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Disclaimer 

Pi Research makes no representation or warranties of any kind whatsoever with respect to 
the contents hereof and specifically disclaims any implied warranties of merchantability or 
fitness for a particular purpose. Pi Research shall not be liable for any errors contained 
herein or for incidental or consequential damages in connection with the furnishing, 
performance or use of the software, associated hardware, or with this written material. 

Pi Research reserves the right to revise this publication from time to time, and to make 
changes in the content hereof without obligation to notify any person of such revision or 
changes. 

A copy of the Pi Research Terms and Conditions of Sale is available on request, and 
includes a declaration of the warranty and limitation of liability, which apply to all 
Pi Research products and services. 
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About Pi Toolbox 

Welcome to Pi Toolbox – a suite of flexible and powerful data analysis tools with 
development potential that can help you solve engineering and design problems. 

Its power and flexibility have been designed to assist and complement problem solving 
techniques employed by data analysis technicians and engineers. 

About this guide 

This guide is divided into sections designed to take you through the typical steps for 
analyzing data using Pi Toolbox. 

In the Installation section you will find information about: 

• Checking the requirements of your computer system. 

• Installing the software. 

• Starting Pi Toolbox for the first time. 

The User Guide provides information about the basic analysis of data, including graphing, 
looking for trends, mapping and reports.  



 

 

Conventions used in 
this guide 

Keyboard commands 

This guide assumes that you are using a wheel mouse to open and close menus, and to 
choose commands, and that the mouse configuration is the default, i.e. left click: select - 
right click: context menu. 

Because the application will be used in many different environments, where the use of a 
mouse may not be available, a full set of keyboard commands are provided. Instructions 
throughout the guide refer to both the menu selections using the mouse, e.g. 

'… to view the Task Explorer select: View > Task Explorer' 

and the equivalent keyboard commands, e.g. 

'… to view the Task Explorer:  + 
 

 

For ease of use and speed, much of the application's functionality is driven by context 
menus; accessed by right-clicking the mouse (default configuration) or by pressing the 
context key. Throughout the guide we have used the context key symbol to indicate that the 
selection is made from the context menu, e.g. 

'… to create a task:  > Add Task. 

 

Other symbols used 

 Left click. 

  Wheel click. 

  Wheel rotate (in direction of arrow). 
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What’s new in this guide? 

Listed below is a brief description of the new features included in V3.0 & V3.1 of Pi Toolbox. 
For further information, refer to information in this guide or the HTML Help. To see the new 
features for V3.1 click here. 

Auto-update of Excel 
reports 

Excel reports now have the ability to be configured to auto generate when new data is 
detected. 

Channel display 

Alarms can now be displayed in the Channel display. Different alarms can be configured to 
display different colors when triggered. 

Channel groups 

Channel groups can be configured to stay collapsed or automatically expand when you view 
channel groups. This is set on the File > Preferences dialog under the Navigation tab. 

General 

General performance enhancements have been made to this version. 
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IfExists maths function 

This function allows different channels to be used if the primary channel is not 
available in the dataset. This can be implemented to use laser ride height if 
sensors are fitted and contained in the dataset, but then switch to a calculated ride 
height if the primary channel is not available. See example below: 

ifExist([Laser FL],[Calculated Rideheight FL]) 

A valid expression cannot contain undefined channels, but IfExists functions can 
be embedded to choose from 2 channels. The example below shows how to select 
one of 2 channels if you are not sure which channel exists in the dataset: 

ifExist([RPM],ifExist([EngineSpeed],-50)) 

RPM will be returned. If RPM is not present in the current dataset, EngineSpeed 
will be returned. If neither channel exists, the function will return –50 to indicate an 
error. 
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Lap performance 

This option controls the format that Pi Toolbox will use to display the fastest lap information. 
This is a global option and will be applied to any workbook that is opened allowing lap time 
or lap speed to be selected. If you chose lap speed, this is a function of lap time and lap 
distance. The lap distance is taken from the current map. If no map is loaded, the current 
distance is used. Therefore you must ensure that the official lap distance is correctly entered 
into the map being used. This should be set when creating the map, but can be amended at 
any time from the following menu: Data > Map > Properties dialog. 

Laptime filter 

A filter can be applied to the fastest lap. When enabled, any lap below the time set in the 
filter will not be labeled as a fastest lap. 

Long comments 

The Long comment in the Task Explorer can now be longer than one line. A carriage return 
can also be inserted by using SHIFT + ENTER. The long comment will be displayed as a 
tooltip if there is insufficient space in the task explorer pane. 

Offsetting the Y – axis 
in a Time and Distance 
chart 

Using the SHIFT + O shortcut in a Time and Distance chart will allow the active trace to be 
dragged in the Y-axis to allow the user to view data with an alternative offset or re-zero data 
such as brake wear. 
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Specifying Offline Auto-
update paths 

Auto-update paths that are offline can be specified in the Auto-update configuration 
pages. This means that if the server that is normally used is unavailable until the 
user is at the track, the path can still be specified. When an offline path has been 
selected, Pi Toolbox will display a dialog asking if this is the correct path. 

Note: This feature is supported on Microsoft Windows XP only. 

Split report display 

The Split report control displays channel data per map sector in a spreadsheet format, using 
laps as row headings and sectors as column headings. Additional columns containing lap 
performance, differences between current and fastest lap, and two additional rows 
containing the fastest rolling lap and theoretical fastest lap data can be displayed. 

Summary display 

The Summary display is made up of 3 features. You can display any or all of the features at 
any time. 

• 

• 

• 

A Channel display. 

Up to 4 channels can be displayed, with the option of using channel alarms. 

A Map. 

The map displayed is for reference only. 

Lap performance. 
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Time and Distance 
chart cursor lock 

The cursor can be locked on a TD chart by pressing L or by selecting the Lock Cursor option 
from the context menu. When the cursor is locked, the view will change so that the cursor is 
in the centre of the screen i.e. the chart will scroll to bring the cursor to the centre of the 
screen. 

XYC channel display 

A third channel - C, can be added to any existing channel pair on a XY chart or added at the 
time of configuration to make it an XYC chart. The extra channel will display data using its 
color gradation scheme, adding an extra dimension to the chart. 

Zoom control 

The Zoom control feature has been added to the context menu for the Time and Distance 
chart, the X-Y chart, the PSD chart and the Real-time chart recorder. 
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V3.1 New features 

Listed below is a brief description of the new features included in V3.1 of Pi Toolbox. 

Bit Indicators 

General display enhancements have been made to Bit Indicators, for example tooltips are 
displayed if the bit caption or status caption is not fully visible. 

Note: The Bit Indicator caption text is displayed horizontally regardless of the 
orientation of the display. 

General 

General performance enhancements have been made to this version. 

Pi Remote Toolbox 

Pi Remote Toolbox uses a Palm Tungsten T3 PDA to show compatible displays via a 
wireless link from a host PC running Pi Toolbox. You can access menus and displays by 
using the touch screen of the handheld or by using the keypad controls. 
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System Requirements 

Minimum System 
specification 

Hardware 
• 1 GHz Pentium III (or equivalent) processor. 

• 256MB Memory. 

• 1.5GB Free Disk Space. 

• 1024 x 768 resolution screen, greater than 256 colors. 

• CD-ROM Drive. 

Operating Systems 
• Windows 2000/XP. 

Other requirements 
• Internet Explorer 5.5 or above. 

• Excel 2000 or above (only required for Excel Reports and Constants). 

 

Note: Running Excel Reports on versions of Excel below 2000 may result in unpredictable 
behavior 
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Recommended System 
specification 

Hardware 
• 2 GHz Pentium 4 (or equivalent) processor. 

• 512MB Memory. 

• 10GB Free Disk Space. 

• 1280 x 1024 resolution screen, greater than 256 colors. 

• CD-ROM Drive. 

Operating Systems 
• Windows XP Service Pack 1. 

Other requirements 
• Internet Explorer 6 or above. 

• Excel 2000 or above. 

• Wheel Mouse. 

 

Note: Running Excel Reports on versions of Excel below 2000 may result in unpredictable 
behavior. 
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Installing Pi Toolbox 

Identifying your version of Pi Toolbox 

The Release Notes that are included on your CD-ROM contain information about your 
version of Pi Toolbox. You should make a note of this and quote it whenever you contact Pi 
Research. It will help when dealing with your request. 

Pi Toolbox Lite and Professional 

Pi Toolbox has two basic levels of functionality: Pi Toolbox Lite and Pi Toolbox Professional.  

If you are not sure which version of Pi Toolbox you are running, select About Pi Toolbox in 
the Help menu. The About Pi Toolbox dialog will state either 'Lite' or 'Professional'. 

Both versions have the same core set of display types and the same functionality that each 
display type provides. Users of Pi Toolbox Lite are restricted to a single Task and a single 
Worksheet, although there is no reduction in the data analysis capabilities of the software. 
However, the multiple Task and Worksheet functionality, available in Pi Toolbox 
Professional, provides greater flexibility for manipulation of datasets and displays etc. 

Note: Video displays are not available to Pi Toolbox Lite users 

Upgrading 

Users of Pi Toolbox Lite and Pi ToolBox Professional can expand the core set or 
displays/features available to them. Users of Pi Toolbox Lite can also upgrade to Pi ToolBox 
Professional. 

For information about upgrading Pi Toolbox contact the Pi Research Support Dept. 
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Supported Languages 

Pi Toolbox is designed to support US/English character sets only. File names, Directory 
names etc. that contain other languages may cause the application to behave unpredictably 
if you try to access or open them.  

To install Pi Toolbox 

Note: When installing or upgrading Pi Toolbox, make sure that the Hardware Key is NOT 
connected to the computer until the installation is complete. 

1 Insert the Pi Toolbox CD into the CD-ROM drive. The Installation Wizard should 
start automatically. 

2 The Wizard Welcome page contains important information about steps to take 
before starting to install. Take a moment to read this page, and then click  ‘Next’. 

3 On the next page it is important that you read and agree to accept the terms and 
conditions of the license agreement before proceeding to install. 

4 Select ‘I accept the license agreement’ and click ‘Next’. 

5 Follow the Installation Wizard instructions to complete the installation procedure. 

Note: Other Wizard options available are: install shortcut on desktop, place Release Notes on 
desktop, and install Pi Toolbox Samples. 

6 Double-click the Pi Toolbox icon to start the application. 

Note: If the Installation Wizard does not start automatically, select ‘Run’ from the Windows Start 
menu and browse the Pi Toolbox CD for the program ‘Setup.exe’. When selected, click ‘OK’ on 
the Run dialog to run the Installation Wizard. 

 

Note: Removing and/or refitting of a hardware key while Pi Toolbox is running can result in the 
application becoming unstable or unpredictable. 



 

 

Hardware keys 

Hardware Keys or Dongles are used by Pi Research as a security device for the licensing of 
Pi Toolbox. If you are using the professional version of Pi Toolbox, you will need a hardware 
key to run the application. The key can either be of the USB or Parallel port type. 

Hardware keys are programmed with information including a user name and an expiry date. 

You can view the expiry date and any other information in the About dialog, opened from the 
Help menu. 

 

 

 

 

 

 

 

 

 

 

Viewing the Hardware key status 

The status of the hardware key is displayed in the lower right hand side of the Pi Toolbox 
main window, as a colored icon, the configured username is also displayed in the same 
area. 

Note: Removing and/or refitting of a hardware key while Pi Toolbox is running can result in the 
application becoming unstable or unpredictable. 
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Hardware key status display 

Valid Hardware key 

The hardware key icon is green, indicating that a valid hardware key has been detected. The 
user name is displayed next to the status display. 

 

 

 

Hardware key expired 

If the hardware key has expired, Pi Toolbox will display a warning: 

 

 

 

 

 

 

Pi Toolbox will revert to Pi Toolbox Lite. The status display will be grayed and the application 
name is displayed instead of a user name. For information on reactivating the key, contact 
Pi Support. For more information on contacting Pi Support, refer to the contacts page of the 
Pi Toolbox User Guide. 
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No Hardware key detected 

If no hardware key is detected, Pi Toolbox will display a warning: 

 

 

 

 

 

 

Pi Toolbox will revert to Pi Toolbox Lite. The status display will be grayed and the application 
name is displayed instead of a user name. 

 

 

 

Hardware key mismatch 

The hardware key stores information about the configuration of your copy of Pi Toolbox. If 
you have updated your version of Pi Toolbox and added extra features to it, but not updated 
your hardware key, when you start Pi Toolbox there will be a mismatch between the 
configuration stored in the hardware key and the configuration stored in the PC’s registry. 

Pi Toolbox will display a warning: 

 

 

 

 

 

 

Pi Toolbox will then revert to Pi Toolbox Lite, until you have updated your hardware key. 
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Information about the mismatch will be displayed on the About dialog. 

 

 

 

 

 

 

 

 

 

 

Parallel port hardware keys 

If you are using a Parallel port hardware key, make sure that the port is enabled in the 
system bios. For more information, contact your PC manufacturer’s support department. 
You may also find that the dongle device driver adversely affects external devices that are 
powered through the parallel port, i.e. external floppy drives. 

This can be alleviated by the use of a USB dongle. 

Windows XP users 

If for any reason you need to re-install dongle drivers (XP only) you will see a dialog stating 
that the drivers have not been verified for use under XP. In this case click ‘Continue’ to 
resume the installation. The drivers will install successfully. 

When restarting the computer for the first time after installing Pi Toolbox, the ‘Add New 
Hardware’ Wizard is launched stating that the dongle needs to be installed. The Wizard 
must be completed to activate the dongle. 
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Introduction 

Pi Toolbox has the familiar look and feel of many popular Windows applications, and with 
the implementation of many standard Windows commands, it is easy to use. The way that 
engineers work with data to solve problems has been paramount in the design of the 
application.   

You will notice that context menus and keyboard shortcuts drive much of the application’s 
functionality, reducing to a minimum the need to move from one part of the work 
environment to another. 

 

Starting Pi Toolbox 

To start the application: 

1 Locate the Pi Toolbox shortcut icon on your computer Desktop. If you did not 
install a shortcut on your desktop, browse for the application and locate the Pi 
Toolbox application icon. 

2 Double-click the icon to start the application. 

When you start the application for the first time you will be prompted to create a new 
Workbook from a default template.  

3 Double-click the Default Template icon to open the application window. 

See the following illustration for an overview of the different areas of the work environment. 

Note: There can only be one instance of the application running at any one time. 



 

 

The Main window 

Pi Toolbox has two main work areas - the Display Area where charts, reports etc. are 
displayed, and the Explorer where you control what you see in the display area. 

       

1 The Explorer is where tasks are created, outings are loaded, and channels or 
events etc. are selected for displays.  

Tasks are a convenient means of storing outings that you want to display. You connect tasks to 
displays to associate outings with the display. 

2 Details Panes show information about the selections you make in the upper 
panes of the Explorer. 

3 The Display Area can hold up to 8 displays. 

4 Up to 16 worksheets can be held in a workbook. 

5 The Toolbar provides shortcuts to many Pi Toolbox functions. 
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Start up preferences 

Startup page 

You can control the way that Pi Toolbox behaves on Startup. The Preferences dialog is 
opened by selecting:  File > Preferences. 

 

Start with a blank workbook  

Starts with a new Workbook that contains a blank Worksheet. You need to add a Task to the 
Worksheet and select a display before you can start working. 

Re-open the last workbook you were working with 

Starts with the last Workbook saved. The top-most Worksheet will be opened. 
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Select a new workbook from the list of templates 

Starts with the new (Workbook) dialog. Here you can choose to create a Workbook from the 
Default template or create a Workbook based upon existing Workbooks. 

• Default workbook: Comprises of a single Worksheet, which contains a task, a 
Time/Distance display connected to the task, and a default channel selected. 

• Existing workbook: The 'Existing' tab of the New dialog allows you to browse 
previously created Workbooks to use as templates. The new Workbook will be a 
complete copy of the existing one, including worksheets, tasks, outings, displays 
and channels. It will be untitled and should be saved immediately. 

Browsers page 

Here you assign default directories and captions for the browser buttons on the Add dialog.  
You can also enable further My Data buttons to which you can add default directories. 

 

To set the default directory of the button double-click ‘Path’ and use the Browse dialog to 
locate the default directory. 

It is possible to configure up to 6 browser buttons. The properties of each browser button 
can be viewed by expanding the ‘Browser’ node.  
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To change a property, click on the property name and select from a drop-down list. The 
properties available are as follows: 

Browser 

Defines the action for the browser button. The default is the ‘File Browser’, which opens a 
folder defined by the path property, allowing Pi Datasets to be selected. 

Clicking ‘Browser’ opens a list of the currently available custom browsers, which can be 
assigned as an action to the browser button. See: Adding a Custom Browser, page 62. 

Caption 

Enter a name which will appears beneath the browser button on the Add dialog. 

Description 

Enter a description for the browser button, which will appear as a tool tip. 

Enabled 

Select Yes to add the browser button to the Add dialog. 

Path 

Enter the path to the browser buttons default directory.  

Source 

Enter a custom string which can be used for user data that may be required be a custom 
browser. For example, if the custom browser is for a database, the string may be some SQL 
code that identifies the last browsed position in the database. 



 

 

Time regions 

Default Time Region 

You can specify which time region is to be displayed from a data selection added to the task,  

or replace an existing data selection in the task: 

 

Fastest Lap: Displays the fastest lap from the outing. 

Entire Outing: Displays the complete dataset 

Last Region: Display the lap leading up to the last lap marker. 

Unchanged: As outings are updated or added, the current time region selected will not be 
changed. 

Note: This setting defines the default time region property applied to new tasks added to the 
Workbook. The property can be overridden locally by setting the time region for a specific Task in 
the Task properties pane of the explorer. 
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Navigation 

 

Enable Smart Focus: With Smart Focus enabled, the current explorer window intuitively 
determines which of its focusable areas receives focus when the user navigates between 
displays and explorer windows. 

For example, if a channel is selected in the Properties explorer, focus will be on the 
channel's properties. If the user navigates to the display and then back to the explorer, focus 
will remain on the channel properties. 
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Smart Focus examples 

 

Smart Focus On 

When the user returns to the Selection 
explorer, focus is given to the upper pane 
where most actions take place 

Action 

User makes selections in the Selection 
explorer, moves to the lower pane to 
deselect a channel then goes to a display 

Smart Focus Off 

When the user returns to the Selection 
explorer, focus is given to the last area 
worked in. In this case the lower pane. 

Action 

User changes a channel property in the 
Properties explorer, moves to the upper 
pane to make a selection, and then goes to 
a display. 

Smart Focus On 

When the user returns to the Properties 
explorer, focus is given to the lower pane 
where most actions take place. 

 Smart Focus Off 

When the user returns to the Properties 
explorer, focus is given to the last area 
worked in, in this case the upper pane. 

Automatically Expand Groups 

The automatically expanding groups feature allows you to enable groups to expand to show 
the active channel when you load a workbook, open a display or add a channel to a group. 
This is a global option and will be applied to any workbook that is opened. 

Note: This feature is enabled by default. 



 

 

Dialog Warnings 

Warnings that have been disabled can be reset from the Navigation tab of the Preferences 
dialog. For example: Starting Pi Toolbox without a hardware key (Dongle) will cause a 
warning to be displayed, you can disable this warning. Pressing the Reset Warnings button 
will re-enable all currently disabled warning dialogs. 

Lap Information 

 

Performance: this option controls the format that Pi Toolbox will use to display the fastest 
lap information. This is a global option and will be applied to any workbook that is opened 
allowing lap time or lap speed to be selected. If you chose lap speed, this is a function of lap 
time and lap distance. The lap distance is taken from the current map. If no map is loaded, 
the current distance is used. Therefore you must ensure that the official lap distance is 
correctly entered into the map being used. This should be set when creating the map, but 
can be amended at any time from the following menu: Data > Map > Properties dialog. 

Fastest Lap Filter: A filter can be applied to set a minimum time (in seconds) for fastest 
laps, any time below the filter target will not be displayed as a fastest lap. 

Note: The fastest lap filter is disabled by default. When first enabled the default time will be set to 
5 seconds. 
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Note: Once you have set the Lap Information options, you must make sure that the options on 
the Formats tab are set correctly. 

Formats 

 

The options that can be set on this page are global options and will be applied to all 
workbooks viewed. The configuration specified is persisted between Pi Toolbox sessions. 

Time: The format that is used by Pi Toolbox to display the time on displays. You can select 
either seconds, minutes and seconds or hours, minutes and seconds. You can also select 
the precision that it is measure to. You can select from 1 nanosecond to 100 milliseconds. 

Speed: The format that is used by Pi Toolbox to display the time on displays. You can select 
either meters per second, miles per hour, feet per second and kilometers per hour. You can 
also set the number of decimal places that the speed will be measured too. You can select 
from 0 to 9 decimal places. 



 

 

Remote 

 

This tab is where the configuration for the Bluetooth connection for the Pi Remote PDA is 
done. 

Remote connection: Select the method of connection that you want to use. Currently there 
are two options, Serial or No connection. You may want to select none if you are using the 
Bluetooth connection for another purpose. 

Serial: Select the Bluetooth serial port that you setup when you installed the Bluetooth PC 
adapter. 

Note: It is important that you specify the same port details as the Bluetooth PC adapter or you 
will not be able to establish a Bluetooth connection. 
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The Options dialog 

The Options dialog lets you define colors and themes for displays throughout the workbook. 
It is also used to associate common channel names to the real channels, held in the Pi 
Toolbox Channel List and set up Real-time options. 

Open the Options dialog by selecting: Tools > Options. 

The dialog has five tabs. 

Displays 

 

Use Small Captions: This option is designed to maximize the available space in the Display 
Area. Check Use small captions to set the Title Bars of all displays in the Workbook to 
'Auto Roll-up', i.e. the Title Bars remain hidden until the cursor is held over the top of the 
display. 
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Channels – Mapping Common Channels 

Some channels are required by Pi Toolbox components to generate maps, display or 
compare data against distance, and generate corrected data channels. These are ‘Common 
Channels’. As users may have different names for these channels, a system has been 
provided for identifying them to Pi Toolbox components as common channels. 

 

 

 

 

 

 

 

 

 

 

 

The lower 'real channel' field lists channels that equate to the 'common name' displayed 
above it. For example, with Corrected Distance selected, the lower field shows all channels 
that measure distance. 
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Common channels definitions  

 

Real channels 

Common Channel name Definition 

Corrected Distance The channel specified for Corrected Distance will be used 
for all distance-based charts and math functions within 
Toolbox. 

Corrected Speed Not used by anything. 

Distance The channel specified for Distance will be used when 
creating a standard map. It is also used as the input 
channel for the Special Math channel [Corrected 
Distance]. 

Fuel used This channel is used with the Corrected Distance channel 
in the Fuel consumption calculation for reporting fuel 
consumption in Excel reports. 

Lap Distance The channel specified for Lap Distance will be used as the 
input channel for the special Math channel [Map Position 
D] for Standard Map types. 

Lateral Acceleration The channel specified for Lateral Acceleration will be used 
when creating a standard map. 

Map Position D The channel specified for Map PositionD is used to 
determine the cursor and segment/split positions on the 
map control. 

Map position X Not used. 

Map position Y Not used. 

Map position Z Not used. 

Speed The channel specified for Speed will be used when 
creating a standard map. 
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Real channels definitions 

 

Special Math channels 

[Corrected Distance] When a map is loaded, this channel is calculated per lap to 
match the official track length. Taking into account the 
Distance Correction settings in the Data Correction dialog. 
(Note. Before a map is loaded, this channel will be the 
same as the channel specified for the common channel 
Distance with lockup correction applied.) 

[Corrected Speed] After a map is created, this is calculated based on the 
channel specified for common channel Speed and the 
options set in the Data Correction dialog. 

[Elapsed Lap Time] Based on [Elapsed Time] reset to 0 on each end of lap. 

[Elapsed Time] The elapsed time of the outing. 

[Lap Distance] [Lap Distance] is created using the [Corrected Distance] 
special math channel, reset to 0 on End of Lap. 

[Map Position D] [Map Position D] is created to show the car’s distance on 
the track from the start point. For standard map types this 
is based on the channel specified for common channel Lap 
Distance. 

[Map Position X], [Map 
Position Y], [Map Position Z] 

After a map is created, these channels are generated and 
represent the location of the car in a Cartesian coordinate 
system. For standard maps the Z channel will provide a 
constant value of 0m. 

The image below shows the default path for distance correction, by Pi Toolbox. 
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Themes 

 

Use Themes to define color and font options for all displays in the Workbook. You can 
define the background color, grid color and foreground color (cursor value text, cursor etc.) 
as well as font style and size. 

These properties define a look or 'Theme' for your workbook. However, individual displays 
can be changed by setting color options locally, in the display's Properties dialog. 

There are three options in the Use theme field: 

• Classic Black: black background, white foreground 

• Classic White: white background, black foreground 

• Custom Theme: with Custom Theme selected, color and font options are 
enabled. 

Note: To reset all displays to a custom theme (individual displays may have had color schemes 
set locally in their Properties dialog) select a classic theme and click Apply, then reselect the 
custom theme and click Apply. 
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Outings 

 

Caption format 

Use the Outings tab to format the outing caption displayed in the Task Explorer. The caption 
definition affects all outings in the current Workbook. 

The default format is <Session: Outing: First Lap Number>. 

The outing caption can contain up to four elements - each element selected by one of the 
four drop-down lists. The preview window shows an example caption for the current 
selections. The Lap selection is always shown after the caption. 

Note that the default format can itself be a single element of an outing caption, making the 
following example possible: 

<006:005:001>, John, Car#1, Phoenix: Lap 1 - Lap 4 
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Sort Order 

This selection defines the order in which outings are displayed when a Task icon is 
expanded in the Task explorer. Select the Arrange by method and then choose to display 
them in ascending or descending order. 

This command is also available in Task explorer. To access the context menu, hold the 
cursor in the area below the Tasks and select: 

 > Arrange Outings By > Car Name/Create Date 

The Sort Order is applied to all Tasks in the Workbook, regardless of where the order is 
defined (Task explorer or Options dialog) 

Real-time - setting up 

 
Use the fields on the Real-time tab to set global real-time outing settings. 

Information stream/Port: These are editable fields used to configure the information stream 
and port that the desired server machine is to broadcast on. 

Network adapter: The IP address of the Network Adaptor that multicast data is received on. 
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Data cache path: This field is used to enter or browse for the location of temporary data 
files. 

Setting the Advanced Real-time options 

Clicking ‘Advanced’ opens the Advanced Real-time Options dialog. 

 

Stream Timeout: This field is used to enter the timeout limit for the detection of a data 
stream. 

Update Rate: This field is used to enter the rate at which displays showing Real-time data 
are updated. 

Time to Live: this field is used to configure the time to live for packets sent from the real 
time data manager to the desired server machine. 

Limit data cache size: Multicast data is stored in a data cache on the hard drive (see data 
cache path on Real-time page). When unchecked, data cache size is unlimited. When 
checked, the oldest data is removed to maintain the file at the size specified in the field 
below. 

Data cache size: This field determines the data cache size.  



 

 

Priorities 

 

This option is for setting event priorities. Priorities allow the user to categorize events based 
on their severity, importance or source. The Event display can then be configured to plot 
events by priority. 

There are four default priorities: Debug, System, Status, Error. Priority properties (Name, 
colors etc.) can be changed if required and further priorities can be added up to a total of 
eight. 

Priorities are created using IDs which correspond to Event IDs. Events are placed in 
priorities accordingly. If an event is assigned an ID that does not exist in the priorities 
defined for the workbook, it is placed into the 'other' priority. This is unique in that it cannot 
be deleted and it does not have an ID. 

Name, ID, fore color and back color properties of the default priorities can be changed if 
necessary. 

Click  to add further priorities and then set the properties as required. 

Click  to delete the highlighted priority. 
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Organizing Templates 

New template categories can be created so that when the New dialog is opened, extra tabs 
are created in addition to the default tabs. 

For instance you may wish to add team specific template categories such as: Test 
Templates, Race Templates, Dyno Templates, as shown in this example. 

 

To add Template categories: 

1 Create a directory on your server or data drive, e.g. Pi Toolbox Templates. 

2 Create three sub-directories, Race, Test and Dyno. 

3 Create Shortcuts to the sub-directories. 

4 Put the shortcuts in C:\Program Files\Pi Toolbox\Templates (default installation 
directory). 

5 Name the shortcuts, Race, Test and Dyno. 

The New dialog will now have three extra tabs: Race, Test and Dyno from which you can 
select templates saved in the sub-directories. 
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The Add dialog 

General 

The dialog can be opened by selecting:  > Add Outing in the Task Explorer. 

Alternatively, the shortcut:  +  opens the dialog from any part of the application. 

The dialog is used to add historic outings (Pi Datasets) or real-time outings to a 
task. The default configuration for this dialog has three browser buttons to enable 
rapid location of outings. 

• Sample data: locates the sample PiDatasets installed on the user’s PC at 
installation (if selected during installation) 

• My Documents: locates a pre-selected directory of your data.  

• Real-time: locates Real-time telemetry or watch data servers. 

Note: Three further ‘My Data’ browser buttons can be added to the dialog. These are enabled in 
the Preferences dialog. You can assign default directories and names for ‘My Documents’ and 
additional ‘My Data’ browser buttons in the Preference dialog (Browers tab). See page 38. 

Custom Browsers 

The Add dialog can also be used to host custom browsers so that users can access their 
outings, irrespective of their file type and location. See Adding a Custom Browser on page 
62. 
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Adding Historic Data 

This button  automatically selects the 
outing, from those currently in view, which 
contains the fastest lap. 

This button  selects the most recent 
outing from those currently in view. 

Look in: Use the Look in field and the 
browse tools to locate an outing. 

File Window: The outings (datasets) 
contained in the selected data folder are 
displayed here. When you highlight a 
dataset, details are displayed in the lower 
pane. Clicking OK will add the selected 
dataset to the Task selected in the field 
above. 

File Name: Displays the name of the outing file (.pds file) selected. 

File of Type: Use this field to select the format of the outing, i.e. Pi, MATLAB or ASCII. 

Details: Details of the highlighted outing appear in this window to help you identify it. 
Properties are listed in categories that can be expanded or collapsed as required. 

Default directories 

You can set up the default directories for the browser buttons in the Preference dialog 
(Directories tab). To open this dialog select: File > Preferences. 

An alternative method of setting a default directory is as follows: 

1 Browse for the required directory in the Look in field. 

2 Ctrl + click My Documents or additional My Data browser buttons. 

The directory becomes the default for that button and it path is entered in the Browsers tab 
of the preferences dialog. 
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Adding Real-time data 

Browser View - The Window 
contains two nodes: Watch and 
Telemetry. Watch lists the Watch 
data servers and Telemetry lists 
the Telemetry data servers. If no 
servers are present, double-clicking 
'No Watch Servers' or 'No 
Telemetry Servers' opens the 
Browse for Computer dialog. 

Alternatively, click  to open the 
Browse for Computer dialog. 

Note: To replace a server, double-
click an existing computer in the 
Watch or Telemetry list and select 
another in the Browse for Computer 
dialog. Clicking OK will replace the 
server. Only one Watch server can 
be loaded at any time. 

Click the delete button  to delete a computer from the Watch or Telemetry list. 

Details: Details of the highlighted outing appear in this window to help you identify it. 
Properties are listed in categories, which can be expanded or collapsed as required. 

OK: Click OK to add the outing. 

Two types of server can be connected: 

• Watch servers – server physically connected to the car. Only one Watch server 
can be connected. 

• Telemetry servers – server not physically connect to the car. More than one 
Real-time server can be connected. However, only one instance of each server is 
can be selected. 
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Important Note: Users of NT4 operating Shell 32 versions below V4.71 may experience 
some difficulty with the Browse for computer dialog box. Details of a possible solution are 
given in the Installation section of the User Guide, page 30. 

To add a Real-time data outing: 

1 Make sure that the data server settings are correctly configured. Do this in the 
Real-time tab of the Options dialog. 

2 With the required task highlighted select:   > Add Outing. 

3 Select Real-time in the navigation bar of the Add dialog. 

4 Open the Real-time list. 

5 Double-click 'No Telemetry Server' or click  

The Browse for Computer dialog opens. 

6 Browse for a Real-time server and click OK. Alternatively enter the server name 
(without prefixes). 

The server is added to the Telemetry Servers list. 

7 Click OK. 
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Adding a Custom browser 

Pi Toolbox allows you to configure Real-time and file browser settings as well as adding 
your own custom outing browsers. This means that it is easier to access your outings, 
irrespective of their file type and location. 

To add a custom browser: 

1 Select File > Preferences. 

2 Click the Browsers tab. 

3 From the list, select the position where you want your custom file browser to 
appear. Each position in the list represents a button on the Places bar in the 
Add/Replace dialog. 

4 Double-click the browser property.  

In the drop-down list, select your custom file browser. 

5 The caption to be displayed will be added underneath the browser button. It is 
taken from the actual browser name. For example: Pi Real-time browser will be 
displayed as Real-time. 

Note: The caption is also user definable. You can edit the caption by double clicking in the 
caption field. 

6 You can add a description to your browser; it will be displayed in the form of a 
tool tip, when the cursor hovers over the button. For example: this can be 
information about what data is stored in the directory. 

To add a description, double-click in the Description field, type your text in the edit box.  
If you do not enter a description, a tool tip based on the browser’s settings will be 
displayed. For example: 

• If you have entered a file path, this will be displayed as the tool tip. 

• If you haven’t entered a file path, the caption that has been entered will be 
displayed as a ToolTip. 

• If the caption field is empty, then no tool tip will be displayed. 

7 By default, when you add a browser the corresponding button will be displayed 
in the Add/Replace dialog. 
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To switch the button off double-click Enabled. In the drop down list, select No. 

8 If you are using a Real-time browser, you can provide a default set of servers 
using the Source field. This must be entered in the standard Real-time source 
format. For example: 

• If you are connecting to a Watch server and a Telemetry server, type the 
following: 

<watch>|<telemetry>, where <watch> is the name of the Watch server and 
<telemetry> is the name of the Telemetry server. 

• If you are just connecting to a Watch server, type <watch>, where <watch> is the 
name of the Watch server. 

• If you are only connecting to a Telemetry server, type <telemetry>|, where 
<telemetry> is the name of the Telemetry server. 

Note: Not all browsers utilize the directory path and source string fields. 

 

 



 

 

Quick start 

The Quick Start Guide is to help new users quickly create displays and plot data. When the 
application is run, a default Worksheet is provided with a single Task included. However, the 
following steps assume that you are starting with an empty Worksheet. To open an empty 

worksheet, click the new button  on the toolbar. 

Create a task: 

Go to the task window of the Explorer (  + ) and select:  > Add Task. Name the 
task by double-clicking 'Name' in the Details pane and overtyping the default name. Press 
Enter or click away from the edit box to accept the name. 

Load an outing: 

Highlight the task and select:  > Add Outing. Browse for a PDS (Pi Dataset) in the Load 

outing dialog. 

Add a display to a worksheet 

Click the Insert Display button  on the toolbar and select a display type from the list. 
Note that this button remembers the last display type added and shows the appropriate icon. 

Connect the display to a task  

In order for the display to plot data, it must be connected (or associated) to a task.  

To do this click the 'No Task' icon  in the top left of the display title bar and from the drop-
down list of available tasks, choose the task you have created. 

Select channels to display 

Go to the Selections Explorer - press  +  - to see the channels in the outing. With 
your display in focus, double-click the channels that you want to appear. The channels 
selected will appear in the lower pane of the Explorer and the data will appear on the 
display. 
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About the tutorial 

In the following tutorial you will learn how to use Pi Toolbox’s common commands and 
procedures - including creating tasks, adding displays, loading data, selecting channels and 
changing properties.  

The Worksheets that you will create are typical layouts that can be used in practical 
trackside analysis. The Data used to create the displays are the example Pi Datasets stored 
on the Pi Toolbox CD. These datasets may also be located on your hard disc (if selected at 
installation). 

The tutorial is divided into logical sections which follow standard working routines. Pi 
Toolbox can be configured to open with a new Workbook, the last Workbook or the default 
Workbook. For the purposes of this tutorial, start with a blank Workbook. 

Note: The default mouse configuration is assumed, i.e. left click: select - right click: context 
menu. Therefore, references to 'right-click' in the text indicate that the context menu is opened. 



 

 

Add a Time and Distance display to a blank worksheet 

 

1 

Click the New button  to open 
a blank Workbook. 

Save changes to an existing 
Workbook if prompted to do so. 

 

 
 

2 
The left-hand pane headed ‘Tasks’ is the Task 
Explorer. 

Right-click in the Task Explorer and select: Add 
Task  

A task named ‘Task 1’ is created in the explorer. 
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3 
In the lower pane of the Task Explorer, double-
click ‘Name’ and enter: ‘Current Outing’. 

Press Return. 

The new task name is displayed next to the task icon 
in the upper pane. 

You can accept the default color given to the task or 
change the color by double-clicking ‘Color’ in the 
lower pane and selecting a color from the palette. 

 
  

4 
With the task highlighted right click and select:  
Add Outing 

The Add dialog opens. 

The Add dialog defaults to the ‘My data’ window, 
which allows you to browse for historical data.  

Browse for a PDS file (Pi Dataset) in the Files tab 
and click OK. 

The selected dataset is added to the task. 
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5 
In this part of the tutorial the Pi Dataset used: 
<ExampleOvalData1> is selected from the directory 
‘Pi Toolbox>Sample Data>US’. Sample datasets are 
included as part of the Pi Toolbox installation (if 
selected). 

Pi Toolbox can display all the laps in an outing, or a 
selection of laps. By default the fastest lap from the 
dataset is selected. Dataset information is displayed 
beneath the task in the form: <000:000:000>: Lap 3 
(session:outing: first lap: lap selected). 

 
  

6 
Tasks can contain one or more datasets. One of 
them is defined as the Datum, indicated by the 
overlay on the dataset icon: . 

A single dataset is automatically made the datum.  

The datum can be changed by right-clicking on a 
dataset and selecting: Make Datum. 

 

At first you will create a general Worksheet that has several functions. The Worksheet will 
enable you to: 

• Analyze general performance parameters in a Time and Distance display, i.e. 
brakes, steering, engine speed, throttle, engine oil temperature, lateral acceleration, 
engine water temperature 

• Visualize where certain events occur on a circuit map 

• Show what gear the driver has selected using a Bit Indicator display 

• Change laps rapidly using the Navigator bar 

• Compare the performance of two drivers. 

 



 

 

 

7 

Click the Insert Display button  on the 
toolbar. 

Select a Time and Distance display from the 
drop-down list.  

The display is added to the worksheet. 

This button remembers the last display type added 
and shows the appropriate icon. If the button is not 
displaying the icon of the display you want, click the 
down arrow adjacent to the button and select from 
the drop-down list. 

8 
The Worksheet title bar reads [No Task]. The display 
grid is shown but no data is displayed. 

Click the ‘No Task’ icon and select ‘Current 
Outing’ from the drop-down list. 

The Display is connected to the ‘Current Outing’ 
task.  

 

Note: Displays connected to the same task share a 
common Data Cursor position. As you move the 
cursor along the X - axis or click a data point or 
event in one display, the cursor moves 
simultaneously in all displays connected to the task. 
See The Principle of Tasks and Outings, page 111. 
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9  

The X-axis scale is drawn on the display. The default 
quantity is ‘Time’ and extent of the scale is 
determined by the data selection (in this case a 
single lap).  

End of Lap beacons are also drawn if they exist in 
the data selection. 

 

10 
Go to the Worksheet name tab and double-click 
the default name ‘Sheet 1’. 

Enter: ‘General’. 

The shortcut:  +  highlights the name tab.  
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11  

Go to the Selections Explorer.  

Shortcut:  + . 

The Selections Explorer is used to select Channels 
and Events (and other elements) for display. 
Generally there are two tabs in the lower pane, 
‘Channels’ and ‘Events’. With the default ‘Channels’ 
tab selected, the channels available for the data 
selection are listed in the upper pane.   

 
 

12 
In the upper pane, double-click the channel: 
Accel Lateral. 

The channel appears in the ‘Selected Channels’ list 
in the lower pane and its trace is drawn on the Time 
and Distance display. 
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13 
Select the following channels in the same way: 

Press Brake F, Press Brake R, RPM, Speed, Steer 
Angle, Temp Eng Water, Throttle. 

Your display should look similar to the one shown 
here. 

Time and Distance displays can display traces ‘Tiled’ 
or ‘Overlaid’. The shortcut  toggles the two 
modes. 

 

14 
When you select channels for a Time and Distance 
displays, their values are displayed to the right of the 
plot area in Legends. You can adjust the space 
allocated to the legends manually, by holding the 
cursor over the border between the plot area and the 
legends and moving the splitter bar horizontally. 
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15 
 
Events are selected for displays in the same way as 
channels. To see the available events in a dataset, 
select the Events tab in the Selection Explorer. 

 

 

 
16 

Select: File > Save.  

Enter: ‘My Sample Workbook’ in the File Name 
field and save the workbook (.pwb file) in a 
directory of your choosing. 

 

 

 

 



 

 

Add Further Displays to the worksheet 

 

17 
Click the Insert Display button. 

A second Time and Distance display is added to the 
worksheet. 

The button should display the Time and Distance 
display icon  because one was selected 
previously. 

 

18 
Click the down arrow adjacent to the Insert 
Display button and select Map from the drop-
down list. 

A Map display is added to the Worksheet.  

 

  

19 
Using resizing and click and drag techniques 
explained on page 117 re-arrange the Worksheet 
to resemble the one shown here. 

  

76 Pi Toolbox User Guide 

 



 

 

 77 

 

20 
Click the down arrow adjacent to the Insert 
Display button and select ‘Navigator’ from the 
drop-down list. 

A Navigator display is added to the Worksheet. 

 

21 
Using resizing and click and drag techniques 
move the Navigator above the first Time and 
Distance display. 

  

22 
Click the down arrow adjacent to the Insert 
Display button and select ‘Bit Indicator’ from the 
drop-down list. 

A Bit Indicator display is added to the Worksheet. 
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23 
Reposition and resize the Bit Indicator display so 
that it occupies the right-hand edge of the 
Worksheet. 

  

24 
Save your work. 

 



 

 

Create Another Task and Add Data 

 

25 
Go back to the Task Explorer. 

Shortcut:  +  

Right click in the Task Explorer and select: ‘Add 
Task’. 

A task named ‘Task 1’ is created. 

 

  

26 
In the lower pane of the Task Explorer, double-
click ‘Name’ and enter: Compare Cars. 

Press ‘Return’. 

The new task name is displayed next to the task icon 
in the upper pane. 
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27 
Right-click on the Compare Cars task and select: 
Add Outing. 

The Add dialog opens. 

Browse for the same dataset that was added to 
the first task: <ExampleOvalData1>. 

Shift + click the second outing 
<ExampleOvalData2> so that both outings are 
selected. 

  

28 
 

Click OK. 

The selected datasets are added to the task. 

You can also use the Copy and Paste toolbar 
buttons to copy the dataset from one task to another

 

 

Save your work. 

 

 



 

 

Connect the New Displays 

 

29 
Click the ‘No Task’ icon of the Navigator display 
and select ‘Current Outing’ from the drop-down 
list of available tasks. 

The display is connected to the ‘Current Outing’ task 
and displays a navigator bar. 

The bar is a graphical representation of the dataset 
in the task. The bar is divided into segments, usually 
representing laps. Clicking on a segment will change 
the data selection, of any display connected to the 
same task, to that segment. 

There are no configuration pages associated with a 
Navigator display. 
  

30 
Click the ‘No Task’ icon of the second Time and 
Distance display and select ‘Compare Cars’ from 
the drop-down list. 

The display is connected to the ‘Compare Cars’ task.

  

31 
Click the ‘No Task’ icon of the Bit Indicator and 
select ‘Current Outing’ from the drop-down list. 

The display is connected to the ‘Current Outing’ task.
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32 
Click the ‘No Task’ icon of the Map and select 
‘Compare Cars’ from the drop-down list. 

 

 
33 

Right-click in the Map display and select: Create.

The Create Map dialog opens. A map of the circuit is 
created in the Preview window, using lateral 
acceleration and corrected speed data from the 
outing. 

If the Map does not draw, you may need to go to the 
Options dialog (Tools > Options) and check that the 
common channel names are mapped to the correct 
real channels for your outings. See Mapping 
Common Channels, page 48. 

 

 
34 

Click OK to draw the map in the display. 

 

 

 

Save your work 

 



 

 

Create Math Channels 

 

When Math Channels are created, they are listed with other channels in the Selection 
Explorer, identified by their icon: . 

Using the Selection Explorer they can be selected for any display in the Workbook. 

 

35 
Select: Tools > Pi Math > Edit 

The Pi Math Management dialog opens. This is for 
the creation and management of math channels. All 
the math channels you define or import can be 
accessed and edited here. 

 

36 

Click the New button: . 

A default name <Maths_0000> for a new math 
channel appears in the ‘Channels:’ list. 

 

37 
Highlight the default name in the Name field and 
enter the name: CompareTime. 
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38 
Click in the Equation field beneath the equation 
description. 

If required, a description of the math channel 
function may be added. Insert the description 
between the characters: /*Description Here*/, or after 
the characters: //Description Here. 

Press:  +  to access a drop-down list of 
mathematical functions, operators and channels.

  

39 
With the drop-down list in view, enter the 
characters: COM. 

The list is filtered to show the mathematical functions 
starting with these characters. 

  

40 

Press:  to add the ‘Compare’ function to add 
it to the equation. 

The beginning of the equation should be: compare( )
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41 
Press:  + . 

A drop-down list of available channels is displayed. 

With the drop-down list in view, enter the 
characters: SP. 

The list is filtered to show the channels starting with 
these characters. 

Press:  to add the channel to the equation. 

The complete equation should be: 

Compare([Speed]) 

Note that equations can also be keyed in manually. 

  

42 
Click OK 

The Pi Math Management dialog closes and the 
Math Channel is added to the list of available 
channels. 
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43 
Click on the lower Time and Distance display so 
that it has focus. 

(The display connected to the ‘Compare Cars’ task).

Go to the Selection Explorer 

Shortcut:  + . 

Scroll down the list of available channels in the 
upper pane and locate the Math Channel. 

It should look like this:  CompareTime 

Double-click the CompareTime Math Channel. 

The channel appears in the ‘Selected Channels’ list 
in the lower pane and its trace is drawn on the Time 
and Distance display. 

 
44 

Select: Tools > Pi Math > Edit 

The Pi Math Management dialog opens. 

Create a new Math Channel called GearBit. 

Follow the procedure used for creating the 
CompareTime Math Channel, only this time 
manually enter the equation: u32(pow(2,[Gear])) 
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45 
Click on the Bit Indicator display to give it focus.

Go to the Selection Explorer 

Scroll down the list of available channels in the 
upper pane and locate the Math Channel. 

It should look like this:  GearBit 

Double-click the GearBit Math Channel. 

The channel appears in the ‘Selected Channels’ list in 
the lower pane and is selected for the Bit Indicator. 

 

Save your work 
 

 



 

 

Configure the Bit Indicator 

 

46 
Right-click on the Bit Indicator display and 
select: Properties. 

Shortcut:  +  

The Bit Indicator Properties dialog opens. 

 
47 

The default parameters on the Layout and View tabs 
of the dialog do not require editing for this Worksheet.

Select the ‘Bits’ tab. 

Highlight the math channel ‘GeartBits’ in the 
channel list on the left of the dialog. 

This is only necessary when there is more than one 
channel selected for the Bit Indicator. The Bit 
settings are for the channel highlighted. 
  

48 
Select the ‘Fixed’ option and enter ‘GEAR’ in the 
adjacent field. 

This is the Name that appears as a title at the top of 
the Bit Indicator display. 
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49 
Uncheck any unwanted bits. 

In this example the Bit Indicator is used to display 
the gear selected. 

To disable a group of bits, click on the first bit then 
shift click the last bit. With the group highlighted, 
click on the checkbox of any of the bits - all bits 
selected will become disabled. 

You can also use this method with multiple channels 
selected. 
  

50 
Rename the Bit Captions 

To do this:  

Double-click the caption bit 0. Delete the caption 
and enter ‘N’. 

Change the remaining captions to 1, 2, 3 etc. to 
indicate gear number.  

The default colors for On and Off states can be 
changed if required. To do this, double-click the color 
panel for each bit and select a new color from the 
color palette. 
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51 
Click OK. 

The Bit Indicator should resemble the one shown 
here. 

 

 

 

 

 

 

Save your work. 
 



 

 

Create a second worksheet 

 

The next worksheet you will create is an engine worksheet which shows key engine 
performance parameters including: 

• An X-Y chart to show the relationship between engine oil pressure and engine RPM

• Histograms to show the distribution of RPM and gears over a lap or the entire 
outing 

• Time and Distance displays to show all engine parameters of time. 
 
 

52 
Select: Insert > Worksheet 

A new worksheet is created and given the default 
name ‘Sheet 1’ 

Double-click the default name and enter the new 
name: Engine 

  

53 
Click the down arrow adjacent to the Insert 
Display button and select a Time and Distance 
display from the drop-down list. 

Click the ‘No Task’ icon in the display title bar 
and select ‘Current Outing’ from the drop-down 
list. 
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54 
Go to the Selection Explorer and select these 
channels for the Time and Distance display: 

RPM, Temp Eng Oil, Temp Eng Water, Throttle. 

  

55 
Create an X-Y display and connect it to the 
‘Current Outing’ task. 

X-Y Displays illustrate the correlation between two 
channels plotted on Cartesian axes, and identify 
patterns of behavior. Typical uses may be to analyze 
the engine oil system performance by plotting engine 
oil pressure against engine RPM. 

  

56 

Channels are added in pairs to X-Y displays. 

With the X-Y display in focus, go to the Selection 
Explorer. 

Double-click the RPM channel. 

The first channel will provide X-axis data. 

Double-click the Press Eng Oil channel. 

The second channel will provide Y-axis data. 
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57 
The data points and resulting polynomial are drawn 
on the X-Y display 

 

To swap the X-Y assignment of channels, right click 
on the channel Pair folder icon  and select: Swap.

  

58 
Create a Histogram and connect it to the ‘Current 
Outing’ task. 

With the histogram in focus, go to the Selection 
Explorer. Double-click the RPM channel. 

The channel is selected for the Histogram. 

  

59 
Create the other Histogram and connect it to the 
‘Current Outing’ task. 

With the histogram in focus, go to the Selection 
Explorer. Double click the Gear channel. 

The channel becomes selected for the Histogram. 
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60 
The completed Worksheet should look like the one 
shown here.  

 

Save your work 

  



 

 

Create a new worksheet and add a reports table 

  

61 
Select: Insert > Worksheet 

A new worksheet is created and given the default 
name ‘Sheet 1’ 

Double-click the default name and enter the new 
name: Reports 

  

62 
Click the down arrow adjacent to the Insert 
Display button and select Excel Reports from the 
drop-down list. 

A Report display is added to the Worksheet. 

Click the ‘No Task’ icon in the display title bar 
and select ‘Current Outing’ from the drop-down 
list. 

  

63 
Holding down the Ctrl key, click and drag the title 
bar of the Report display. 

When you release the mouse button a copy of the 
first display is added to the Worksheet. Creating a 
new display in this way copies the parameters of the 
original display. Therefore the new display will be 
connected to the Current Outing task. 
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64 
Connect the second Report display to the 
‘Compare Cars’ task. 

  

65 
With the ‘Current Outing’ Report display in 
focus, select Properties from the context menu. 

The Excel Reports properties dialog opens. 

The Excel File field shows the filename of the Excel 
file linked to all tables in the display. This file is the 
template for the report. In practice the Excel file 
would be formatted beforehand to correspond to 
your data output. The Browse button is used to 
locate the Excel File. 

  

66 
Click Browse 

The Select Excel File dialog opens. 

Browse for the Excel File that you wish to use as 
a template. 

Click OK and OK again in properties dialog to 
return to display 
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67 
The Display shows the path to the selected Excel 
file. 

Connect the second Report display to the Excel 
file in the same way. 

 
68 

From the context menus select New Table 

A Report display is made up of one or more tables 
(up to a maximum of eight). When you generate a 
report you can choose a single table or all tables. 

The content of the table is configured in the Excel 
Report properties dialog (Table tab). 

The default report type for a table is an Outing 
Report. 

  

69 
Add a second Table. 
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70 
Go to the Selection Explorer and select the 
following channels for the Report display that is 
connected to the Current Outing task. 

Press Eng Oil, Press GBX Oil, RPM, Speed, Temp 
Eng Oil, Temp Eng Water, Temp Gbx Oil. 

These channels will then be available for inclusion in 
individual tables. 

Highlight Table 1 and select Properties from the 
context menu. 

The Excel Report properties dialog opens. 

  

71 
Select the Table tab. 

  

72 

Click new button  to add a blank line to the 
table, ready for a new channel. 
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73 
Open the drop-down list of channels and Select: 
Press Eng Oil. 

The values that can be displayed in the report can 
be calculated from channel values using the 
following functions (selected in the Telltale column): 

Min/Max, Mean, Standard Deviation, Start Value / 
End Value. Leave the Telltale in its default condition 
for this example, i.e. Max. 

 
74 

Add more new lines and select the remaining 
channels as shown here. 
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Note: The Get Cell button opens the Excel file associated with the display. In the Excel file 
you select a cell that will define the top left cell of the data read into the file. If the Excel file 
has been formatted with heading information such as Title, Track etc. a starting cell should 
be selected below this. 
 

75 
Click Get Cell  

The Excel file opens  

Bring the Excel file to the front of your Desktop 
and click a cell that will be the top left starting 
point of your table. 

Bring Pi Toolbox to the front of your Desktop 
and click Get Cell again. 

The starting cell is entered in the field. 

Click OK to go back to display 

 

  

76 
Highlight table 2 and open its properties. 
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77 
Select the Table Tab 

In the Type field select Split 

Configuration of channels is unnecessary in a Split 
type report. The Report looks at times for key 
segments or features of the track (e.g. slow corners, 
fast corners, straights). 

Click Get Cell to choose a cell defining the top 
left cell of the table. 

Click OK to return to the Report Display 

  

78 
Highlight Table 1 and select Run Table from the 
context menu. 

The data from the channels selected for this table is 
read into the selected Excel file. 

 

  

The output from the table created 
should look similar to the illustration 
shown. The ‘template’ Excel file can be 
formatted with titles and heading 
information prior to report generation.  

 

  

Note: You may need to change the Excel file cell format. For instance, if your output data is 
in times, you may need to change the cell format to display times correctly, e.g. 00:01:51. 
See Data Format in Excel, page 351. 
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Concepts 
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What is Pi Toolbox? 

• Pi Toolbox is a standalone application that uses the concept of Workbooks. All 
work is done in Workbooks, which contain all the information about the 
environment you create in them. Only one Workbook can be open in the Pi 
Toolbox container at any time. 

• Workbooks can hold up to 16 worksheets. You can create as many Workbooks 
as you like and save them for later use. Distribute a single Worksheet or a 
complete Workbook by email or on disk to other team members. All channels, 
outings and anything else you create, is saved in the Workbook so that others 
can see exactly what you see. 

• The manipulation of data is quick and efficient. Intuitive display area features let 
you move displays quickly around the Worksheet (or to another Worksheet) to 
create the layout you want. 

• The foundation of Pi Toolbox and its future development is centered on event-
based technology. Events can be used for system error detection and car 
performance analysis. 

• The concept of Task based data manipulation is fundamental to the operation of 
Pi Toolbox.  Tasks contain outing data and provide the connection between the 
data and displays. 

• COM technology gives you the flexibility to embed Pi Toolbox displays in other 
applications that support ActiveX™ such as Microsoft Excel™, giving fully 
integrated and flexible data analysis. The open architecture allows Visual Basic 
and C++ programmers to develop Tools for specialized analysis tasks. 

• Intuitive editing tools allow you to create and distribute math channel definitions 
quickly. 

• Existing users can obtain new controls from Pi, in order to expand their toolset 
within the application.  

The following pages explain how Pi Toolbox's flexibility allows you to distribute anything you 
create freely around the team, letting others use the templates you create. 
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Event based Technology 

Events are points of interest that occur at a specific instant in time. An event is generated 
when a set of conditions are true.  

Events can either be generated in the Sigma hardware system, referred to as Hard Events, 
or can be created locally on the PC, referred to as Soft Events. 

Hard or soft events can be displayed as markers on Time and Distance displays, or in Event 
Displays, giving the user the means of automatically searching through data to find points of 
particular interest. 

Unlike hard events that are part of the outing data, soft events are always calculated at run 
time on the PC. 

Events can be used for system error detection or when analyzing car performance, and form 
the basis of future enhancements in Pi Toolbox. 

Soft event definitions can be exported in a single external Event Definition file and can then 
be subsequently imported into other Workbooks. 



 

 

Flexibility within your 
work environment 

The open architecture enables fully integrated and flexible data analysis, allowing controls to 
be embedded in your software, with full Pi Toolbox functionality.   

 

 Server.

Pi DATA ACQUISITION 
(Sigma Hardware only) 

 Test Data.

 Simulated Data. 

USER DATA 

Data displayed in 
the Pi Toolbox 
container. 

Data displayed in 
the user’s Bespoke 
Software: VB, VC++. 

 Either:. 

 Or:.  Or:. 

 Weather Data. 

 Wind Tunnel Data. 

Pi 

 

 

Data displayed 

in Microsoft 
Excel.
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Using displays in Microsoft Excel 

 

The example above illustrates the potential use of Pi Toolbox components in Excel 
worksheets. The concept of task based data manipulation is retained, as are many other 
data analysis features. 

This advanced functionality is intended for users with knowledge of coding in VBA. A sample 
of VBA code for Excel is shown in Appendix C.  

Note: There may be a reduction in data processing performance when using Pi Toolbox controls 
in Excel or Visual Basic Environments. 
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Workbooks and 
Worksheets 

 Organize. Workbooks 
can contain up to 16 
Worksheets. Each 
Worksheet contains up 
to eight displays. 

 Store.  

Everything you do 
in Pi Toolbox is 
contained in a 
Workbook. 

 

 Save.   Analyze.  

Open a Workbook 
in Pi Toolbox (or 
create a new one). 
Add Worksheets, 
add displays, 
create layouts. 

 Distribute.  

Email layouts. Workbooks contain 
Math Channels, Soft Events etc. 
Worksheets contain Displays. 
Displays contain local channel 
properties. 
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Distribution 

One of Pi Toolbox’s most important features is the ability to distribute workbooks, worksheet 
layouts, displays (in fact, anything you create) around the team. Some of the great 
advantages are the ability to create templates for common use; save workbooks after the 
occurrence of an event and distribute for analysis by others; share definitions of math 
channels, constants and soft events; and distribute displayed and qualifying data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exporting and Importing Data 

Pi Toolbox provides import and export wizards to make the distribution of work quick and 
simple. 
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Key Features 

 



 

 

The Principle of Tasks and Outings 

What are Tasks? 

A task is a collection of outings, created and controlled in 
the Task Explorer and color-coded for identification.  

A task can be connected to any display in the Workbook 
(on any Worksheet). When you connect a display to a 
task you ‘associate’ it with the outings contained in the 
task. Once a display is connected, the contents of the 
task, and any changes you may make to the content, will 

be conveyed to the display. For example a Time and Distance display connected to a task 
called ‘Current Outing’ may be showing a gearbox temperature trace for lap three. If you 
change the lap selection of the outing in the task to lap four, the connected display changes 
accordingly. Alternatively you may replace the outing data in ‘Current Outing’ with a new 
outing. Again the connected display will change accordingly.  

When the connection is made between the task and its contents, and a display on the 
Worksheet, the elements of the display can be built; i.e. the channels and events selected, 
properties set, math channels defined, etc. The display has a knowledge of which Task it is 
connected to, so that when outings are replaced, or added, to the task, the display shows 
the same channels, properties, events etc., for the new data and/or additional data. 

Note: The sort order for outings contained in a task is defined in the Options dialog. The default 
sort order is set to ‘Create Date in Ascending order’. 
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The Task Cursor 

Displays connected to the same task share a common Data Cursor position. As you move 
the cursor along the X-axis or click a data point or event, the cursor moves simultaneously in 
all displays connected to the task. 

Using this feature you can copy a display and, by setting different zoom levels, view data in 
detail on one display while maintaining an overview in the other. 

Tasks and Outings 

To each task you add one or more outings, up to a maximum of eight. The data channels 
contained in the outings can then be selected for the displays connected to the task.  

Note: If a display is connected to a task that has more than one outing dataset added, selecting a 
channel for the display will cause a trace to be drawn for every outing added. 

Connecting Outings 

Some displays, e.g. Bit Indicators, Channel displays, handle data from only one outing. In a 
task of more than one outing, select which outing the display is connected to as follows: 

1 Make sure the appropriate display has focus. 

2 Highlight the desired outing and select:  > Connect. 

The outing icon will change from this:  to this:  to show that it has been selected. 
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Tasks containing multiple outings 

Channel data is plotted using global properties unless a local override exists. Therefore the 
color of individual channel traces on a display depends upon the channel's properties. If a 
task contains multiple outings, all channel traces are plotted in the outing color, not 
individual channel colors. The outing color is set by highlighting the outing in the upper pane 
of the Task Explorer, and editing the color property in the details pane. 

With multiple outings added, cursor value legends are grouped 
together in the cursor region. The illustration shows a cursor value 
for every outing contained in the task. 

In a display one channel is the 'Active' channel, or the channel in 
focus, its cursor value legend is highlighted. The active channel 
can be changed by clicking on the legend or using the  keys. 
See Time and Distance Displays, page 243. 

When using multiple outings, the active channel determines which 
outing is the 'Active Data Selection'. In this illustration, with a 
channel from the 'red' outing highlighted, the red outing is active.  

Changing the active data selection on the display in focus changes the active data selection 
in all displays connected to the same task. 

Note: For visual reference, the Y-axis scale and statistics are displayed in the same color as the 
active channel. For multiple outings they are displayed in the color of the active data selection. 
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Selecting laps 

When an outing is initially connected to a task, the fastest lap of the outing is loaded. This 
data is then available to be displayed through selected channels. 

The Select dialog lets you select the lap or set of laps you want to analyze. 

To open the select dialog select:  Data > Select > Laps (alternatively double-click an outing). 

Shortcut:  +  +  

 

Useful shortcuts 

 +   Selects all laps in the outing. This command affects all displays connected to the 
task. 

 +  Selects the quickest lap in the outing. This command affects all displays 
connected to the task. 

 

Note: You can select a single lap or a number of laps from an outing to display. You can quickly 

change the lap selection from within the display by pressing:  +  +  / . 

 If, for example, you have laps 12 to 14 selected, pressing  +  +  will advance the 
selection to 13 to 15. 
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Automatically updating tasks 

Using the Auto Update command, a task can be made to ‘watch’ a directory for new outings, 
as they become available. This is typically when data has been downloaded from the car at 
the end of a run. The task will automatically ‘Add’ the outing to the task or ‘Replace’ the 
current outing, depending upon the parameters set. In this way displays can be updated with 
the latest data downloaded to a network server. 

Users can specify the source directory for new outings, a target outing and the time region to 
be selected from the target outing. 

The Auto Update mechanism works by scanning the source directory for the most recent file 
creation time. If the latest time stamp becomes more recent since the last scan, Pi Toolbox 
automatically adds/replaces the respective file. 

Auto update is configurable on a task-by-task basis. 

To enable Auto Update: 

1 Highlight a task in the Task Explorer. 

2 The task’s properties are displayed in the details pane. 

3 Expand the Auto Update options. 

4 Click Enabled and select ‘Yes’. 

5 Click ‘Select’ and choose a time region to display. 

6 Use the selection property to specify what time region is to be displayed from the 
new/updated outing. 

7 Click ‘Source’ and use the ‘Browse for Folder’ dialog to locate the watched 
directory. 

8 Click ‘Target’ and select the outing to be added/replaced. 

 



 

 

Auto update options 

 

 

Note: When the task contains the maximum number of outings (eight), adding another outing to 
the watched directory will have no effect on the task. 
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Layout customization 

When you add a display to a Worksheet, you change the display area of the Worksheet. Pi 
Toolbox assembles displays intelligently as you add them to make best use of the available 
screen space. 

However, resizing and repositioning displays in the Display Area could not be easier.  

Resize displays using the splitter: 

Hold the mouse cursor over the border of two displays, or the intersection of three or four 
displays, then as the cursor changes click and drag to resize. 

 

Reposition using click and drag: 

Click the title bar of a display and drag to a new position in the Display Area. As you drag 
you will see a bounding box that changes shape as you move the display. This is the area 
that the display 'snaps to' when you release. 
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Did you know? 

When you click and drag, hold down the CTRL key to copy the 
display. 

Drag the display onto a Worksheet name tab to move the display 
to that Worksheet.  CTRL + drag to copy to another Worksheet. 

You can also cut, copy and paste, see page 121. 
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Typical Layout 

Using both resizing and repositioning techniques, you can customize your Worksheet layout 
to suit your needs. 

A typical layout might look like this: 

 

 

Maximize Workspace 

All displays on the Worksheet can be maximized to make use of all the available display 
area. When maximized, all displays on the Worksheet can be scrolled through by using the 
arrows on the display title bar. 
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Real-time Outings 

The principle of tasks and outings in Pi Toolbox is applied to Real-time data as well as 
historic data (Pi Datasets). The Real-time options on the Add (outing) dialog are used to 
connect the task to Real-time data servers. Telemetry and Watch data can be viewed and 
analyzed in Time and Distance displays, X-Y charts, Histograms, Event displays, Channel 
displays, Bit Indicators, Chart Recorders and Maps. Maps display single or multiple car 
cursors to indicate track position. 

Real-time data can be exported as a Pi Dataset from Time and Distance displays. The data 
exported starts at the beginning of the data stream and ends at the time that the Export 
command was executed. 

Active channel & Data 
selection persistence 

Active channel 

In a display one channel is the 'Active' channel, or the channel in focus. For visual reference 
the Y-axis scale is displayed in the same color as the active channel, and its cursor values 

legend is highlighted. You can scroll through the available channels using the  keys, 
making each in turn the active channel. The data cursor is a vertical line drawn through the 
active channel trace from the X-axis to the upper limit of the Y-axis.  

You can move the Data Cursor along the active channel trace using the  keys. 

Data selection 

The Data Selection is the portion of the Outing data that is selected for displaying. Outings 
are contained in Tasks that are associated with displays. Therefore a display on the 
Worksheet shows a selection of the data held in its associated Task. A Data Selection can 
be a single lap, multiple laps or the complete outing. 
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Persistence 

Active channels/active channel pairs and data selections in displays that support active 
channels are persisted when the Workbook is saved and subsequently opened. 

Exported displays that are imported into other Worksheets also persist their active 
channels/channel pairs.  

 

Cut, copy and paste 

Throughout Pi Toolbox there are numerous ways in which you can use the Cut, Copy and 
Paste Features. Generally the commands are available when the toolbar buttons are active 
(not grayed out). 

The standard Windows shortcuts for these commands apply: 

 +   = Cut 

 +   = Copy 

 +   = Paste 

 

Here are some examples of where you can use these commands: 

• Copy and Paste Displays across Worksheets and Workbooks 

• Copy and Paste Displays into Excel spreadsheets or Word documents as 
Enhanced Metafiles 

• Copy and Paste outings across tasks. 
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Printing displays 

Selected displays or whole worksheets can be printed from Pi Toolbox. You can also select 
to print all of the axes for displays with more than one axis. 

The Print dialog 

You can open the print dialog from the file menu, File > Print; or by using the keyboard 
shortcut CTRL + P. 

Print options 

Active display:  Print the display that is currently in focus on the worksheet. 

Worksheet: Print all of the displays in the worksheet. 

Print all axes: Print all axes for all channels selected for the display(s). 

Note: The print all axes option is independent of the multiple axes (link) setting for individual 
displays, which is a per-channel setting. Users can view displays with active channels axes only, 
but print out all axes for reference. 

You can preview the display, using the Print Preview option, before printing. 

Note: Cursor value legends are only included on the printed output if they are visible on the 
display. Statistics are shown for the active channel in all data selections. 



 

 

Print preview 

Selecting File > Print Preview opens the Print Preview window that displays how the 
printed output will appear, either for the worksheet or a display.  

Print preview options 

Active display: Prints the display that currently has focus on the worksheet. 

Worksheet: Prints all of the displays on the worksheet. 

To adjust page margins and page orientation for the printed output, close the Preview 
window, then click File > Page Setup. 

The printed output includes: task and display title, outing properties and the time and date of 
printing. 

Example images 
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Expandable toolsets 

Users of Pi Toolbox can expand their toolset within the application by obtaining additional 
controls from Pi Research. These can be distributed via the Pi Website, by email or on CD. 
When the controls are installed, new menu options are activated within the existing Pi 
Toolbox container, immediately integrating the new controls with your existing toolset. 

Software Development Kit 

A Software Development Kit (SDK) is available from Pi Research for the purpose of 
expanding the capabilities of Pi Toolbox. For example, creating new controls, math channels 
and noise filters. The SDK supports Microsoft Visual Studio 6 or higher. It is supplied with its 
own user documentation and is therefore not covered in this guide. For further information 
contact your Pi Representative. 

Quantities and Units 

Channel data units can be quickly changed in the Properties Explorer, instantly changing the 
values shown in the cursor value legends on the displays. 

 A channel highlighted in the explorer displays properties in the details pane. Double-clicking 
‘Unit’ displays a drop-down list of units appropriate to the channel quantity. Simply select the 
units you require.  

Quantities and units can also be selected for math channels and can also be user defined.  
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Display type summary 

Pi Toolbox is designed to let you view and manipulate data. Using the software you are 
better equipped to make informed decisions about your race setup and make changes to 
improve performance. 

 

• Time/Distance Displays - let you display data against time or distance. 

• X-Y Displays  - lets you plot one channel against another. 

• Histograms - show data in percentage and time values between specified 
boundaries. 

• Reports - can be designed for specific analysis requirements; stored and re-run 
with any outing. Layout and printing is performed in Microsoft Excel. Excel allows 
easy manipulation of data, and the development of complex report integration 
using comprehensive mathematical and statistical functions. 

• Maps - show a pictorial representation of the track, built from logged data. 

• Video Displays - enable MPEG files to be viewed in synch with Task Cursor 
time. 

• Bit Indicators - examine system status channels looking for error conditions. 

• Channel Displays - display the numeric values of the selected channels for real 
time (last point) or historic data. 

• Event Displays – display events from both real-time and historic data, 
depending on the type of data stream it is associated with. 

• Chart Recorders - display real-time data from the car as it proceeds around the 
track. The chart constantly updates with the latest data, resulting in a scrolling 
behavior. 

• Navigators - provides a quick and easy means of selecting time regions within 
outings, changing the range of data plotted by displays connected to the same 
task. 

 

 



 

 

 129 

 

Time/Distance displays 

The Time and Distance display is typically the most commonly used, as you can relate data 
to actual track position or time. By overlaying data from several laps you can compare 
visually the difference in performance at any point on the track. Time and Distance displays 
can be configured to show either Time or Distance on the X-axis. 

Normally you will look at a single lap of data or part of a lap. Often it is useful to look at data 
for more than one lap, and perhaps over the entire outing. This can be useful for noticing 
trends such as the temperature of the engine. 

X-Y plots 

An X-Y plot allows you to plot one channel against another and can be used to identify 
patterns of behavior. Plotting RPM against Speed produces a characteristic saw tooth plot 
showing how each gear is used through the speed range. 

X-Y plots are useful for analyzing vehicle dynamics. Plotting lateral acceleration against in-
line acceleration gives a characteristic 'traction' or 'g-g' diagram. By comparing two plots 
from different laps, it may be possible to identify handling characteristics, and how close the 
driver is to the limit of the vehicle's performance. 

More advanced use of the X-Y plot involves creating and plotting Math channels to analyze 
the dynamic behavior of the vehicle. 
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Histograms 

A histogram is a graphical method of displaying the distribution of data against time in the 
form of a bar chart. 

Each bar represents how long each channel spends between two bin values. 

For example a histogram may be used to display the time a car spent in each gear, helpful 
in determining if the gear ratios are correct for a given set of conditions. 

The Y-axis displays the range of values of the active channel, divided into a number of bins. 
The axis is displayed in the color of its associated channel. 

The X-axis shows the absolute time or percentage of time that each channel spends 
between two bin values. 

The Bin-axis (to the right of the plot area) shows the absolute time and percentage of time 
for every bin. 

Microsoft Excel reports 

Pi Toolbox lets you design reports to show exactly the information you want quickly and 
efficiently in Microsoft Excel. 

Split reports 

The Split report is based on the track sections. Each track section is marked by a split 
beacon point. This can be a physical beacon or a beacon inserted using the software. By 
dividing the track into appropriate sections you can see how fast and consistent the driver is 
in each section of the track. By comparing laps you will notice how adjustments made to the 
setup affect performance. 

Creating a Split report using elapsed time gives a very useful Split Time report. The Split 
Time report provides two unique performance indicators: the theoretical fastest lap and the 
fastest rolling lap. 
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The theoretical fastest lap gives the lap time that could be achieved if the best split section 
times from an outing were all in one single lap. 

The fastest rolling lap is the fastest lap time using a start and end point, which may not be 
the end-of-lap beacon. Comparing achieved lap times to the theoretical fastest lap time 
shows driver consistency. 

Tabular Outing report 

The Tabular Outing report is useful when used with the entire outing plot. The Tabular 
Outing report shows channel values lap-by-lap for the entire outing and is ideal if you want 
to analyze trends during an outing; for example, engine temperatures or pressures. 

Tabular Lap report 

The Tabular Lap report uses the map segments created by the mapping software to divide 
laps into straights and corners. Tabular Lap reports show channel values for segments of 
each lap. 

Event reports 

Event reports show when an event occurred and any associated channel values. 

Video displays 

This display enables Video data to be viewed synchronized with Task Cursor time, on 
displays sharing the same task. As the video is scrolled forwards or reverse, cursor 
movements are made simultaneously in all displays connected to the same task. 

Bit Indicators 

The Bit Indicator control enables the engineer to examine system status channels looking for 
error conditions to occur. A typical example would be where the health status channel 
comprising a 32 bit word which had Bits 0, 1, 2, 5 and 7 assigned to the errors identified in 
the gearbox. 
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Channel displays 

The Channel display can display multiple channels from the connected data selection. 
Channel names, values and units are shown in a list view. The position of channels in the 
grid, and the grid format, can be specified. 

Event displays 

The Event Display, displays events in a list view from both real-time and historic data, 
depending on the type of data stream it is associated with. 

Selecting an event in the display causes the task cursor to be set to the event's timestamp. 
All displays connected to that task navigate to the time the event occurred. For example a 
display can be set up to show gearbox parameters such as temperatures and pressure, 
together with more general car parameters such as lateral acceleration, speed. Then if an 
event occurs, say, 'Low Gearbox Oil Pressure' and is selected in the Event display, the 
cursor positions in the associated displays update, allowing engineers to see what other 
parameter values were at the event time. 

The principle of connecting tasks to a display and selecting channels for viewing, as in 
Time/Distance Charts, applies to Event Displays. 

Layout Options 

The information shown for listed events is controlled in the Layout tab of the Properties 
dialog. The event name is always displayed. Time, Source, Category and Message columns 
can be shown or hidden as required.  Column widths can be customized by dragging the 
vertical border between columns. 

Chart recorders 

A Chart Recorder provides a means of viewing real-time data from the car as it proceeds 
around the track. The chart constantly updates with the latest data, resulting in a 
characteristic scrolling behavior.  
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Constants 

Constants let you express numerical values as a 'word' that can be used in Math channels. If 
you use the constant in several Math channels and you want to change its value then you 
need only change the constant definition; the Math channels will then all use the new 
constant value.       

Soft Events 

Unlike ‘hard events’ that are part of the outing data, ‘soft events’ are always calculated on 
the PC at run time. Engineers may need to create their own events based on set conditions. 
An example could be during a circuit test to investigate the efficiency of the gearbox oil pick-
up when the car is accelerating or braking. In this instance stationary and cornering 
conditions would need to be excluded.  

Math Channels 

There is a limit as to what can be measured by sensors. A greater understanding of 
performance can be gained by combining data and physical constants in mathematical 
equations, the result of which is a Math channel; this can be plotted on displays and used in 
histograms and reports. 

Pi Toolbox is supplied with a comprehensive set of standard math functions. 
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Advanced features 

User written channel sources 

Pi Toolbox allows you to link to your own external math functions. User Math Functions are 
written as a DLL (Dynamic Linked Library) to a format specified by Pi Research. When you 
run Pi Toolbox the DLL is linked and the User Functions appear in the Add in Manager 
dialog and can be accessed by any part of Pi Toolbox. 

Typically User Math allows you to provide data, for which description by an equation is 
insufficient, for example an accurate kinematics model of the car. 



 

 

The Explorer 

The way the Explorer works should be familiar to most users of Windows applications. The 
Explorer is where you create tasks; load outing datasets and select channels from the 
outings to display. When you have finished work in the Explorer it can be quickly hidden to 
maximize the screen area for data analysis. 

The Explorer has four panes, the Task Explorer, the Selections Explorer, the Channel 
Properties and the Event Properties Explorer. You can quickly switch between the three 
using keyboard shortcuts.  

The Task Explorer is mainly used to create tasks, add outings to the tasks and select the 
laps that you are interested in.  

The shortcut  +  opens the Task Explorer. 

The Selections Explorer is used to select channels, events and other elements for individual 
displays.  

The shortcut  +  opens the Selections Explorer. 

The Channel Properties Explorer is used to manage channel properties, affecting the 
appearance of the displayed data.  

The shortcut  +  opens the Channel Properties Explorer. 

The Event Properties Explorer is used to view and edit event properties, and select priorities 
for events to be assigned to. This Explorer has two tabs, Workbook and Display: 

The shortcut  +  will open the Event Properties explorer. 

Note: Tasks are an important feature of Pi Toolbox. A Workbook can contain up to eight tasks, all 
of which are available to each Worksheet contained in the Workbook. They can contain single 
outings or multiple outings up to a maximum of eight. The outings that you add to a task are 
available to all displays that you create and connect to the task. Connecting displays to the same 
task provides you with added functionality such as linked data cursors and linked zooming. 
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The Task explorer 

Pi Toolbox opens with the Task explorer in view. This is where tasks are created. Tasks are 
a convenient method of storing outing data. You create a task by right clicking in this pane 
and selecting the 'Add Task' option. When you highlight a task, its properties (Color Name 
and Description) are displayed underneath in the Details pane. 

 

Note: To change a task property, double-click the property name. 

Click the  icon to expand the task and view its outings. 

136 Pi Toolbox User Guide 

 



 

 

The Details pane shows the properties of the task currently highlighted above. If you have a 
task expanded and an outing highlighted, details of the outing will be displayed here. 

 

Note: To change a task property, double-click the property name. 

Working in the Task explorer 

You can perform various tasks in the explorer. 

Adding a task 

1 In the upper pane select:  > Load Task. 

2 A task called Task 1 is added. 

3 Double-click Name in the Details pane 

4 The name Task 1 is highlighted. 

5 Overtype Task 1 with a name of your choice. 

6 Press Return. 
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7 Connect a task to a display 

8 Make sure that the display that you want to connect the task to is selected (has 
the current focus). 

9 In the Data menu, select: Connect > Task task name 

10 The display is connected to the task. The colored task icon will change from 
looking like this  to this . 

Note: You can also connect to a task by using the Connect Task button, the task icon on the task 
bar, or the Connect menu item from the Task view. 

Load an Outing 

1 Click on the task that you want to load the outing into. 

2 Select:  > Add Outing. 

3 In the Load Outing dialog, browse for the required outing dataset (.pds file). 

4 Select the required outing dataset. 

5 The Outing details are summarized in the Details pane of the Load Outing 
dialog. 

6 Click OK. 

Select Laps 

When an outing is initially connected to a task, the data from the fastest lap of the outing is 
loaded. 

Highlight the outing whose laps are selected. 

Select:  > Select Laps (Alternatively double-click the outing or press Enter). 

The Select dialog lists all the laps contained in the outing. 

Select the required lap or laps. 

To highlight a group of laps: Click the first in the group, the Shift + click the last. 

Click Select. 



 

 

Set the datum outing 

If a task has a number of outings loaded, you can choose one to be the datum. 

Click on the outing you want to make the datum. 

Select:  > Make Datum. 

The outing is now the datum, indicated by the  icon. 

Task properties 

Task properties are displayed in the details pane when a task is highlighted or selected. The 
properties can be listed in categories that can be expanded or collapsed, or listed 

alphabetically. To change the method of display select:  > alphabetic/categorized. 

Appearance 

Color: The identifying color of the task. Double-click the color panel to select another 
color from the color palette. 

Description: Double-click to enter a short description of the task. Press Enter to close 
the dialog. 

Name: Double-click and type a name for the task. Press Enter to close the dialog. 

Auto Update 

Using the Auto Update command, a task can be made to watch a directory for new outings. 
The task will automatically Add the outing or Replace the current outing, depending upon 
the parameters set. In this way displays can be updated with the latest data downloaded to a 
network server. 

Enabled: Click Enabled and select Yes or No from the drop-down list to 
enable/disable Auto Update. 

Source: Click Source, then click the browse button. Use the Browse for Folder dialog 
to locate the watched directory. You can type the path to a directory that does not 
currently exist in the text field below the explorer view. 

Note: A dialog box will be displayed telling you that the path cannot be found. You must click Yes 
to enable the path.  
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Target - Use the Target property to determine how Auto Update responds to new 
outings. Click Target and select an option from the drop-down list. 

Data selection caption: The outings added to the current task are listed 
here. When the selected outing is updated in the source directory, the task is 
updated. 

Add Always: Any new outing added to the source directory will be added to 
the task. 

Add Initial: This is the default option. The latest dataset added to the source 
directory will be added to the task. The target will then be set to that outing. 

Time regions 

Initial Selection: Use the selection property to specify what time region is to be 
displayed from a data selection added to a Task, or replacing an existing data 
selection in a task: 

Fastest Lap: Displays the fastest lap from the outing. 

Entire Outing: Displays the complete dataset 

Last Region: Display the lap leading up to the last lap marker. 

Unchanged: As outings are updated or added, the current time region selected will 
not be changed. 

Note: This property affects all outings added/replaced in the task. You can define a time region 
globally (across the workbook) by setting the time region default in the Preferences dialog. The 
time region defined for the task overrides the global setting.  

Outing properties 

Outing Properties are displayed in the lower Details pane when an outing is highlighted in 
the upper pane. 

Properties can be listed in categories, which you can expand or collapse, or listed 

alphabetically. To change modes select:  > alphabetic/categorized. 
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Appearance 

Color: The default color of the outing. When two or more outings are contained in a 
task, all channel traces will take on the default color of the outing it is contained in. 
This does not affect the individual properties of channels. 

Data Selection: Displays the outing caption and the data (Lap/s) selected for display. 
The outing caption can be configured in the Outings tab of the Options dialog. Select: 
Tools > Options to open the dialog. 

Details 

There are several properties in the Details section that can be changed, such as Driver 
Name and Track Name. This information is included in display print-outs. 

Comments 

Short Comments / Long Comments: Double-click to enter a short and/or long 
comment. 

Note: Long comments can be more than one line. You can also insert a carriage return by using 
Shift + Enter. The long comment will be displayed as a tooltip when there is insufficient space in 
the Task Explorer. 

Lap Information 

Lap Information is not editable. 

Outing 

Outing Information is not editable. 

Data 

Show Hidden Regions: Double-click and choose Yes or No to show/hide hidden 
regions e.g. Warm up and Cool Down laps. 

Time Offset: When the task contains more than one outing, a time offset can be 
added to change the position of one outing relative to another. Double-click, enter a 
time offset then press Return. Offset can be set manually in a Time/Distance Chart. 
See the relevant help topics for the Time/Distance Chart.  



 

 

Task shortcuts 

The following shortcuts apply to the Task List in the upper task window, and the Properties 
List in the lower task window (with an outing selected in the upper task window). 

Task list 

Shortcut Description Menu 

 +   

 +  
Creates a new task from anywhere in Pi 
Toolbox.  > Add Task 

 (task highlighted) 

Opens the Add Outing dialog that is used 
to locate and load outings into the 
selected task. 

 > Load Outing 

 ( outing highlighted) 

Opens the Select dialog which is used to 
select laps for the current outing. 

 > Select Laps 

 (task highlighted) Deletes the highlighted task or outing 
from the current Workbook. 

 > Delete Task 

 +  Selects all laps in the outing (outing 
highlighted or display in focus) 

 

Selects the fastest lap in the outing 
(outing highlighted or display in focus) 

Properties list 

Shortcut Description Menu 

 

Edits the highlighted property None 

 Cancels the Edit None 

  Expands or collapses property category None 

  Expands/Collapses category and 
navigates up and down 

None 
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The Selection explorer 

The available channels of data and events contained in the loaded outings are listed in the 
Selection pane. These include channels and events from outings as well as math channels 
and soft events created in Pi Toolbox. You use the Selection Explorer to select channels 
and events that are to be presented on displays in the Display Area. The lower Details pane 
shows you which channels and events are selected for individual displays.  

Note: If you have several displays on a Worksheet, the Details pane shows the selections made 
for the display that has focus. 

Data channels, groups, events, cameras (and other elements unique 
to certain display types) are listed in the Selection pane. Here you 
can select elements for displays and modify them. 

Generally, a 'Channels' tab is displayed, showing a list of channels 
available from the task connected to the display in focus. For Excel 
Reports or Time/Distance displays, a second tab 'Events' shows 
events available. 

Some displays do not have selection tabs associated with them, or 
may have specialized tabs, e.g. Videos. 

The lower pane shows only those channels selected for the display 
currently in focus. Some displays, such as Time and Distance and 
Histogram, can have groups and individual channels as part of their 
selection. Others such as X-Y displays can have only individual 
channels associated with them. 

With the Events tab selected, the Selection Explorer is used for selecting events for the 
display currently in focus. 

 

Note: The Selections Explorer generally has two tabs: Channels and Events. This allows 
channels and events to be listed separately. However, both channels and events are selected in 
a similar manner. 
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To add a channel to a display: 

Note: See Quick Start on page 64 to help you create a display 

1 Make sure that the display you want to add a channel to has focus. 

2 Go to the Selections Explorer and select the Channels tab. 

3 Enter the first few letters of the channel you want to add. 

This reduces the channels in view to those starting with the letters you type. 

4 From the Matching Channels list double-click the channel to Add. Alternatively 
highlight the channel and select:  > Select. 

The channel will appear in the lower pane under 'Selected Channels’ and the data will 
be plotted on the display in focus. 

If you select the wrong channel by mistake, simple double-click the channel in the lower 
pane to remove the selection. 

Note: If the channel fails to be added to the active display, you may have reached the channel 
limit for that display. 
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Deleting or removing a channel from a display 

Channels can be deleted from the display in focus without the need to go to the Selection 
explorer and deselect channels manually. There are two ways of deleting channels from the 
display: 

• Pressing  will delete the active channel from that display. 

• The context menu option: Trace > Delete will achieve the same result. 

Deleting or removing a channel from a group 

Deleting channels from a display does not remove the channel from any groups it may be 
contained in. However the channel trace will be removed from the display. 

For example: The group shown below contains the channel Damper FL. Deleting the 
channel from the display using the delete key or the context menu. 

 

The channel trace is removed from the display and the channel is deselected for that 
display. In the group (in the lower pane of the Selection explorer) the channel is grayed out 
to show that it is deselected, but it remains in the group.  The icon  indicates that it is not 
displayed. The group icon overlay  indicates that it contains channels that are not 
displayed. 

To re-select a channel that has been deleted, select the group icon (in the upper or lower 

pane) and press . 

 

 

 145 

 



 

 

The Channel Properties 
explorer 

The Channel properties explorer is used to view and edit channel properties, which affect 
how a channel’s data will be plotted on the display. As with the Selection Explorer, channel 
groups appear at the top of the pane. 

This Explorer has two tabs, Workbook and Display: 

• In the Workbook tab, all available channels and groups are in view. Properties 
edited here affect the whole Workbook, not just the display in focus. 

• In Display tab, only those channels that are being displayed by the active display 
are in view. Properties edited here, will only affect the display in focus, overriding 
those set for the Workbook in the Workbook tab. 

The Detail pane shows the properties of the channel or channels currently highlighted in the 
upper pane. The channel properties that cannot be changed are 'grayed out'. 
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With the Display tab selected: The changes you make to 
properties are 'local' changes, and will not affect the channel in other 
displays. 

If the channel icon is overlaid as shown here,  local property 
changes have been made. 

 

With the Workbook tab selected: Changes made to a channel’s 
properties in the Workbook tab are global and will affect all displays 
in the workbook that are displaying that channel’s data. 

Note: You can change the properties of multiple channels. Simply select 
a number of channels in the upper pane and change the appropriate 
properties in the lower pane. 

 

 



 

 

About Properties 

When a channel is highlighted in the upper pane, its properties are displayed in the lower 
Details pane of the Explorer. To edit a property, double-click the property name or value and 
enter values or make selections as required. Properties are listed by category in the Details 
pane. Each category can be expanded or collapsed as required, by clicking the +/- icons, 
double-clicking the category, or using the   cursor keys. The properties can also be 
viewed as an alphabetical list by right-clicking and selecting 'Alphabetic'. 

Generally, properties that you cannot edit show their properties grayed out. 

Appearance 

Color: The channel's default (or base) color. 

Color Gradation: Enables a channel’s plotted color to be graded according to the channels 
value at that point. See Color Gradation, page 160. 

Display name: The channel name. 

Plot 

Autoscale: Enables/disables Autoscale. When Autoscale is on the trace expands to the full 
extent of the axis relating to the channel’s data, to maximize the data in the plot area. 

Auxiliary axis: Enables or disables multiple axes to be displayed on Time and Distance 
charts, Histograms, etc. A display will show a Y-axis for the active channel and a Y-axis for 
any channel it has selected having this property enabled. 

Display maximum: The maximum extents of the axis relating to the channels data when 
plotted on a display. This parameter is disabled when Autoscale in on. 

Display minimum: The minimum extents of the axis relating to the channels data when 
plotted on a display. This parameter is disabled when Autoscale in on. 

Interpolation: Determines the interpolation technique applied between sample points. 
Select either Linear or Sample and hold. 
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Y-axis percent enabled: Enables or disables Y-axis percent of the channel. When enabled, 
the Y-axis percentage occupied by the channel and its vertical position on the scale can be 
changed. 

Y-axis percent max/min: determines the maximum and minimum percentage of the Y-axis 
occupied by the channel. Use this to move a channel trace clear of other overlaid traces to 
aid visibility. 

Data 

Decimal Places: The number of decimal places to which channel values are displayed. 

Quantity: What the channel is measuring, for example pressure, velocity. 

Units: °C, MPH, KPH, liters, mm, bar, volts. 

Filter 

Filter: Select a filter type from the drop-down list. The default options are: No filter, band-
pass filter, gating-function filter, and moving average filter. When a filter is selected the Filter 
Enabled: Indicator changes to Yes. Custom filters developed using the SDK will also 
appear in the drop-down list. 

Filter enabled: Indicates filter on or off state. 

Filter Properties: Double-clicking this property opens the Property dialog for the filter type 
selected. 

For more information, refer to Data Filters on page 153. 

 

Note: Properties that exist but are not listed in the categories above will be listed in the 'Others' 
category. 

 



 

 

Global or Local channel 
properties 

Channel Properties can be changed on two levels: 

• Globally - for the workbook, so that every time you select a particular Channel 
from the outing, the new Channel properties are used. 

• Locally - for an individual display. Locally defined properties override global 
properties. Other displays using the channel will show default Channel properties 
or the properties set for the outing. 

Note: You can revert to the default properties at any time. When reverted, local properties 
change back to the channel’s global properties. 

To change channel properties globally: 

1 Go to the Properties Explorer. Shortcut:  +  

2 Select the Workbook tab 

This will make the changes globally for the outing 

3 Highlight a channel 

4 In the lower 'Details' pane change properties as necessary. For example, 
double-click ‘Color’ and use the palette to select a new color. 

5 Properties grayed out cannot be changed. 

To change channel properties locally: 
• Follow the steps above but select the 'Display' tab instead of the Workbook tab. 

This will make the changes local to the Display currently in focus. 

Note: Channel data will be plotted using global properties unless a local override exists. If 
multiple outings are being plotted the outing color will be used to plot the data instead of the 
channel color. 
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To revert Global channel property changes to default: 

1 Go to the Properties Explorer. Shortcut:  +  

2 Select the Workbook tab. 

3 Highlight the channel whose properties you want to revert. 

4 Select:  > Revert to defaults. 

To revert Local channel property changes to Global: 

1 Go to the Properties Explorer. Shortcut:  +  

2 Select the Display tab. 

3 Highlight the channel whose properties you want to revert. 

4 Select:  > Revert. 
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The Event properties 
explorer 

The Event Properties explorer is used to view and edit event properties, and select priorities 
for events to be assigned to. This Explorer has two tabs, Workbook and Display: 

In the Workbook tab, all available events are in view. Properties edited here affect the 
whole Workbook, not just the display in focus. 

In the Display tab, only those events that are being displayed by the active display are in 
view. Properties edited here, will only affect the display in focus, overriding those set for the 
Workbook in the Workbook tab. 

 

With the Workbook tab selected, all available events in the Workbook are displayed. 
Properties of the highlighted event appear in the Details pane. Event properties can be 
edited (if they are not grayed out). You can change the properties of multiple events. Simply 
select a number of events in the upper pane and change the appropriate properties in the 
lower pane.  

Events are assigned Priorities in the Details pane. These are defined in the Options dialog. 
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With the Display tab selected, only those events that are associated with the display in focus 
are shown. In 'Display' the changes you make to properties are 'local' changes, and will not 

affect the event in other displays.   This icon overlay indicates local property changes. 

Note: Changes made to event properties in the Workbook tab are global. 

To change an event property, double-click the property name, e.g. Color. 



 

 

Data filters 

Filters modify channel data by applying a math algorithm to the channel. A typical 
application would be to remove 'noisy' data from a channel by setting up a high-pass filter. 

Data filters can be applied globally or locally. When applied globally all uses of that channel 
will display filtered data. When applied locally to a channel in a specific display, the channel 
data is only filtered in that display. This means that users can now filter a channel in one 
display and simultaneously view the same channel in a second display unfiltered (or with a 
different filter). Global filters are defined in the Workbook tab of the Channel Properties 
explorer. Local filter properties are defined in the Display tab of the Channel Properties 
explorer. 

 

Filters are set up in the Property Explorer. Initially channels do not have filters associated 
with them.  Selecting a channel type from the Filter drop-down list enables the filter. When 
set up, the filter parameters are specific to that channel. Using the Filter enabled property; 
the filter can be switched on or off as required for a channel. A filter associated with a 
channel can be switched on and off as required. When enabled, a filter is applied across all 
displays in the Workbook plotting the channel. 

Note: Filter settings, configured for a particular channel, will be lost if the Filter property is 
subsequently set to ‘no filter’. 
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Gating Function filter 

Gating Function filters use preset upper and lower values to limit the data that passes 
through the filter. Data that falls outside of these values is not plotted on the display, causing 
regions of discontinuity in the data stream. 

Filter Properties 

 

Units: the units available for selection depends upon the channel that the filter is being 
created for. 

Upper: (None, Less, Less or Equal, Greater, Greater or Equal) - Selecting None means that 
there is no upper value limit on data allowed to pass the filter. Selecting Less passes data 
below the value entered in the adjacent field and blocks data above it. Selecting Greater 
passes data above the value entered in the adjacent field and blocks data below it. 

Lower:  (None, Greater, Greater or Equal, Less, Less or Equal) - Selecting None means 
that there is no lower value limit on data allowed to pass the filter. Selecting Greater passes 
data above the value entered in the adjacent field and blocks data below it. Selecting Less 
passes data below the value entered in the adjacent field and blocks data above it. 
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Examples 

Using the options available in the Upper and Lower fields, the following cases are possible: 

Inclusive Filter 

Upper (Less, Less or Equal) 

Lower (Greater, Greater or Equal) 

 

 

 

Exclusive Filter 

Upper (Greater, Greater or Equal) 

Lower (Less, Less or Equal) 
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Band-pass filters 

Band-pass filters remove frequencies above and below a preset threshold. 

Typical use: Removing high frequency noise – for example, on an accelerometer 
measuring the lateral acceleration of a car. The acquisition frequency could be 100Hz, but in 
the calculations the user may wish to reject frequency spikes and only require a maximum 
frequency of 25Hz. 

Filter Properties 

 

Upper (None or Less): Selecting None means that there is no upper limit to the frequencies 
allowed through the filter. Selecting Less passes all frequencies below the value entered in 
the adjacent field.   

Lower (None or Greater): Selecting None means that there is no lower limit to the 
frequencies allowed through the filter. Selecting Greater passes frequencies above the value 
entered in the adjacent field.  
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Discontinuity handling 

Reset: In 'Reset' mode the filter kernel is clipped on the boundaries of discontinuities 
effectively processing each continuous region as a data block. 

Ignore: Discontinuities are ignored. 

Assume Zero: Mode works much like 'Reset' in that it process each continuous region as a 
data block, however it assumes that input channel has zero values outside continuous 
regions (i.e. filter kernel is not clipped). 

Examples 

Band pass filter: A combination of low and high pass 
filters. It filters frequencies below some lower bound and 
above some upper bound frequencies. 

 

 

 

Low Pass filter: A specific upper limit frequency value 
and a lower limit of "None". 

 

 

 

High Pass filter: A specific lower limit frequency value 
and an upper limit of "None". 

 

 

Algorithm 

See Appendix D. 
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Moving Average filter 

This filter works by averaging data within a pre-set time interval around each data point. 

Typical use: Smoothing data to identify trends. 

For the sample at time T, moving average returns the integral over time interval (T-dT, 
T+dT). Linear interpolation is used to calculate values at 
the boundaries of the time region where there are no 
samples. 

 

 

 

Filter properties 

The Filter Properties dialog is accessed by double-clicking Filter Properties in the lower 
pane of the Properties Explorer.  
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Data Range: Determines the time interval around each data point for calculating data 
average. Higher settings produce smoother traces on the display. 

Discontinuities: These options determine how the filter handles discontinuous data. 

Ignore: Discontinuities are ignored. 

Assume Zero: Assumes that there is no data beyond the point where the discontinuity 
starts. 

Working with Data 
filters 

 

To add a Band-pass filter: 

1 Add a Time and Distance display and select the required channel to filter 

2 With the correct display in focus, go to the Properties Explorer 

Shortcut  +  

3 In the Details pane of the Explorer, click the Filter down arrow and select: Band-
pass Filter 

The Filter enabled property field changes to Yes. 

4 Double-click Filter properties 

The Filter Properties dialog opens. 

5 In the Upper field select: Less and enter a value in the adjacent field 

6 In the Lower field select: Greater and enter a value in the adjacent field 

7 Click OK.  
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Color gradation 

Color gradation allows Pi Toolbox displays that support color grading, to plot channels as 
graded bands of color, each color representing a different channel value. Color gradation is 
typically used in Graphical Lap Reports, although other uses could include grading bars in 
histograms. 

There are two modes of color gradation: 

Discrete: The discrete scheme grades channel values into color bins. Each bin has an 
upper and lower value. Values within those bounds are assigned to the bin’s color. 

Discrete scheme:  

 

Gradient: The gradient scheme is defined by a start and end color. The start color 
represents the channel’s lowest plot value, the end color it’s highest. Channel values lying 
between these are plotted with a color that is graded between the start and end color. 

Gradient scheme:  

 

Setting color gradation properties 
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The color gradation channel property is available in the 
Properties Explorer. To set properties, click the browse 
button . The gradation properties dialog opens and 
defaults to a ‘Gradient’ gradation scheme. 

For more information, refer to Discrete gradation 
properties on page 161. 

 



 

 

Gradient Scheme 
properties 

 

The main window is made up of two columns: Color and Threshold. 

The color property for each band is set by double-clicking the band to access a drop-down 
list of color options. These are: 

• Custom: Uses the color defined in the 'Color' property, selected from the color   
palette. 

• Channel: Uses the color property of the selected channel. 

• Display Background: Uses a color determined by the background color of the 
display plotting the data. 

With Channel-Channel selected for both nodes, the minimum color is a variation of the 
channel color so that a gradient based on the channel color is used. 

Display Background-Display Background selected for both nodes, the maximum color is 
a variation of the plotting display's background color. 

Note: There are only two color bands because a gradient scheme can only have a start and an 
end band. The 'Add' and 'Delete' buttons are therefore disabled. 
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Discrete scheme 
properties 

 

The main window consists of a three columns 'Color', >= (lower boundary) and < (upper 
boundary). 

Color 

The color property for each band is set by double-clicking the band to access a drop-down 
list of color options. These are: 

• Custom: Uses the color defined in the 'Color' property, selected from the color 
palette. 

• Channel: Uses the color property of the selected channel. 

• Display Background: Uses a color determined by the background color of the 
display plotting the data. 

Lower and upper boundaries 

Color band boundaries can be edited individually by highlighting the default and entering a 
new value. Boundaries for adjacent bands are adjusted to accommodate new bands. For 
more information see About Boundaries on page 479. 
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Context Menu Options 

Each band displays its bounds and assigned color. For each item or selected group of 
bands, the following context menu options are available. 

Insert/Delete: These commands add or delete a color band in the same way as the 
Add/Delete buttons. See below. 

Interpolate: This option determines boundary values for a selected group of color bands 
based upon adjacent bands or the top and bottom band in the selection. This command is 
only enabled when either the upper or lower band is included in the selection. 

Graduate Colors 

This option produces a smooth gradient across a number of color bands. After adding the 
required number of bands, the user selects a group of bands to apply the Graduate 
command to. The gradient colors produced depend upon the colors of the upper and lower 
bands selected in the group. 

This command is only enabled when the 'Color Source' of the top and bottom bands 
selected, is set to 'custom'. 

 Adds a color band above the band currently selected. Alternatively press . 

 Removes the currently selected band. Bounds are reassigned to take up the gap 

created. Alternatively press . 
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Working with color 
gradation 

Changing a color band’s values (discrete gradation scheme) 

1 Go to the Properties Explorer. Keyboard shortcut:  +  

2 Select the channel you want to change. 

3 In the lower pane click the  button adjacent to the Color Gradation property 

The Gradation Properties dialog opens. 

4 In the ‘Type of color gradation’ field select: Discrete. 

In the main window the color bands for the selected channel are displayed. By default, 
channels are given an upper, middle and lower band. 

5 If required, click  to add a band to the scheme. 

Additional bands are inserted above the band currently highlighted. The source color 
defaults to 'channel'. This can be changed if necessary by double-clicking the default 
value and selecting a source from the drop-down list. 

6 Double-click the upper or lower boundary of the color band that you want to 
change, so that the current value is highlighted. 

7 Enter a new value for the boundary. 

Note: Altering the lower bound will affect the upper bound of the preceding color band. Altering 
the upper bound will affect the lower bound of the proceeding color band. 

164 Pi Toolbox User Guide 

 



 

 

Setting up a gear change scheme for a graphical lap report 

The example below shows how, using a discrete color gradation scheme, it is possible to 
quickly set up a gear change indicator. The Color Band indicates the gear change points on 
the track and the Active Channel Indicator shows the color allocated for each gear. On the 
Indicator, note that the color band up to the value 2.00 denotes 1st gear, up to 3.00 denotes 
2nd gear etc. 

1 With the Map in focus, go to the Selection Explorer and select the Gear channel. 

2 Go to the Properties Explorer and click on the Gear channel. 

3 Double-click Color Gradation in the Details pane. 

The Color Gradation Properties dialog opens. 

4 In the Type of color gradation field select Discrete. 

5 Using the New button add three new color bands. 

6 Set the Lower Bound property to 2 and the Upper Bound Property to 6. 

The gap between bands should be 1. 

To set the color bands: 

1 Double-click the bottom color band and select 'custom' from the drop-down list. From 
the color palette, select a color to represent the 1st gear. 

2 Double-click the top color band and select a color to represent 6th gear. 

3 Select all color bands by clicking the top band then shift + clicking the bottom band. 

4 Select:  > Graduate Colors. 

5 Colors graded in depth between the first and last gears are selected automatically. 

6 Click OK. 

Note: In the Gear channel details pane, you can set the Decimal place property to '0' so that the 
divisions read 2, 3, 4 etc. 

You can use a discrete color gradation scheme to set up a gear change indicator scheme for 
map displays, see Setting Up a Gear Change Scheme, page 333. 
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Explorer Icon summary 

Throughout the Pi Toolbox explorer various icons are used to represent channels, math 
channels, events etc. As well as the standard icons, various overlays are used to represent 
certain conditions. Generally red overlays indicate an error condition, whilst blue overlays 
are for information. 

The tables below summarize the icons and overlays used. 

 

Icons 

 Channel  

 Hard Event  

 Soft Event  

 Real-time Channel  

 Global Math Channel  

 Special Math Channel  

 Map position icon  

 In Global Math and Soft Events the definition is invalid. In channel trees elsewhere, 
none of the outings associated with the display provide data for this channel.  

Property Explorer Icons and Overlays  

 This Properties Explorer icon represents any channel. Without an overlay it indicates 
default properties. 

 This Properties Explorer icon represents any event. Without an overlay it indicates 
default properties. 

 The properties for this event have been locally overridden. 
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Overlays 

Channels and Events 

 Undefined in at least one source outing. 

 Cyclic in at least one source outing. 

  

Channels and Channel Collections 

 Part of this group/collection is not displayed on the associated display. 

 This channel or all of this group/collection is not displayed on the associated display. 

 This overlay indicates that a channels or math channels has a filter currently applied 
(band-pass, moving average etc.). The overlay only appears in the Selection explorer. 

The icon overlay takes a low precedence over all the other possible icon overlays. If 
there is any other reason for a channel to have an overlay, e.g. the x or y overlay on 
channels selected for an XY display, the filter overlay will not be visible. 
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About Groups 

Groups are created to group together related sets of channels. They appear at the top of the 
Selection or Properties pane, above the list of Available Channels. Groups can be created in 
the Selection or Properties Explorer. Groups are dynamic elements when selected for a 
display. If you change the contents of a group (add channels, change properties, etc.) 
connected displays are directly affected. 

Note: When you delete a channel that exists in a selected group, the channel remains in the 
group but the trace is removed from the display. Selecting the group icon and pressing 'Return' 
will re-select the channel. 

With groups you can: 

• Add a group of Channels to a Display in a single action. 

• Change Channel properties or add/delete a Channel - the change is propagated 
to all Displays connected to the group. 

Note: When you highlight a channel group (or multiple channels) in the upper pane of the 
Properties Explorer, values that differ between channels in the highlighted group, are shown as 
<multiple> in the Details pane. 

To create a group (working in the Properties Explorer) 

1 Click the Workbook tab and select the channels you want to include in the 
Group. 

2 In the upper pane select:  > Add to > New Group. 

A new group folder is inserted above the All Channels folder. 

3 Highlight the folder. 

The group's properties are displayed in the Details pane. 

4 Double-click Group Name. 

5 Enter a Name and press Enter. 

The new group name appears in the upper pane. 
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To create a group (working in the Selection Explorer) 

1 Click the Channels tab and select the channels you want to include in the group. 

2 In the upper pane select:  > Add to > New Group. 

An empty new group folder is inserted above the Available Channels folder. 

To rename the group go to the Properties Explorer,  + . 

3 Highlight the folder. 

The group's properties are displayed in the Details pane. 

4 Double-click Group Name, enter a name for the group and press Enter. 

The new group name appears in the upper pane. 

The channels you have selected appear in the group folder. When you highlight a channel, 
its properties appear in the Details pane. 

Adding the group of channels to a display is the same as adding a single channel to a 
display. Make sure the correct display has focus and double-click the group in the upper 
pane. The group will appear in the lower pane of the Explorer and the channel data will be 
loaded into the display 

Note: You can also create a group by selecting a number of channels, right clicking and selecting 
the Add to > New Group option. 
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To add a channel to a group: 

1 Open the All Channels list. 

2 Filter the list if necessary. 

3 Highlight the channels you want to add to the group. 

To highlight a sequential group of channels: Click the first, then Shift + Click the last. 

To highlight a discontinuous group of channels: Ctrl + Click the required channels. 

To highlight two separate blocks of channels: Shift + Ctrl + Click. 

4 Select:  > Add To (choose from the existing groups or create a new one). 

Note: To reduce the number of channels in view (filter), types the first letter or letters of the 
channel you are looking for. Press Esc to remove the filter.  

To remove a channel from a group: 

1 Open the group folder to view the channels 

2 Highlight the channel you want to remove and select:  > Ungroup. 

Note: Group names must be unique in the Workbook. 

To remove a group from a display: 

1 Make sure that the display you want to remove the group from has focus 

2 Go to the Selection Explorer,  +  

3 In the lower pane highlight the group or channel you want to remove 

4 Select:  > Remove or press . 

Note: To delete the group, in the upper pane select:  > Delete Group 
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Changing channel group properties 

The properties of channels in a group can be edited simultaneously by highlighting the 
group. 

When a group is initially created, the channels within it retain their properties. The properties 
of each channel within the group can be edited individually or in multiple selections. All 
channels in the group can be simultaneously edited by selecting the group. Even other 
groups and channels can be brought into the selection to have their properties edited 
simultaneously. 

To change channel properties globally in a group: 

1 Go to the Properties explorer .Keyboard shortcut:  +  

2 Highlight the group in the upper pane 

The group properties are displayed in the Details pane. 

3 Edit group properties as required. 

All channels in the group will share the same properties. 

Note: A channel within a group can still have its properties edited individually if required.  
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Filtering Channel and 
Event lists 

Applying list filters to channels or events in the Selection Explorer has two main functions: 

• To reduce the number of channels or events in view in the Selection Explorer, 
making selection easier 

• To create an inclusion or exclusion filter for events. Therefore, whenever a 
workbook is opened, the display will include (or exclude) events that pass through 
(or are blocked by) the filter, for any dataset loaded into the task. 

 

Note: The filtering process is the same for both channels and events. 

Apply a Simple filter 

In the Selection Explorer, all 
channels/events associated with 
the outing dataset loaded, are 
listed in the Available Channels 
(Events) list. 

To apply a filter, with the Explorer 
having focus type in the first letter 
of the channels you are interested 
in. Typing more characters filters 
the list more. 

To remove a filter character press 
'Backspace'. To remove the filter 
press 'Esc'. 

Note: Holding down the shift key whilst navigating the Explorer, e.g.  +  +  clears 
any filters applied to the channel selection list. Holding down the shift key when you click the 
navigation arrows has the same effect. 
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Advanced filters 

Create advanced filters by using a mixture of normal and wildcard characters. 

Wildcard characters 

* Any character or group of characters---? Single character. ----?? Two characters etc. 

To enter a wildcard character press  +  +  or  

 

Filter: TE 

Comments: 

Finds channels 
beginning 'TE' and 
channels with first 
word starting with 'T' 
and second word 
starting with 'E'. 

'TEW' would find 
Temp Engine Water. 

Results: 

Temp Brake FL 

Temp Brake FR 

Temp Brake RL 

Temp Brake RR 

Temp Clutch 

Temp Engine Oil 

TH Error 

TM Error 

Etc. 

Filter: C*E 

Comments: 

Finds channels 
beginning with 'C' and 
ending with 'E'. 

Result: 

CF Status.CLF Mode 

CL Last Event Code 

CL Override 

CL Press Line 

Corrected Distance 

CR Status.Cruise 

Etc. 

 

Filter: 

Comments: 

Finds channels of 
5 characters 
long. 

Result: 

EN RPM 

G Long 

G Vert 

Etc. 

 

Filter: Damper 

Comments: 

Finds channels that 
start with the word 
Damper, and are 
followed by two 
characters. 

Result: 

Damper FL 

Damper FM 

Damper FR 

Damper RL 

Damper RM 

Damper RR 

Etc. 
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Changing Explorer 
properties 

 

When a task, outing or channel is highlighted in the upper pane, its properties are displayed 
in the lower details pane. To change a property, double-click the property name or value and 
enter values/make selections as required. Generally properties that cannot be edited are 
grayed out. 

Note: Properties can be listed by category or alphabet. The categories can be expanded and 
collapsed in a similar manner to channel lists. To change modes, highlight a property or category 
in the Details pane and select alphabetic or categorized from the context menu. 
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Configuring the Task 
Explorer 

When you create a task it is given a default name and color. Change these as required. You 
can also enter a brief description of the task by double-clicking the Description field. 

Note: Task and outing properties can only be changed in the Task Explorer. 

Task Properties are as follows: 

Appearance 

Color: The identifying color of the task. Double-click the color panel to select another from 
the palette. 

Description: Double-click to enter a short description of the task. Press ENTER. 

Name: Double-click and enter a name for the task. Press ENTER. 

Auto Update 

Using the Auto Update command, a task can be made to ‘watch’ a directory for new outings. 
The task will automatically ‘Add’ the outing or ‘Replace’ the current outing, depending upon 
the parameters set. In this way displays can be updated with the latest data downloaded to a 
network server. 

Enabled: Click ‘Enabled’ and select Yes or No from the drop-down list to enable/disable 
Auto Update. 

Selection: Use the Selection property to specify what time region is to be displayed from the 
new/updated outing: 

Default: Displays the fastest lap from the outing. 

Entire Outing: Displays the complete dataset. 

Last Region: Display the lap leading up to the last lap marker. 

Unchanged: As outings are updated or added, the current time region selected will 
not change. 
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Source: Click ‘Source’, then click the browse button. Use the ‘Browse for Folder’ dialog to 
locate the watched directory. 

Target: Use the Target property to determine how Auto Update responds to new outings. Click 
‘Target’ and select an option from the drop-down list. 

Data selection caption: The outings added to the current task are listed here. When 
the selected outing is updated in the source directory, the task is updated. 

Add Always: Any new outing added to the source directory will be added to the task. 

Add Initial: This is the default option. The latest dataset added to the source directory 
will be added to the task. The target will then be set to that outing. 

Changing Outing 
properties 

There are a limited number of outing properties that you can edit. These may vary but 
include: Color, Driver Name, Time Offset and Track name. 

Note: When two or more outings are added to a task, all channels plotted from that task will be 
traced in the color of the outing. This does not affect the properties of the channel. 

  

Changing the Channel 
properties 

When a channel is highlighted in the upper pane, its properties are displayed in the lower 
Details pane of the Explorer. To edit a property, double-click the property name or value and 
enter values or make selections as required. Properties are listed by category in the Details 
pane. Each category can be expanded or collapsed as required, by clicking the +/- icons, 
double-clicking the category, or using the '<', '>' cursor keys. The properties can also be 
viewed as an alphabetical list by right-clicking and selecting 'Alphabetic'. 

Generally, properties that you cannot edit show their values grayed out. 
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Appearance 

Color: The channel's default (or base) color. 

Color Gradation: Enables a channel's plotted color to be graded according to the channel's 
value at that point. 

Display name: The channel name. 

Plot 

Autoscale: When Autoscale is on; the trace expands to the full extent of the axis relating to 
the channel's data to maximize the data in the plot area. 

Auxiliary-axis: Enables or disables multiple axes to be displayed on Time/Distance charts, 
histograms etc. A display will show a Y-axis for the active channel, and a Y-axis for any 
channel it has selected having this property enabled. 

Display maximum: The maximum extents of the axis relating to the channels data when 
plotted on a display. This parameter is disabled when Autoscale in on. 

Display minimum: The minimum extents of the axis relating to the channels data when 
plotted on a display. This parameter is disabled when Autoscale in on. 

Interpolation: Determines the interpolation technique applied between sample points. 
Select either 'Linear' or 'Sample and Hold'. 

Y-axis percent enabled: Enables or disables Y-axis percent of the channel. When enabled, 
the Y-axis percentage occupied by the channel and its vertical position on the scale can be 
changed. 

Y-axis percent max/min: Determines the maximum and minimum percentage of the Y-axis 
occupied by the channel. Use this to move a channel trace clear of other overlaid traces to 
aid visibility. 

Data 

Decimal Places: The number of decimal places to which channel values are displayed. 

Note: The channel values displayed in a Time/Distance Chart are limited to 10 characters 
(including decimal point). If the number of decimal places exceeds this limit, the displayed value 
is trimmed to 10 significant figures. 
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Quantity: What the channel is measuring. For example: pressure, velocity. 

Units: °C, MPH, KPH, liters, mm, bar, volts. 

Filter 

Filter: Select a filter type from the drop-down list. The default options are: No filter, band-
pass filter, gating-function filter and moving average filter. When a filter is selected the Filter 
Enabled indicator changes to Yes. Custom filters developed using the SDK will also appear 
in the drop-down list. 

Filter enabled: Indicates filter on or off state. 

Filter Properties: Double-clicking this property opens the Property dialog for the filter type 
selected. 

Note: Properties that exist but are not listed in the categories above will be listed in the 'Others' 
category. 

Navigating the 
Time/Distance display 

Pi Toolbox has been designed for operation in many different work environments, and caters 
for the various keyboard and mouse navigation techniques that people will use. Therefore, 
there is a variety of ways of finding and examining areas of interest on a display.  

Moving the cursor 

The cursor keys move the display’s time cursor forwards or backwards along the active 
channel trace. Scrolling moves the visible plot region without moving the cursor. When you 
scroll it can be thought of as a sliding window moving over a larger area. 

Zoom control 

Zooming can be performed from the keyboard or by using the mouse. Keyboard and mouse 
wheel zooming centers on the data cursor. Whereas the Ctrl + click and drag technique 
zooms on the dragged area. This may or may not include the data cursor. 
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Cursor control 

  Moves the cursor to the previous/next data sample in the active 
channel trace. 

 +   Moves the cursor quickly along the active channel trace. Each 
press moves the cursor 5% of the visible time region. 

  Moves the cursor to the beginning or end of the active channel 
trace. 

  
Moves 50% of the visible time region. 

 
Moves the cursor along the active channel trace following the 
mouse cursor. 

  

Or 

 +  

Moves the cursor to the next or previous trace making it the new 
active channel. The cursor value legends (if displayed) highlight to 
indicate which is the active channel. For further visual reference 
the Y-axis scale changes to the same color as the new active 
channel. 

Note: When the cursor is moved beyond the visible time region it is re-centered; effectively 
scrolling the visible time region to follow the cursor. 



 

 

Scrolling 

The following scrolling commands apply only when zoomed in. 

 +  
The mouse cursor becomes an open hand. With the key held 
down click and drag to scroll. 

 +   Moves the view port by 10% of its width in the arrow direction. 

 +    

Or  

 

Scrolls the view port up or down by 10% of its height. If vertical 
scrolling is not possible, the view port will scroll forwards or 
backwards by 10%. 

 
Places this marker cursor where you click. Move the 
mouse left, right, above or below the marker to auto-
scroll in that direction. 

The arrow cursor depends upon your mouse position. The scroll 
speed depends on how far you move your mouse from the 
marker. 

To cancel click middle button again. 

  

Or 

  

Auto-scrolls the view port. The initial key press starts the scroll at 
slow speed. Each subsequent press doubles the speed. Each 
key press in the opposite direction undoes the previous key 
press, until scrolling stops. 
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Zooming 

 +  
Zooms into the specified drag area. You can vary the function of 
this technique by dragging the mouse in different directions. See 
Click and Drag Zooming below. 

 +  Or  
Zoom centered on the data cursor. 

 Undo Zoom. 

 +  Undo all zooms. 

Click and drag zooming 

There are three modes of 
operation depending upon 
which way the mouse is 
dragged from the click point: 

Drag to the left to zoom the 
Y-axis only. 

Drag to the top right to 
zoom the X-axis only. 

Drag to the bottom right to 
zoom in both X and Y.  

 

 

Note: In Tiled mode only X-axis zooming is possible. X and Y axis zooming requires the display 
to be in Overlay mode. 



 

 

Linked Zooming 

Displays within a Workbook that share the same task, can have their zoom level linked 
together. With two or more displays in a task linked, zooming in on any of the displays will 
cause all linked displays to zoom to the same level, i.e. share the same X-axis time region. 
This function operates regardless of the zooming method employed. All Task Cursor 
functionality is retained while link zooming is enabled, so that cursor movements and 
scrolling is tracked by the other displays. 

When linked zooming is disabled, all displays return to their previous state and become 
unlocked. If a display was zoomed prior to becoming linked, it will return to its previous zoom 
level. 

There are two ways to apply linked zooming: 

Link All / Unlink All – Clicking Link All  or Unlink All  on the main toolbar will affect all 
displays in the task associated with the display in focus. 

Link individual displays – Clicking the toggle button   on a display’s title bar, links or 
unlinks individual displays. 

Shortcuts 

 Links all controls ihn the task associated with the display in focus. 

 +  Links the display in focus. 

 Unlinks all controls in the task associated with the display in focus. 

 +  Unlinks the display in focus. 

Note: Linked zooming only adjusts the time range of the visible data. It does not zoom on a 
channel’s axis. Therefore it will not zoom ‘into’ data on an XY display but will alter the time range 
of the data shown, as if the data selection had been altered to show that range. 
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To link individual displays in a task: 

1 On the first display click the toggle button so that the locked icon is shown:  

Keyboard shortcut:  

2 Repeat this for all displays in the task that you want to link. 

3 Zoom in on any linked display using any zoom method. 

All linked displays will zoom to the same level 

Note: When you unlink a display – the toggle button shows the unlocked icon  - it will revert to 
its previous zoom level prior to becoming linked. 

To link a display to another ‘zoomed’ display: 

1 Zoom the first display to the required level 

2 Click the toggle button so that the locked icon is shown:  

Keyboard shortcut:  

3 Move the focus to another display 

4 Click the toggle button so that the locked icon is shown:  

The display will zoom to the level of the first display. 
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Channels 

Overview 

The channels of data contained in a dataset are presented in the Available Channels list of 
the Selection Explorer. 

To commence data analysis, channels of data must be added to the display. Each display in 
the Workbook (of whatever type) must have its own channels selected. The Channels 
Available list will contain all the channels present in the outing currently loaded into the task. 

Channel data is displayed in the form of a trace on a display. 

Real channels 

Real Channels (referred to simply as 'channels') are generated in the data acquisition and 
control system and are not user generated. 

A channel is identified in the explorer like this:  

Math channels 

A greater understanding of performance can be gained by combining 'real' channel data, 
and mathematical equations and functions, to create Math channels. These can be thought 
of as user generated 'virtual' channels derived from the result of a mathematical operation. 
Math channels can be used in the same way as real channels, and the results displayed in 
charts or reports etc. 

A math channel is identified in the explorer like this: . 

Other channel icons 

Special Math:   

No data available:  
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Channel icon overlays 

Channels/Events can exist in different states depending upon their definition and their 
existence in outings. If a channel/event displays the  overlay, it is undefined. This means 
that some of the input data for the channel is missing. If a channel/event displays the  
overlay, the definition of that channel/event contains a cyclic dependency. This means that 
an error has been created in the math definition such that the data provided by the given 
channel is required in order to produce the data for that channel. (E.g. A=f(B), B=f(A).) 

Mapping common 
channels 

Some channels are required by Pi Toolbox components to generate maps, display or 
compare data against distance, and generate corrected data channels. These are 'Common 
Channels'. As teams may use different names for these channels, a system has been 
provided for identifying them to Pi Toolbox components as common channels. 

The lower 'real channel' field lists channels that equate to the 'common name' displayed 
above it. For example, with Corrected Distance selected, the lower field shows all channels 
that measure distance. 

For each common name select the required real channel. 

For more information on mapping common channels, refer to Channels - Mapping Common 
channels on page 48. 

 

GPS channels 

GPS Channels are used to generate GPS Maps and the map positioning channels: Map 
Position X, Y, Z and D. Users may use different names for GPS channels, therefore a 
system has been provided for identifying them to Pi Toolbox components as common 
channels. Use the GPS Mapping dialog to specify the correct GPS channel for each GPS 
coordinate. 
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Note: Access the GPS Mapping dialog: Tools> GPS Mapping > Edit. 

 

For each coordinate select a channel from the drop down list. 

Map Positioning Channels 

GPS channels create the map positioning channels when a GPS map is initially created or 
loaded into the Workbook. They can be identified by their icons: 

 Map Position X: Map positioning channel when a Map is currently loaded in the 
Workbook. 

 Map Position Y: Map positioning channel with no Map currently loaded in the 
Workbook. 

For each X, Y and Z point, the nearest point on the track is found and its distance is 
assigned to the Map position D channel. The D channel is used to position the cursor on the 
Map. It measures the distance into the map from the first point, enabling accurate cursor 
positioning in either direction, i.e. whichever direction the car is traveling on the map. 

The X and Y channels can be used as a channel pair in XY Charts to show the car trajectory 
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Working with Channels 

To add a channel to a display: 

1 Make sure that the display you want to add a channel to has focus. 

2 In the Explorer select the Channels tab. 

3 Click on the 'Filter' bar and type the first few letters of the channel you want to 
add. 

This reduces the channels in view to those starting with the letters you type. 

4 From the Matching Channels list double-click on the channel to Add 
(alternatively right click on the channel and choose select from the pop-up menu) 

The channel will appear in the lower pane under 'Selected Channels" and the data will be 
loaded into the display in focus. 

To add a group of channels to a display: 

1 Make sure that the display you want to add the group to has focus 

2 In the Explorer select the Channels tab. 

3 Right click on the group you want to add and choose select from the pop-up 
menu. 

The group will appear in the lower pane of the Explorer and the channel data will be loaded 
into the display in focus. 

To remove a channel or group from a display: 

1 Make sure that the display you want to remove the group or channel from has 
focus 

2 In the lower pane right click on the group or channel you want to remove 

3 Select Remove. 

The data from the channel or group of channels is removed from the display. 

 



 

 

Math Channels and Soft Events 

Introduction 

Pi Math allows users to perform complex data analysis. Generally a math channel takes one 
or more input channels and produces an output channel. Input channels can be real 
channels or other math channels. 

The operators and functions that are available to math channels are also available to soft 
events. Soft Events are simply math channels with a Boolean value. For a given sample 
point, if the event occurs, it is On/True. If the event does not occur it is Off/False. For 
Example: [Speed]>80. 

What is a Math Channel? 

A greater understanding of performance can be gained by combining ‘real’ channel data, 
mathematical equations and functions to create a Math channel. These can be thought of as 
user generated ‘virtual’ channels derived from the result of a mathematical operation. Math 
channels can be used in the same way as real channels. The results can be displayed in the 
Time and Distance displays, Histograms, Reports etc. 

A Math channel is identified in the explorer like this:  Math Channel name 

What is a Soft Event? 

Engineers need to create their own events based on set conditions within channel data, for 
this purpose soft events are provided. Unlike hard events, which are part of the outing data, 
soft events are always calculated at run time. For example, on a circuit test to investigate the 
efficiency of the gearbox oil pickup, when the car is accelerating, braking, stationary and not 
cornering conditions need to be excluded. Setting event parameters to exclude lateral 
acceleration data greater that 0.5g or less than –0.5g and the RPM data greater than 
10,000rpm, would be carried out in the Soft Events Management dialog. 

A soft event is identified in the explorer like this: Soft Event Name. 

See Also: Soft Events, page 217. 
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Math channels give Pi Toolbox users the ability to perform complex data analysis. Generally 
a math channel takes one or more input channels and produces an output channel. Input 
channels can be real channels or other math channels. Therefore a simple math channel is 
in the form of: 

Math Channel = ƒ (Input1, Input2,)  

Calculating the aerodynamic downforce that the car is subjected to is a typical math 
channel: 

TotalAero = AeroF + AeroR 

Where: 

AeroF = FL Pushrod Load + FR Pushrod Load 

AeroR = RL Pushrod Load + RR Pushrod Load 

TotalAero is a math channel whose inputs, AeroF and AeroR are also math channels. 
These, however, are derived from the input data (real) channels: FL Pushrod Load, FR 
Pushrod Load, and RL Pushrod Load. 

Math Channel editing 

Editing is carried out in the Pi Math Management dialog, which is accessed from the Tools 
menu: Tools > Pi Math > Edit… 

Global definitions 

All Math channels defined are stored in the Workbook and are listed in the Pi Math 
Management dialog. They can be exported and imported for use in other Workbooks. 
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Math Channel Equation 
components 

Equation components 

Math channels and Soft Event equations can contain a single component or multiple 
components, from those listed below. 

Channels: Generally a math channel takes one or more input channels and produces an 
output channel. 

Math Channels: An input channel can also be a math channel. 

Soft Events: User generated events (created locally on the users PC) referred to as Soft 
Events. 

Constants: A constant is a named time-invariant value, used in math channel equations. 
Constants can be Simple, Excel or Literal.  

Registers: See page 209. 



 

 

 191 

 

Properties 

When a math channel is defined it is given a set of default properties that determine how the 
channel trace appears in Displays. These properties can be viewed and edited in the 
extended section of the Pi Math Management dialog, accessed by clicking ‘<< More’. 

Like real channels, math channel properties are displayed in the Properties Explorer when 
the channel is selected. If not grayed out, they can be edited in the explorer as well as the 
management dialog. 

The following properties can be defined for math channels: 

Autoscale: Enables/disables Autoscale. When Autoscale is on the trace expands to the full 
extent of the axis relating to the channel’s data, to maximize the data in the plot area. 

Min / Max: defines the minimum or maximum extents of the axis relating to the channels 
data when plotted on a display. This parameter is disabled when Autoscale in on. 

DPS: defines the number of decimal places that channel values are displayed in. 

Color: The channel's default (or base) color. 

Note: To ensure math channel uniqueness can be maintained, the math channel name cannot 
be edited in the Properties Explorer 
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Built in functions 

Equation strings for math channels and soft events are created in the Equation field of the 
Management dialogs. Select: Tools > Pi Math > Edit or Tools > Soft Events > Edit. 

Building equations is facilitated by built-in mathematical functions and operators. Selection is 
made from a drop-down list, accessed by pressing  +  in the equation field. 

To select, use the up/down arrow keys to highlight the required operator and press Enter. 
The Channel or Operator is inserted in the equations at the cursor location. 

The list can be filtered if required. The backspace key will delete filter characters. 

The content of the drop-down list depends upon the context of the equation when accessed: 

After '[' or between '[' and ']' a list of 
available channels is displayed. 

When highlighted, or with the cursor held 
over, a tool tip displays the name and 
quantity of the channel. 

 

 

 Between two sub-expressions a list of 
operators is displayed. 

Note: Enter a space after the ']' character, 

before pressing  + , to access the 
list of operators.  

When highlighted, or with the cursor held 
over, a tool tip shows the syntax and 
description of the operator. 

 

 



 

 

Calculation rate 

Math channels consist of one or more input channels that are often acquired at different 
frequencies. 

The user determines the Calculation or Sampling Rate of a math channel, and can either be 
the same rate as one of the constituent channels or user defined. 

Same rate as Constituent Channel 

In the Pi Math Management dialog, the user selects from a drop-down list of constituent 
channels, which channel will set the calculation rate. If the selected channel rate is higher 
than the lowest of the constituent channels, Linear Interpolation is employed. 

For example, in the math channel:  FL Aero = ƒ (FL Pushrod Load, FL Displacement) the FL 
Pushrod Load is acquired at 25 Hz and FL Displacement at 50 Hz, and the user sets the 
rate to be that of the highest channel - the calculation rate is as shown below: 

 

User Defined Rate 

The user can assign a frequency for the calculation. 
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Math Channel 
definitions 

To define a math channel, the following parameters should be specified: 

Name 

Each math channel must have a unique name.  

CAUTION: Math channel names are case sensitive. Make sure that you do not create a math 
channel that has the same name as an existing one, but different capitalization. 

Equation 

The equation string represents a mathematical formula for calculating samples of a math 
channel, and should be in the form of the following example: 
[ChannelName] +CONST(ConstantName)/ƒ ([ChannelName], [ChannelName]) – 3 

A description is optional but can aid in quickly identifying the purpose of the channel, for 
example: Tire slip angle calculation uses Pace jka '96 coefficients'. 

Insert the description between the characters: /*Description Here*/, or after the characters: 
//Description Here. 

Quantities and Units 

Math channel units default to user-defined units. These are entered directly in the Units field 
of the Pi Math Management dialog. 

A math channel's quantity can be changed to a pre-defined quantity in the extended section 
of the dialog. When the quantity is defined, the user can then define the units. 

Calculation rate 

The calculation rate defines the data rate (sampling rate) of the math channel. 

 



 

 

Math Channel 
management 

The Pi Math Management dialog is for the creation and management of math channels. All 
the math channels you define or import can be accessed and edited here. 

To open the dialog, select: Tools > Pi Math > Edit. 

 

 195 

 



 

 

Channel Name List 

This is a list of all existing math channels. When a math channel is highlighted in the list, its 
details are displayed in the panels on the right.  

 Inserts a default name for a new math channel in the math channel list. 

 Deletes the math channel currently highlighted in the math channel list. 

Note: You can select single or multiple channels in this list using ‘Shift + Click’ or ‘Ctrl + Click’. 
Alternatively select all channels by pressing ‘Ctrl + A’. With multiple selections, filtering will 
deselect non-matching records, whilst the matching records remain selected. 

 

CAUTION: A math channel may be a sub-expression of another math channel equation, i.e. the 
math channel is dependent on another. Deleting the first channel would cause the dependent 
channel to become globally non-valid. 

Name 

Displays the name of the math channel highlighted in the channel list. The name can be 
edited in this field. 

Unit 

Math channel units default to user-defined units. These are entered directly in the Unit field 
of the Pi Math Management dialog. 

A math channel's quantity can be changed to a pre-defined quantity in the extended section 
of the dialog. When the quantity is defined, the user can then define the unit. 
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Data rate 

Math channels consist of one or more input channels that are usually acquired at different 
frequencies. 

The user determines the Calculation or Sampling Rate of a math channel, which can either 
be the same rate as one of the constituent channels, or user defined. 

Same as of Channel: Allows you to select from a drop-down list, which contains the 
constituent channels of the equation. The calculation rate of the math channel will be the 
same as the data rate of the channel selected here. 

Fixed: Allows you to define a data rate from a range of fixed frequencies from 1 to 1000 Hz. 
This option can be used when a math channel has no constituent real channels. 

Equation 

This field is for entering the math channel equation string - a mathematical formula for 
calculating samples of a math channel. To make creating equations easy, you can access 
drop-down lists of channels and operators, at any point in the equation string, by pressing 

 + . Selecting an element from the list inserts it at the cursor location. 

The syntax is color highlighted as follows: Red = error, Green = comment, blue = keyword. 

If required, a description may be added to aid identification. Insert the description between 
the characters: /*Description Here*/, or after the characters: //Description Here. 

Note: The status bar beneath the equation field displays ‘Definition evaluates successfully’ or 
‘Invalid Definition’ as you build the equation, to indicate the accuracy of the equation syntax. 

<< More 

Expands the dialog to show the input channels list, i.e. a list of all real channels referenced 
in the math channel equation. Here you can change the quantities and units of individual 
channels. Simply double-click a quantity or unit, and select from a drop-down a list of 
options appropriate to the channel. 

Note: The Default Properties panel is used to define math channel properties. The properties 
displayed are those of the channel selected in the Channel Name list. These properties appear in 
the Properties Explorer and determine the appearance of the math channel trace.  
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About Intellitype 

The Management dialogs 'Intellitype' system enables faster editing by allowing the user to 
concentrate on the equation rather than its syntax. 

As you type in the Equation field, Intellitype functionality auto-completes as you type, auto-
corrects case and colorizes different components. 

Colorization 

The equation is automatically colorized as it is built. Different colors are used for comments, 
functions, channels, constants, operators and errors. 

Auto-case correction 

As a function is typed into the equation, Intellitype automatically changes case to the correct 
one (if required). For example: If the user enters 'COMPAREDIST or comparedist, Intellitype 
automatically corrects the case to 'compareDIST'. 

Auto-completion 

Auto-completion attempts to complete the word being entered into the equation, depending 
on the context of the equation at that point. For example: 'com..' would be completed to 
'compare'. 'compared' would be completed to 'compareDIST', (auto completion and auto-
case correction). 

To accept the word suggested in the equation field, press . 

198 Pi Toolbox User Guide 

 



 

 

 199 

 

Syntax 

Precedence in Math channels 

Certain mathematical operators have a higher precedence than others. This affects how 
math channels are calculated; for example 2*5-3 gives 7 but 2-3*5 gives -13. 

Multiplication and division have a higher precedence than all other Standard functions. 
Addition (+), Subtraction (-), less than (<), less than or equal to (<=), greater than (>), 
greater than or equal to (>=), have equal precedence.  

Syntax 

Math channel equations should be written in the form: 
[ChannelName] +CONST(ConstantName)/ƒ([ChannelName], [ChannelName]) - 3 

Input channels 

Input Channels are referenced using the following syntax: [Channel Name] 

When an input channel is referenced in the equation, an attempt is made to match this to an 
existing channel of that name. This is used to determine the current units defined for that 
channel in Pi Toolbox. 

Note: If a channel is entered in the expression, which is not in the channel database, its quantity 
must be specified in the 'Advanced' section of the Pi Math Management dialog, otherwise 
defaults will be used. 



 

 

Operands 

The following objects may be used as operands in the equation: 

• Channels. 

• Global math constants (name). 

• Outing constants (name). 

• Real number constants (value). 

Constants 

Constants are referenced using the following syntax: CONST (Constant name) 

 GLOBALCONST (Constant name) 

 OUTINGCONST (Constant name) 

 

Error checking 

The Status bar beneath the equation field displays ‘Definition evaluates successfully’ or 
‘invalid Definition‘ as you build the equation, to indicate the accuracy of the equation syntax.  

An invalid definition is also indicated by the math channel icon, which changes from  for a 
valid definition to  for an invalid definition. 
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Example Math channels 

Note: The following math channels are examples and should be treated as such. Their 
appropriateness for a specific purpose in your Workbook is not guaranteed. 

 

Name Air box Efficiency 

Syntax 
2 * ([Air box pressure] - [static pressure])/(GLOBALCONST(Air Density) * 
pow([Speed],2) 

Channels Air box Pressure, Static Pressure, Speed 

Definition 
Air box efficiency is the ratio of the pressure in the air box to the maximum 
available pressure. The maximum available pressure is the pressure of a free 
stream flow due to the speed of the car. 

 

Name Gear Ratio 

Syntax ([RPM] * OUTINGCONST(Wheel Diameter) * GLOBALCONST(pi))/[Speed] 

Channels RPM and Speed 

Definition 
Gear ratio is the number of turns of the engine to each turn of the driven 
wheels. 
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Importing and Exporting 
Math channels 

Exporting Math channels 

Math channels can be exported from the Workbook as a file. This enables teams to build up 
libraries of standard math functions that can then be E-mailed to the relevant engineers for 
importing into their Workbooks. 

Importing Math channels 

When importing a math channel you are warned if there are duplications of channels and/or 
constants, and given the choice of overwriting or rejecting duplicates.  

When you open a global math definition file in the wizard you can import all channels 
contained in the file or select specific channels. Check the channels you want to import 
when prompted. 



 

 

Lookup tables 

Lookup tables are contained in external excel files. Tables can be included in math channel 
and soft event equations by mapping to the external table with a definition string. 

There are two table types: 1 input parameter (1D) and two input parameters (2D). 

1D table example 

 

The function's input channel is a damper channel where suspension travel values vary 
between 10 and 30. The user has devised a math function that requires spring rate to be 
used as part of the calculation. This can be derived by looking up in the table the value for 
the spring rate as a function of wheel travel. 

Data is linearly interpolated between values. 
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2D table example 

 

The functions input channels are Front Ride Height and Rear Ride Height. The values for 
both input channels vary between 10.0 and 50.0 mm in steps of 10.0 mm. The user has 
derived an aerodynamic function that requires the coefficient of drag to be used as part of 
the calculation. This can be found by looking up in the table the value for coefficient given 
the inputs of front and rear ride height. 

Data is linearly interpolated between values. 

Table Definition Strings and Hyperlinks 

A string is used in the math channel equation to uniquely define a lookup table. Strings are 
in the form of: name\filename\sheet!cellfrom:cellto. For more formation, refer too Look up 
table Syntax. 

Definition strings can be entered manually into the equation or pasted from the clipboard. 

When the string is entered in the Equation field of the Pi Math Channels Management dialog 
it becomes a hypertext link. Clicking the hyperlink opens the table in Excel and highlights the 
specified cells. Right-clicking the same hyperlink offers the following context options: 

Verify Table Definition: Verifies the table defined in the hyperlink clicked on. 

Verify All Table Definitions: Verifies all tables definitions in the equation. 

The verification process attempts to locate the specified file, sheet and cells and verifies for 
errors. If errors are detected during this process, they are reported in the equation status 
bar. 
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Lookup table Syntax 

Both 1D and 2D tables are defined in the math channel/soft event equation using the 
following syntax: 

table #name = path\filename\sheet\!cellfrom:cellto; 

Where: 

Table: Keyword is used for defining lookup tables 

Name: Is the lookup tables name. It must always start with a '#' symbol. 

Path: Is the driver plus directory path of the Excel file. Relative network paths can also be 
used. See the examples below. 

Sheet: Is the Excel sheet name. 

Cellfrom: The lookup table's top/top left value cell. 

Cellto: The lookup table's bottom/bottom left value cell. 

Cellto and Cellfrom arguments can be specified using the Excel Cell syntax, e.g. cell A3 
would be $A$3. 
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Examples 

table #local = C:\Lookup Tables\My Tables.xls\Sheet1!B4:B8 

table #srv = \\server\c\Lookup Tables\Server Tables.xls\Sheet1!B4:B8 

Usage 

Lookup Tables can be used in channel/event definitions with the following syntax: 

#name (exp[,mode]) 

#name (exp1, exp2[, mode]) 

Where: 

Name: Is the name of the table. 

Exp: Is the input argument used in 1D lookup tables 

exp1 and exp2 - are input arguments used in 2D lookup tables. exp1 specifies the 
IndexColumn and exp2 the IndexRow. 

Mode: Is optional parameter. It specifies modes of interpolation/extrapolation. If not 
specified explicitly, the 'Snap' value will be assumed. It can have one of the following values 

Interpolation: Interpolation is performed 

Extrapolation: Extrapolation is performed. 

Both: Interpolation and extrapolation is performed. 

Snap (default value): neither interpolation or extrapolation is performed - the nearest value 
is returned. 

Hold: As Snap mode but will snap the value always to the previous one.  



 

 

Lookup table errors 

If errors are detected in the validation process they will be reported in the equation status 
bar of the Pi Math Management dialog. 

• A valid lookup table must have the following properties: 

• Numbers in the IndexColumn and IndexRow sorted in ascending order 

• No duplication of numbers in the value cells 

• 2D tables - no empty cells in the selected range of cells except the upper left 
cell. 

• 1D tables - value cells must not be empty. 

Cell Range Validation 
• 2D tables must contain at least 3 x 3 cells. 

• 1D lookup tables must have at least 2 value cells 

Error Handling 

If the validation for any lookup table in an equation fails, the math channel/soft event will be 

marked as undefined  and will return no samples (discontinuity) for the entire outing time 
range.  
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Using Math channels 

To define a math channel: 

1 Open the Pi Math Management dialog - Tools > Pi Math  > Edit 

2 Click   

A default name for a new math channel appears in the math channel list. If required, 
edit the default in the name field. 

3 Enter units in the Unit field if required. 

Note: A math channel's quantity and units can be changed to pre-defined values in the 
Advanced section of the dialog. See below 

4 Enter a brief description of the purpose of the channel (optional). 

5 Build the math channel equation. 

Note: Pressing  +  at any point in the equation string, opens a drop-down list of 
channels or operators for you to select from. The list is 'Channels' if the cursor is after or between 
these characters '[' ']', or 'Operators' if you are between sub-expressions, or ‘Constants’ if after 
CONST(, etc. 

6 Select a data rate. 

If you want to select a quantity or unit, other than the default, for any of the constituent 
channels, do the following: 

7 Click   

A list of all input channels referenced in the math channel is displayed. 

8 Double-click a quantity for a particular channel and select from the drop-down 
list. Repeat for the units. 

9 Click OK. 

The math channel is added to the database and will appear in the Selections Explorer. 

Note: Math channels are listed with the real channels. Identified by their icon:  
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To delete a math channel: 

1 Open the Pi Math Management dialog. 

2 In the Channel list highlight the channel or channels to delete. 

3 Click    

Note: Another math channel may be dependent upon the one you are attempting to delete, i.e. 
the one being deleted may be a sub-expression of another math channel equation, so deleting it 
would cause the dependent channel to become globally non-valid. 

4 Click Yes to delete the channel. 

Registers 

Registers are used for storing discrete variables (real numbers). The value of a register after 
the current sample is evaluated, is propagated as a value for the next sample evaluation. 

Registers are calculated for each sample of the math channel. Typical uses of registers are 
to: 

• Simplify equations by providing means for defining local variables. For example: 

AveSpeedFront = ([SpeedFL] + [SpeedFR]) / 2 

AveSpeedRear = ([SpeedRL] + [SpeedRR]) / 2 

(AveSpeedFront + AveSpeedRear) / 2 

• Make recurrent definitions by persisting registers sample-by-sample. For 
example: 

Summ = Summ + [Speed] 

Will set Summ equal to the value of Summ in the previous sample plus the value of the 
Speed channel in the current sample. 
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Declaration 

Before a register can be used it must be declared: register @R; 

Register names are case sensitive and must start with the ‘@’ character. 

As part of the declaration the user can specify an initial value for the register:  

Register @R=1; 

When not specified, initial value defaults to zero. 

Note: Register declarations must precede all other statements in an equation. 

Initial value 

A register takes its initial value only for the first sample of the math channel (which is 
equivalent to initialization of static variables in C++) 

Assignment 

Once a register is declared, its values can be changed with an assignment operator: 
<register> = <expression>; 

For example: @R = @R + 1; 

Registers in expressions 

The value of registers can be used in any expression by simply specifying the register name: 

Sin( @R); 

@R3 = log (@R1+@r2); 

Limitations 

Registers cannot be used as arguments of multi-sample functions because these functions 
need to evaluate their arguments forward in time, which can cause cyclic dependencies 
between them and their arguments. For example: 

@a =@a+1; 

@a = maximum (@a); 

mailto:register@R;
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Values of Registers 

The following rules apply to the values of registers: 

• All registers are of the type: double. 

• Before the first sample of math channel is evaluated, registers have their initial 
values (as set in their declarations). 

• Registers can change their value between consecutive statements of channel 
definition (using assignment operators). 

• The value of registers after sample is evaluated (all statements of channel 
definition are evaluated) they are propagated as initial values of the registers for 
the next sample. 

• A register can have a #NAN for a value. 

Data Discontinuity Handling 

Registers are calculated for each sample point of the math channel. 

Note: The math channel will not have a sample at a given time stamp if any of its inputs is 
discontinuous with the time stamp. 

This implies that the registers will never be calculated over a discontinuity. 

Register Syntax 

There are three types of statement (in the order in which they appear): Declaration, 
Assignment and Final Expression: 

[[[<declaration>;]…][[<Assignment>;]…]][<final expression>;] 

The syntax requires the following rules: 

• Register declarations must precede any other statements. 

• Register assignments can occur anywhere after the declaration. 
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• The value of the math channel’s sample is the value of the last statement in the 
expression. Depending on the statement the math channel ends with its sample 
value as follows: 

Declaration – The initialization value, explicit or implicit. 

Register assignment – The value assigned to the register. 

Final Expression – The value of the expression. 

Note: Placing any expression (that is not a register assignment or declaration) before the last 
statement is irrelevant, as its value will not affect the channels value. 

Declaration 

Declarations are the first statements in the equation and are used to define the register in 
the equation and set its initial value. 

Syntax: register name [= expression]; 

Where register is the key word, name is the name of the register, and expression (optional) 
is an arbitrary expression, which is evaluated and is set as the initial value of the register. 

Assignments 

Assignments are used to set values for registers. 

Syntax: name=expression; 

Where name is the name of the register, and expression is an arbitrary expression, which is 
evaluated and is set as a new value of the register. 

Final Expressions 

Final expression is the last statement in definitions. 

Syntax: expression; 



 

 

Events 

Overview 

Events are points of interest that occur at a specific instant in time. They give the user a 
rapid method of searching data for points of interest, and are invaluable for system fault 
finding. 

Events markers appear on Time and Distance 
displays as triangles. Holding the cursor over an 
event marker will display the Name and Time of 
the event. You can 'Pin' event information by 
clicking the marker. A pinned marker will be 
displayed in Print Preview and will appear on a 
printed output of the display. To unpin the event 
click on the display again. 

Note: You can easily move between consecutive events on a trace by using the   keys. 

Events that are generated in the data acquisition and control system are referred to as Hard 
Events. In addition to Hard Events, Pi Toolbox facilitates user-generated events (created 
locally on the PC) referred to as Soft Events. 
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Filtering Events 

Inclusion and Exclusion filters 

Events can be selected for displays in the same way as channels are selected. These are 
individual events (unfiltered) and are saved with the Workbook. 

Alternatively, the user may want to create an event filter for a display so that whenever the 
workbook is opened the display will include events that pass through the filter, and those 
events will appear for any dataset loaded into the task. For example, the user may want the 
display to show all events with 'Oil' in the title. By constructing the filter the display will show 
any 'Oil' event and also include any new 'Oil' events. 

The user also has the facility to exclude events that have passed through the filter. For 
example, the engineer may be interested only in oil pressure events. While the 'Oil' event 
filter lets all events through that have 'Oil' in the title, the filter can be constructed to block 
any 'Oil' event that has the word 'Temp' in it. 

Event naming schemes are obviously determined by the user. 

Note: The filtering method is the same for both channels and events. See Filtering Channels and 
Events, page 172. 



 

 

Filter 

To create a filter that will find events starting with the 
word 'Oil' in the title, enter 'OIL'. The upper pane shows 
the 'Matching Events'. To include these events right click 
and select 'Inclusion', or press . 

The lower pane will list the filter events indicated by the 
event icon . 

The 'Include' filter will be indicated by the  icon. 

Note: You can create as many Include filters as you require. 

 

 

 

 

To modify the filter to exclude certain events (in this 
example 'Oil' events with the letter 'T' in the title). 
Highlight the upper pane and enter 'OILT' (clear the filter 
first or just add a ‘T’). The upper pane shows the 
'Matching Events'. To exclude these events right click and 
select 'Exclusion', or press  + . 

The lower pane will now show a modified list of events. 
The Exclude modifiers are indicated by the  icon. 

 

Note: To delete a filter press  + . 
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Working with Events 

To add an Event to a Time and Distance display: 

1 Make sure the Time and Distance display you want to add the event to has focus 

2 Go to the Selections Explorer 

3 Click the Events tab 

4 From the list of Available Events, double-click the event – or press  - to add 

to the display. 

The event is added to the individual events list in the lower pane of the Explorer and will 
appear on the Time and Distance display (if the event conditions have been met within the 
data selection region on the display). 

Note: You can set up filters specific to the current display so that certain events are run every 
time the display is opened.  
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Soft Events 

Engineers need to create their own events based on set conditions within channel data, for 
this purpose, soft events are provided. Unlike hard events, which are part of the outing data, 
Soft events are always calculated at run time. For example, on a circuit test to investigate 
the efficiency of the gearbox oil pick-up, when the car is accelerating or braking, stationary 
and not cornering conditions need to be excluded. Setting event parameters to exclude 
lateral acceleration data greater than 0.5g or less than -0.5g and the RPM data greater than 
10,000RPM would be carried out in the Soft Events Management dialog. 

Importing and Exporting 

You can export groups of soft event definitions as single external PXE (event definition) files. 
These files can then be imported into other Workbooks, where the imported events can be 
selected in the Soft Events Management dialog. 

 This icon identifies soft events. 

Event priorities 

Event priorities allow events to be categorized based on their severity, importance or source. 
The Event display can then be configured to plot events by priority. 

Priorities are set up in the Priorities tab of the Options dialog. Background and foreground 
colors can be set to aid recognition in the Event display. There a four default priorities, 
Debug, System, Status, Error. Priority properties (name, colors etc.) can be changed if 
required and further priorities can be added up to a total of eight. 

Priority ID’s 

Priorities are created using IDs which correspond to Event IDs. Events are placed in priority 
categories accordingly. If an event is assigned an ID that does not exist in the priorities 
defined for the workbook, it is placed into the 'other' category. This is unique in that it cannot 
be deleted and it does not have an ID. 
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Creating and Editing 

Soft events are created, edited and managed in the Soft Events Management dialog. 

To open the dialog select: Tools > Soft Events > Edit. 

Soft Events are defined by a math equation. The equation string represents a mathematical 
formula for defining event conditions. 

Events 

This is a list of all events created or imported. When an event is highlighted in the list, its 
properties are displayed in the panels on the right. Soft events can have the same name as 
a hard event. Where this occurs the soft event will take precedence. 

Note: A 'Broken Event' in the list indicates that a constituent channel of the soft event equation is 
missing, or the equation is incomplete. The Soft Event becomes invalid and cannot be used. 

 

 Creates a new soft event 
with a default name. 

 Deletes the soft event 
currently highlighted in the soft 
event list. 

Name 

Displays the name of the soft 
event highlighted in the event 
list. The name can be edited in 
this field. 
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You can select single or multiple channels in this list using ‘Shift + Click’ or ‘Ctrl + Click’. 
Alternatively select all channels by pressing ‘Ctrl + A’. With multiple selections, filtering will 
deselect non-matching records, whilst the matching records remain selected. 

Data Rate 

Soft events consist of one or more input channels that are usually acquired at different 
frequencies. 

The user determines the Calculation or Sampling Rate of a soft event, which can either be 
the same rate as one of the constituent channels, or user defined.  

Same as of Channel - Allows you to select from a drop-down list, which lists the constituent 
channels of the event. The calculation rate will be the same as the data rate of the channel 
selected here. 

Fixed - Allows you to define a data rate from a range of fixed frequencies from 1 to 1000 Hz. 

Equation 

This field is for building the soft event equation string. To make creating equations easy, you 
can access drop-down lists of channels and operators, at any point in the equation string, by 
pressing  + . Selecting an element from the list inserts it at the cursor location. This 
method is the same when creating math channels; see Built in Functions and Operators, 
page 192. The status bar beneath the equation field displays ‘Definition evaluates 
successfully’ or ‘Invalid Definition’ as you build the equation, to indicate the accuracy of the 
equation syntax. 

If required, may be added to aid identification. Insert the description between the characters 
/*Description Here*/ 

Note: All channels that occur in the soft event equation (input channels) are listed in the 
'Advanced' section of the dialog. 

<< More / >> Less 

Expands the dialog to extend dialog options.  
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Extended options 

The Extended section of the Soft Events Management dialog is hidden until the <<More 
button is pressed. Here you can define further soft event options: 

Event offset 

This field is used to define an event Offset. An Offset specifies that the actual event will 
occur at a time (given by the offset) after the conditions were satisfied. The Offset can be a 
negative value. 

Message content  

The Message Content panel is used to define what data appears in the soft event 'Flag'. 
Check the elements of the message that you want to appear. 

Channel name, quantity, units  

The input channels list is a list of all channels referenced in the soft event equation. Here 
you can change the quantities and units of individual channels. Simply double-click a 
quantity or unit, and select from a drop-down a list of options appropriate to the channel. 



 

 

Working with Soft 
Events 

To create a soft event: 

1 Open the Soft Events Management dialog 

2 Click   

An empty default event definition is created and should now be named. 

3 In the Name field overtype the default name if required. The soft event name 
must be unique to the Workbook. However a soft event can have the same 
name as a hard event. Where this occurs the soft event will take precedence. 

4 In the Equation window enter a brief description of the soft event (optional). 

5 Build the soft event equation.  

Note: Pressing  +  at any point in the equation string, opens a drop-down list of 
channels or operators for you to select from. The list is 'Channels' if the cursor is after or between 
these characters '[' ']', or 'Operators' if you are between sub-expressions. 

6 Select a data rate. 

7 If you want to select a quantity or unit, other than the default, for any of the 
constituent channels, do the following: 

8 Click   

A list of all input channels referenced in the soft event is displayed. 

9 Double-click a quantity for a particular channel and select from the drop-down 
list. Repeat for the units. 

10 Click OK. 
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Building Equations 

Soft events are defined by a math equation. Every time the equation results in a non-zero, 
an event is generated. 

For Example: 

• [Speed]>80 

• fabs([Speed FL] - [Speed FR])<10 

Note: The operators and functions are available to both math channels and soft events. 

Special functions 

In addition to math operators, soft events definitions can include special functions. These 
are accessed by opening the drop-down list of operators -  +  - and scrolling to the 
bottom of the list. The last four operators are as follows: 

Minimum (channel)/Maximum (channel) 

An event is created when the expression reaches its maximum or minimum value within the 
current data selection. For example: 

• maximum([Speed]) 

• minimum(fabs([Speed FL] - [Speed FR])) 

Edge(channel, difference, time) 

This function has three parameters – expression, constant and dt. Returns 1 if the 
magnitude of the difference ‘c’ and its value ‘t’ seconds before is greater that ‘d’, else returns 
0. Expression is evaluated in two consecutive samples (at times (t-1) and (t) - based on the 
sample rate) and depending on the sign of the constant function returns: 

• If const > 0 function returns 1 when (expr(t) – expr(t-dt)) > const 

• If const < 0 function returns 1 when (expr(t) - expr(t-dt)) < const 

This way the function combines Rising Edge, Falling Edge and Edge functionality. 
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Note: The result of the function is highly dependant on the sample rate. For example 
Edge([Speed], 20] will return different results on sampling rate 10Hz and 200Hz. Higher rates 
effectively decrease the difference between two consecutive samples 

Cond (expr, pre-guard, post-guard, assume) 

This function has four arguments: 

• expr: expression 

• pre-guard: pre-guard time - non-negative numerical constant (in seconds) 

• post-guard: post-guard time - non-negative numerical constant (in seconds) 

• assume: numerical constant 

and returns non-zero (at time t) if the following conditions are met: 

• expr is non-zero at t 

• expr is zero in the time interval [t - pre-guard, t) 

• expr is non-zero in the time interval (t, t + post-guard] 

In all other cases function returns zero. 

Every time when expr has no value (out of data range or data discontinuity) the value of the 
assume parameter is used instead of expr. 

The pre-guard time is designed to filter-out events that will be otherwise generated in a 
series of data points that satisfy the standard event conditions and to leave just the first 
event since which the event conditions are met. 

The post-guard time is designed to filter for events that mark a start of a long data sequence 
in which the alarm conditions are satisfied. 

It implies: Generate only the events where the conditions are met by all data points within 
the period of post-guard time seconds following the event data point. 

The pre/post-guard validation is performed on all data points (depending on the type of 
sampling rate) that fall in the range of pre/post-guard time.  

Note: If there are no sample points within pre/post-guard time it is considered that the pre/post-
guard condition is met. 



 

 

Example of cond function 

The following soft event is intended to detect when oil pressure drops to less than 4.5bar, for 
5 s (post guard time) given that it was greater than 4.5 bar for the previous 2 s (pre guard 
time). 

The Soft Events Management dialog 

The equation below: 

<expression> = [OilP] >4.5 

<pre-guard-time> = 2 (in seconds) 

<post-guard-time> = 2 (in seconds) 

<assume> = 0 so that the event will not trigger if <expression> is out of range. 
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Results 

The results are shown in following Time/Distance Charts. 
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If the soft event definition is changed so that the post guard time is 5s, then the event does 
not trigger because the OilP channel recovers to >4.5bar before the post-guard-time period 
has expired. 

<expression> = [OilP] >4.5 

<pre-guard-time> = 2 (in seconds) 

<post-guard-time> = 5 (in seconds) 

<assume> = 0 so that the event will not trigger if <expression> is out of range. 

cond([OilP]<4.5,2,5,0) 

Result 
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Units and Arguments 

Functions requiring specific units 

Only trigonometric functions have specific requirements for the units of their arguments. 
These are: 

• Sin () – radians 

• Cos () – radians 

• Tan () – radians 

Functions requiring channel arguments 

The arguments of all functions can be arbitrary expressions, with the following exceptions: 

• Compare () 

• CompareDist () 

• TimeDiff () 

These functions only accept channels as their arguments. 
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Registers not accepted in arguments 

Some multi-sample functions do not accept registers as part of the argument. These are 
functions that read their argument forward in time. For example, ‘derivative ()’ reads three 
samples of the input argument, the current input argument, the previous input argument and 
the next input argument.  

This could result in cyclic dependencies between multi-sample functions and the register. 
For example: Reg= derivative(reg) 

The functions in this category are: 

• Gate() 

• MoveAverage() 

• BandPass() 

• Derivative() 

• Slope() 

• Integral() 

• Minimum() 

• Maximum() 

• Edge() 

• Cond() 

Time as an indirect argument 

All functions having time as an indirect argument assume that time is in seconds. For 
example: integral(), which multiplies the difference between two consecutive values of the 
argument by the time difference between them, takes the time difference in seconds. 

The functions in this category are: 

• Integral() 

• Derivative() 

• Slope() 



 

 

Pre-Guard and Post-
Guard times 

Pre-Guard Time 

This prevents numerous events from generating, where a series of data points satisfy the 
standard event conditions. The first event where conditions are met is retained. 

Example: An event is set up to flag oil pressure failures, where typically the pressure falls 
below a certain level and stays low for some time. All data points for the time of the failure 
will create an event. Setting a Pre-Guard time of say 0.5 seconds only allows an event to be 
generated if oil pressure was in its normal range for the preceding 0.5 seconds. 

Post-Guard time 

The Post-Guard time is designed to filter events that mark the start of a long data sequence 
in which the event Conditions are satisfied. This will prevent events being triggered by 
channel noise. 

Example: Looking for a drop in engine revs for a sustained period.  

Event Offset 

An Offset specifies that the actual event will occur at a time (given by the offset) after the 
conditions were satisfied. The Offset can be a negative value. 

 

Note: When you click OK, the event is saved with the current Workbook and will be available for 
use in any outing that you load. Soft events are listed alphabetically with hard events. They are 
identified by their icon:  
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Constants 

Introduction 

A constant is a named, time-invariant value that has a global or outing context. 

Constants can be used in math channels; for example, if several math channels use a spring 
rate value, that value can be represented by a constant created in Pi Toolbox. If the spring 
rate needs to be changed, by changing the constant value to the new rate, all channels 
using the constant are recalculated using the new value. 

Scope 

Global Constants 

A global constant has scope across all datasets and is saved as part of a Workbook. They 
are available for all Math Channels. Constant values, for instance: tire diameter, which do 
not change from one outing to the next, are defined as Global Constants. 

Outing Constants 

An outing constant only has scope within an outing and is saved as part of a dataset. 
Constant values, for instance: track temperature, which can change from one outing to the 
next are defined as outing constants. 

Note: Constants are created in the Constants Editor where they are defined as either Global or 
Outing constants. 



 

 

Simple constants and Excel constants 

There are two constant variants: 

• Simple Constant: Which is defined as a numeric value 

• Excel Constant: Which takes its value from an Excel cell. When math channels 
containing the constant are calculated, the value is taken from the spreadsheet 
cell, for example, a component value in the setup sheet. Certain actions can be 
executed in Excel before the cell value is retrieved, e.g. Execute a Macro. 

 

Constant management 

Global constants and outing 
constants are defined in the 
Constants Editor. The scope of the 
constant depends upon where the 
value is entered in the Editor. 

To open the dialog, select: Tools > 
Constants > Edit 

 

Names - The constants that exist for the current Workbook or for any of the outings 
contained in the Workbook are listed in the Name column. 

Global - A constant value entered here creates a Global constant. Enter a value by double-
clicking in the Global field and typing. 

Outing - The columns following the Global column represent the outings currently loaded in 
the Workbook. A constant value entered here creates an Outing constant. Values are 
entered by double-clicking in the Outing field and typing. 

Note: A colored triangle in the bottom left corner of the value field indicates the type of constant, 
i.e. Black = Simple Constant, Green = Excel Constant. 
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Inserts a new constant in the Name Column. Change the name if required by double-
clicking the default name and overtyping with the new one. You can also enter a constant 
name by typing directly in an empty name field. 

Note: Values entered in the Global or Outing columns create Simple Constants. To create an 
Excel Constant, click the 'More' button to extend the dialog. 

Excel constants 

The Constants Editor is extended when 
the 'More' button is pressed. These 
commands are used for creating Excel 
Constants. 

The left window shows details of the constant currently highlighted in the main window of the 
dialog. To create an Excel Constant, select Excel in the Type field and enter the name of the 
Excel workbook to be used. Then enter the cell address of the cell holding the constant 
value, into the Cell field, using the standard Excel format. 

Excel cell: Enter the location of the cell which holds the constant value, the location is in the 
form: Sheet name! A1 or A1, (column letter, row number).  

Excel file: Opens a browse dialog to let you browse for the Excel File. 

Note: You can copy a value from an Excel spreadsheet and paste it into a Constant value field. 
The Excel Cell location and Excel File paths are automatically entered. See Copy and Paste 
Excel Cell Value, page 58. 

Name: The name of the constant that is currently highlighted in the main window. This will 
become the Excel Constant. 

Type: Simple or Excel. 

Value: Shows the value of the constant. 



 

 

Command: The right hand window gives further command and argument options. 
Commands are activated each time Pi Toolbox attempts to acquire a value from a cell 
before the value is read. You can add as many commands as you wish and change their 
order using the up/down arrow buttons. To add a command, right-click in the Commands 
column and select from the available list.  

Enter arguments by typing directly in the field. 

The commands available are: 

Move to Sheet: Activates an Excel Sheet (argument: sheet number) 

Execute Macro: Executes an Excel Macro (argument: Excel Macro Name) 

Set Cell Value: Sets a value in a cell in the active Excel Workbook (argument: 
A1=value).  

Cut, Copy and Paste 
commands 

There are several cut, copy and paste options available within the Constants Management 
dialog. You can access these commands from the context menu or use keyboard shortcuts. 
You can copy and paste constants, globally, individually or by outing.  

Select all constants by clicking the Global or Outing header bar. Alternatively select 
individual constants by shift + clicking. 

Paste commands 

 +  Paste: Only the constant values and properties are pasted, the constant names 
are ignored. 

 + +  Paste Named: The constant names are used when pasting. If a constant 
with the same name is found in the target – it is replaced. If a constant with the name does 
not exist – it is created in the target. 

 +  Paste Excel Cell: An Excel cell value when copied from a spreadsheet and 
pasted into a constant creates an Excel Constant. 
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Working with Constants 

To create a simple constant: 

1 Select: Tools > Constants > Edit. 

The Constants Editor opens. 

2 Click the  button. 

A unique default name is entered in the Name column. To change the name double-
click the name field and overtype with the required name. 

3 Enter a constant value in the Global column or one of the Outing columns. To do 
this double-click the field and enter the value. 

4 Click OK to create a Simple Constant. 

To create an Excel constant: 

1 Highlight a Constant in the main window and click the Global column. 

2 Click   

The Constant Editor is extended to show the constant properties and commands 
windows. The details of the highlighted Constant are displayed. 

3 In the Constant Properties Window double-click Type and select: Excel. 

4 Double-click Excel File. Use the Open dialog to browse for the Excel file 
required. 

5 Double-click the Excel Cell field and enter the location of the cell that holds the 
constant value. 

Use the form A1 (column name, row number) to locate the cell. 

6 Click OK to create the Excel Constant. 
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To add a command to a constant: 

1 Create an Excel Constant following the instructions above. 

2 In the command column double-click and select a command. 

The available commands are: 

Move to Sheet: Select this to Activate an Excel Sheet (argument: sheet number) 

Execute Macro: Select this to Execute an Excel Macro (argument: Excel Macro Name) 

Set Cell Value: Select this to set a value in a cell in the active Excel Workbook 
(argument: A1=value) 

3 Double-click the argument column adjacent to the command and enter an 
argument. 

4 To add another command, click in the field beneath the last command listed and 
select the command. 

5 To change the command order, highlight a command and use the up / down 
arrows. 

To copy and paste an Excel cell value 

1 Click the  button. 

A unique default name is entered in the Name column. To change the name double-
click the name field and overtype with the required name. 

2 Copy a value from an Excel Cell,  + . 

3 Click in the Constant Value field (Global or Outing). 

4 Paste the cell value,  + . 

<New> will be displayed in the field until the cell value has been evaluated 

5 Click Apply. 

The cell value is evaluated and entered in the Constant Value field. An Excel Constant 
is created and the Excel Cell location and Excel File paths are automatically entered.   
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Working with Real-time data 

Real-time Outing 
functionality 

 

Outing functionality 

PiDatasets (Historic Data outings) Real-time Data outings 

Add up to 8 outings in a task. Same. 

Cut, copy and paste outings from one task into 
another task (or a the same task). 

Same. 

Automatically update outings in a task by 
‘watching’ a specified directory for added or 
replaced outings. 

Same. 

Select any lap in the outing from the Select Laps 
dialog. 

Same when in Paused mode. 

Select all laps in the outing using the keyboard 

shortcut:  +  .  
Same when in Paused mode. 

Select fastest lap from the dataset using 
keyboard shortcut:  + . 

Same when in Paused mode. 

Move the data selection to the Next, Previous, 
First or Last laps. 

Same when in Paused mode. 

Export qualifying data and displayed data from 
Time and Distance displays. 

Same. 

Change channel properties locally and globally. Same. 

Apply filters to individual channels. Same. 
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Display Features 

Link zoom all displays connect to a task. Same. 

Display X-axis in Time or Distance. Same. 

Display traces tiled or overlaid. Same. 

Show/hide cursor value legends Same. 

Display and edit lap markers. Display only. 

Show/Hide and Flash traces. Same. 

 

 

Real-time display 
features 
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Displays 

Real-time data can be viewed in Time and Distance displays, Chart Recorders, Histograms, 
X-Y charts, Bit Indicators, Channel displays, Event displays and Maps. 

Map displays 

Maps displays connected to real-time outings display car cursors to indicate track position. A 
Cursor is drawn for each real-time outing in the task. Graphical Lap Reports plot data in real-
time. 

Export displayed data 

Real-time data can be exported as a Pi Dataset from Time and Distance displays. The 
export data starts at the beginning of the data stream and ends at the time that the Export 
command was executed.  

Pi Dataset format data files support channel, event and lap marker data. Exported real-time 
datasets can be subsequently added to tasks and viewed as historic data. 

Pause mode 

 Use the pause button on the main toolbar - or shortcut:  to pause the incoming data 
stream. In Pause Mode data selection functionality is similar to that of displays showing 
historic data. Previous laps can be selected (one or more). When the pause button is 
pressed again Pause Mode is cancelled. How the display responds when Pause Mode is 
cancelled depends upon several factors. See Pause Characteristics. 

Note: In Pause, automatic updating of the data selection is suspended, but the data stream 
continues. 

Pause characteristics 

As the data stream continues and extends over several laps, the time span of the X-axis 
changes lap-by-lap to reflect the length of the last complete lap. 

In the example below when the data is paused the trace stops. Data continues to be 
recorded but the display does not update. When pause is cancelled, the display snaps back 
to the last seen lap marker and the data stream continues. 
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Pause characteristics examples: 
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The following illustration shows how the user can pause the data stream then scroll back 
and select a number of laps already received. When pause is cancelled the data selection 
snaps to the beginning of the incoming lap.  

In this example the user pauses the data 1 and selects two previous laps 2. When pause is 
cancelled 3, the display snaps to the current lap 4 (incoming data).  
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Setting up a Real-time display 

Set up real-time options 

1 Add a real-time display to the worksheet. 

For example, Real-time Chart recorder, Time and Distance display, Bit Indicator etc. 

2 Select: Tools > Options 

3 Select the Real-time tab. 

4 The Information stream field contains the IP address of the real-time server. If 
necessary, you can check that the address is correct. Go to the Pi Server 
application, select Telemetry tab and check the address in the Information 
Stream field. 

5 Click OK on the Options dialog. 

Add a Real-time outing to the task 

1 Create a task. 

2 Select (right click button) > Add Task to create a new task. 

3 Select (right click button)  > Add Outing. 

4 Click the Real-time button. 

The file window contains two nodes: Watch lists watch data servers. Telemetry lists 
telemetry data servers. If no servers are present, double clicking ‘No Watch Servers’ or 
‘No Telemetry Servers’ opens a ‘Browse for Computer dialog’. 

5 Double-click ‘No Telemetry Servers’. Alternatively select the telemetry node and 
click the add button. 

The ‘Browse for Computer’ dialog opens where you can browse for the telemetry server 
you require. 

6 Click OK to add the server to the telemetry list. 

7 Click OK in the Add dialog to add the real-time outing to the task. 

Select channels in the usual way in the Outing explorer. 
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CPU usage 

Users with machines rated at the recommended system specification should not experience 
performance problems in Real-time mode. However some worksheet configurations may 
cause high demands on CPU usage, for instance where the maximum permissible channels 
are used on several displays. 

One option for users who find that their CPU usage is too high is to reset the Update rate. 
This is the rate at which displays showing Real-time data are updated. The default is every 
200ms. 

To lower the Update rate, open the Options dialog select the Real-time tab and click the 
Advanced button. Enter a new time in the Update Rate field. 

 

Time and Distance displays and Real-time chart recorders 

Setting the drawing style of these display types to ‘Draw using Points’ can increase CPU 
usage. To reduce CPU usage the drawing style should be set to ‘Draw using Lines’. This 
property is set on the Drawing page of the display’s property page dialog. 



 

 

Time and Distance charts 

A Time and Distance display is a graphical method of displaying channel data values 
against Time and Distance in the form of a trace. 

A display can hold up to a 32 channels. Each channel creates a single trace on the display. 
If two outings are loaded each channel will create two traces, one for each outing. The 
Offset feature allows two traces from different outings to be aligned and compared.  

Shortcuts 

 Tile/Overlay traces 

 Time/Distance mode 

  Finds Min or Max values in the data selection 

 Zoom 

  Undo zoom 

+  Undo all zooms 

  Move cursor left or right 

 +  Move cursor quickly left or right 

   Move cursor to start or end of trace 

  Scroll through channels in display 

 Enter or exit time offset mode 

 +  Enter or exit value offset mode 

 Hide trace 
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 Flash trace 

 +  Selects all laps in the Select dialog 

 +  Selects the fastest lap in the outing (outing highlighted or display in focus) 

 +  Selects the all laps in the outing (outing highlighted or display in focus) 

 +  
Displays the Time and Distance display Properties dialog. 

 Lock/unlock the task cursor. 

Features 

Time or Distance mode 

You can display values against time or distance in the X-axis. This applies to both historic 
and real-time datasets. To toggle between the modes, press ‘D’. 

Tile or Overlay traces 

Traces can be overlaid, or tiled vertically. To toggle between the two layouts, press . 
Tiles hold one channel only but can hold multiple outings of that channel. 

The Active channel 

In a display one channel is the 'Active' channel, or the channel in focus. For visual reference 
the Y-axis scale is displayed in the same color as the active channel, and the cursor values 
legend is highlighted. You can scroll through the available channels using the   keys, 
making each in turn the active channel. 
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Active Channel selection 

Channel traces can be selected directly in the display plot area by shift-clicking the trace. 
The selected trace becomes the active channel. The active channels can also be changed 

by using the  keys to scroll through the available channels. 

The Task cursor 

The data cursor is a vertical line drawn through the active channel trace from the X-axis to 
the upper limit of the Y-axis. Move the Data Cursor along the X-axis using the   keys. 
The value at the intercept of the active channel (and all other channels) is displayed in the 
Data Value legends. In a Workbook two or more Time and Distance Displays can be 
connected to the same task. Cursor movements are made simultaneously in all displays 
connected to the same task. 

The data cursor can be locked on a TD chart by pressing  or by selecting the Lock 
Cursor option from the context menu. When the cursor is locked, the view will change so 
that the cursor is in the centre of the screen i.e. the chart will scroll to bring the cursor to the 
centre of the screen. 

Reference cursor 

Press  to place a reference cursor at the current cursor location. While in 'Reference 
Cursor' mode, all cursor values are relative to the reference cursor location, i.e. the 
difference between the data cursor and the reference cursor values. 

Auto-sized Cursor value legends 

Displays Y-axis values for the current Cursor position for both the active channel and all 
other channels. The legends continually update as the data cursor moves. With 'Auto size 
cursor values' selected in Properties, the maximum width required to show the cursor values 
/ channel names in full is calculated, and the display area adjusted automatically. 

Circuit maps 

Include a circuit map in the display to provide a visual reference to track position for a given 
data point. As the Task Cursor is moved along the active channel trace, the car cursor 
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moves to the relevant position on the map. This map is for visual reference only and cannot 
be edited. Circuit maps can be created using Pi Toolbox and presented in their own display. 

Flash or hide the active channel trace 

For ease of identification you can flash the active channel trace by pressing . Press  
again to stop the flash. You can also hide the active channel trace by pressing . 

Event markers 

An event marker - a triangle on the X-axis, indicates events on a display. Holding the mouse 
over the marker displays the event message. You can easily move between consecutive 
events on a trace by using the < > keys. 

Lap markers 

Lap markers generated by End of Lap beacons can be added to a display. They can be 
moved, deleted and reset as required. 

Statistics 

Maximum, Minimum and Mean values, and where applicable, the rate of data acquisition, 
are shown beneath the X-axis. Values can be shown for the active channel or for all 
channels selected for the display (All Traces). When the All Traces option is selected, a 
scroll bar is provided, to allow the user to scroll through all entries. 

Auto size statistics region 

Selecting this option (Properties dialog) forces the statistics region to expand so that values 
for all channels can be read without scrolling. This only applies when All Traces is selected. 

Offset mode 

A time offset can be added to all channels in an outing to change the position of the outing 
relative to another. This can be used typically to align two events from different outings, 
which occurred at different times in the respective outings, on the same circuit, e.g. a 
braking point. Pressing  on the keyboard allows you to drag all channel traces for the 
active outing (the outing belonging to the active trace) along the X-axis. 

246 Pi Toolbox User Guide 

 



 

 

 247 

 

Linked zooming 

Displays sharing the same task can have their zoom level linked. When linked zooming is 
enabled, zooming in on one display will cause all other displays to zoom to the same level, 
i.e. share the same time region. 

Scale the Y-axis of an individual trace 

Where several traces are overlaid, an individual trace can be scaled and moved vertically in 
the Y-axis, pulling the trace clear of the overlaid ones. 

Changing the Y-axis scale for a channel overrides the channel properties for that display. 

Map segments and Split positions 

If a Map has been created and is open, displays sharing the same task will show a segment 
bar along the full extent of the X-axis. The bar represents the Map’s segments, the segment 
colors matching those set for the Map. Split Beacon positions are shown below the Segment 
Bar. Double-clicking a segment or a split will cause the zoom region to be set to the extent 
of the segment/split. 

Zooming and Scroll bars 

Zoom in and out using the 'Z' key or the 'Ctrl - click and drag' method. Using the keyboard 
zooms in on the cursor region, leaving the cursor at the center of the display. Using the 
mouse you can zoom in on any region of the data selection. Use 'Backspace' to zoom out. 
When zoomed in scroll bars are added to the display. 

Panning in a zoomed region 

When zoomed in you can Pan forwards or backwards along the trace using the '+' and '-' 
keys. Multiple presses of the key will increase pan speed. Pressing the opposite key will 
decrease the speed. 

Auxiliary axes 

A separate Y-Axis can be displayed for every channel selected for the Display. The feature 
can be switched on and off individually in the Property Explorer for each channel. When the 
feature is switched off the axes displayed are for the active channel only. When switched on, 
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the axes for the active channel are displayed closest to the plot area. Changing the active 
channel re-orders the axes so that the new active channel's axes are nearest to the plot 
area. Displays having multiple data selections show multiple axes for each data selection. 
The shortcut key 'Y' toggles the auxiliary axis for the active channel between left, right and 
off. 

Real-time features and 
behavior 

Time and Distance Displays can be used to display historic and real-time outings. For more 
information see Setting up a Real-time Display, page 241 to find out how to add a Real-
time outing. 

Pause characteristics 
• When Pause mode is entered, data is frozen on the display but it continues to be 

buffered. 

• When Pause mode is cancelled, the buffered data is displayed from the last 
seen End of Lap beacon. 

Behavior 
• When a display begins to display real-time data the Y-axis range expands until 

an End of Lap beacon event is detected. 

The Y-axis is then set to the length of the first full lap. 

• For real-time outings, Distance mode is disabled. 

The default drawing style “Draw using Lines” is recommended in real-time mode as this 
reduces CPU usage. 



 

 

Working with Time and 
Distance displays 

The Task cursor 

Time/Distance Charts connected to the same task share a common Data Cursor position. 
As you move the cursor along the X-axis or click a data point or event, the cursor moves 
simultaneously in all displays connected to the task. 

This allows you to copy a display and, by setting different zoom levels, view data in detail on 
one display while maintaining an overview in the other. 

You can copy a display by 'Ctrl + click and drag' on the display title bar. 
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Tile or Overlay Traces mode 

Traces can be overlaid or tiled vertically. In Tiled mode a tile can hold one channel only but 
can hold multiple outings of that channel. 

 

The illustration shows the same data overlaid and tiled. In the tiled view the data is scaled in 
the Y-axis to accommodate all traces in the available display area. 

In the tiled view the data is scaled in the y-axis to accommodate all traces in the display. 

To change the display mode: 

1 Right click in the display. 

2 Select:  > Axes > Tiled (or Overlaid). 

• Or use the keyboard shortcut: with the display in focus, press . 
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Scale an Individual trace 

A single trace on a display in Overlay mode can be scaled in the Y-axis and moved above or 
below the remaining traces to give a clearer view. This feature may be unavailable if the Y-
axis is zoomed.  

To scale a single trace: 

1 Make the trace you want to tile the active channel. 

2 Place the cursor over the Y-axis at the top or bottom. 

The cursor changes to  or  depending upon where you are pointing. 

3 Click and drag to the required scale. 

4 When scaled, place the cursor over the center of the Y-axis to move the axis to 
the required vertical position on the display. 

The cursor will change to this  

Note: When 'Y Axis % enable' (in the details pane of the explorer) is set to 'Yes', Axis % max and 
min values can be edited in the explorer. This will achieve the same result as above. Note that 
values set in the Display tab of the explorer are local to the display, and override those set in the 
Workbook tab. Because of this, values entered in the Workbook tab will be ignored if local values 
have been previously set in the Display tab. 
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Using Time offset mode 

A time offset can be added to all channels in an outing to change the position of the outing 
relative to another. This can be used typically to align two events from different outings, 
which occurred at different times in the respective outings, on the same circuit, e.g. a 
braking point. Offset mode can only be accessed when the task contains more than one 
outing. 

To align traces: 

1 Select a channel in the outing you wish to move. 

2 Press . Note that the offset value is displayed. 

3 Click and drag the trace to align with the other outing. 

4 Press  again to accept the offset. 

You can enter the offset value by selecting the outing in the Task Explorer and changing 
'Time Offset' in the Details pane. 

To remove an offset, change the Time Offset property to zero. 

Using Value offset mode 

Active channels can be offset by a specified value. For example, you can compensate for an 
incorrectly zeroed ride height sensor by offsetting the channel by the amount that the sensor 
is out of calibration by. When an offset is applied it will affect the channel and data selection 
that the offset was set on, it will not affect a different data selection with a channel of the 
same name, even if the other data selection contains the same outing. Offsets can be 
applied to any channel including raw outing channels, maths channels and special maths 
channels. The offset is saved in the workbook not the .pds file. 

The value that the channel is offset by is displayed in the bottom of the Time and Distance 
chart. See example below. 

Note: If you have applied a Time and a Value offset, only one can be displayed at a time. When 
the channel with the value offset is selected, a box is drawn around the offset value, highlighting 
it. 
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Setting an offset 

To set an offset manually: with this option enabled you can drag the active channel trace up 
and down on the chart until the desired offset is achieved, once the offset is set, exit the 

offset mode.  > Offset > Value 

An offset can be set numerically from a dialog or by manually moving the whole channel 
trace to the desired offset position. 

You can specify a numerical offset in two ways: 

Offset relative to original values  

Selecting this method allows you to offset the whole active channel by a value. For example, 
if a ride height sensor has not been zeroed correctly, you can offset the ride height trace by 
the amount that the sensor is out. 

Offset to a target value 

Selecting this method, channel values will be offset so that the value at the current cursor 
position becomes the value shown. 
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  > Offset > Set Value Offset 

Pin Event markers 

Holding the cursor over an event marker will display Name and Time of the event. You can 
'Pin' event information by clicking the marker. A pinned marker will be displayed in Print 
Preview and will appear on a printed output of the display. To unpin the event click on the 
display again. 

 

Setting the size of the Plot region 

Including cursor values and a map on Time/Distance Charts reduces the plot region in the 
X-axis. You can extend the plot region, without switching off cursor values and maps. 

To extend the plot region: 

1 Move the cursor to the end of the X-axis 

The cursor changes to  and the plot region border is drawn. 

2 Click and drag the plot region border. 

The cursor values region is reduced and may result in the legends becoming partially 
hidden. 
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You can adjust the space allocated to the statistics region in the same way. Hold the 
cursor between the statistics region and the plot region. This method only applies when 
the All Traces option is selected on the Properties dialog (show statistics for all traces). 
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Setting the Reference cursor 

Setting the Reference Cursor on a 
Time and Distance Display forces 
the cursor value legends to show 
cursor values relative to the 
Reference Cursor Location. This 
applies to both Time and Distance 
mode displays. 

 

 



 

 

To set the Reference cursor: 

1 Move the Data Cursor to a point on the active channel trace where you want to 
place the Reference Cursor. 

2 Press  

The Data Cursor position now becomes the reference point. 

3 Click on a different point on the trace (alternatively click and drag the cursor). 

The Data Cursor is re-drawn. The region between the Reference Cursor and Data 
Cursor is shaded in red (depending upon operating system used). All cursor values are 
given relative to the Reference Cursor location (zero), e.g.  8.6 psi. The difference 
values can be positive or negative, depending upon where you place the Data Cursor 
on the trace. 

Note: The Time (or Distance) from the Reference Cursor is shown below the X-axis, e.g. 
5.200s. 

 

Note: Event times are also shown relative to the reference cursor position. 
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Using Lap markers 

Lap markers are indicated by a vertical line intersecting all traces. A number to the top left of 
the marker indicates the number of the lap that has just finished. Lap marker menu options 
are accessed from the Time and Distance display context menu. 

Note: The remove menu option is only enabled when the cursor is over the marker. 

Insert 

It is possible that a car passing a beacon would not record the event. For instance, an 
overtaking car may obscure the beacon. In this case the user needs to add a lap marker to 
an outing. Added lap markers cause all following lap markers to have their lap number 
increased by 1. Note that: 

• A lap marker can only be edited in Pi Datasets. 

• A lap marker cannot be added with the same time as an existing lap marker. 

Remove 

A lap marker may need to be removed if it was added in the wrong place, or if there are 
spurious lap markers in an outing (most likely generated by lap beacons at the track with 
duplicate codes). When a lap marker is removed, all subsequent lap markers and lap 
numbers are decreased by 1. 

Move 

If an adjustment to the lap beacon position is required, a correction can be made on the 
display by shifting the lap markers. 

You specify the distance along the track that you want to shift lap markers. All lap markers 
then adjust to the new virtual beacon position. 

A lap marker: 

• Can be shifted if derived from a hard End of Lap event or if inserted by the user. 

• Cannot be shifted if it derives from a Car Halt event. 

• Cannot be shifted past an existing lap marker. 

A distance channel must exist at the current location of the lap marker, and the new position 
for the lap marker. 



 

 

Reset 

All lap markers can be reset to their original non-shifted times. Any inserted lap markers will 
be removed, and removed lap markers will be reinstated, when the reset command is 
executed. 

Note: Editing a lap marker does not alter the ‘End of Lap’ events. 

To export Real-time data from a Time and Distance display: 

1 In the Real-time display select:  > Export > Displayed data 

It is recommended that Pause Mode is selected prior to exporting the data in order to 
guarantee the export range. 

2 Alternatively highlight the required outing in the Task Explorer and select:  > 
Export  

The Data Export Wizard opens.  

3 Select the Channels to Export. 

4 Select the Events to Export. 

5 Browse for a File Location. 

6 Select an Export Format option. 

The options are: MATLAB, ASCII and Pi Dataset. See Exporting Data, Page 425. 

7 Check Summary and Click Finish. 
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Properties 

To display the Properties screen, right-click on the Time/Distance chart to display the 
shortcut menu. Click Properties. 

Or select:  > Properties 

Layout 

 

Show cursor values: Displays cursor value legends for the selected channels. 

Auto size cursor values: calculates the maximum width required to show the cursor values 
/ channel names in full, and adjusts the display area automatically. 

If the cursor value region is resized manually, auto sizing is disabled. 

Show grid: Display a grid to aid data visualization. 

Show Map: Places a pictorial representation of the circuit map in the display, to provide a 
visual reference to track position for a given data point. 

Show segments/splits: places a segment bar along the full extent of the x-axis which 
represents the Map's segments and split beacons. Vertical reference lines are drawn at 
each segment or split beacon (depending upon which is selected). 
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Show statistics: places maximum, minimum, mean values, and where applicable, rate of 
data acquisition, for the active channel, beneath the x-axis. 

Auto size statistics: If checked, the statistics region will automatically adjust vertically, so 
that all statistics are visible beneath the plot region. This only applies if the 'All Traces' option 
is selected on the statistics tab of this dialog. If not checked, a scroll bar is provided on the 
left of the statistics region. 

Show active Y-axis: displays the active channel axis closest to the plot region. 

Drawing 

 

Draw using lines: Data points are connected by a line to render a trace on the display. 

Draw using points: Each data value is drawn as a point. With ‘draw using points’ selected, 
the slider is enabled. Use this to increase or decrease the size of data point when rendered 
on the display. 

 



 

 

View 

 

Cursor Values: Sets the display mode of cursor values. 

When Hexadecimal or Binary mode is selected, the Bit depth buttons are enabled. 

The values will be limited to 8, 16, or 32 bits when in hex and binary mode. If 'Auto size 
cursor values' is checked (Layout tab) the cursor value region will adjust automatically. 

X-Axis: Display values against time or distance in the X-axis. With a Time and Distance 
display selected, press  to toggle these modes. 

Y-Axis: Traces can be tiled or overlaid. With a Time and Distance display selected, press 
 to toggle these modes. 
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Trace 

 

In displays with multiple data selections, the Trace properties page can be used to 
progressively vary the color applied to channel traces over the range of data selections. Use 
the Color Variation slider to increase or decrease the intensity of the color variation. 
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Statistics 

Channel statistics: maximum, minimum, mean values, and where applicable, rate of data 
acquisition, are displayed beneath the plot region of the display. 

 

All Traces: Select this option to display statistics for every channel selected for the display. 

Active Trace: Select this option to display statistics for the active channel only. 

Note: With 'All Traces' selected, there may not be sufficient space to display all statistics. In this 
case a scroll bar is provided to the left of the statistics. A splitter bar is also provided between the 
plot region and the statistics region to allow the space allocated to each to be adjusted. 

Displayed Statistics: Select the statistics that you want to be displayed. The Channel 
statistics: maximum, minimum, mean values, and where applicable, rate of data acquisition, 
are displayed beneath the plot region of the display. 
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Color 

 

Properties: The various elements of the plot region are listed in this window with their 
assigned colors. 

Color Set: Allows you to choose Standard or Windows System colors. 

Color Palette: Shows the colors available for the Color Set selected. 

Edit Custom Color: Opens the custom color palette. 
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Font 

 

The standard Windows Font dialog controls the fonts used in the plot region of the display. 
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Histograms 

A histogram is a graphical method of displaying the distribution of data against time, or as a 
percentage of total time, in the form of a bar chart. 

Each bar represents how long each channel spends between two bin values. 

For example a histogram may be used to display the time a car spent in each gear, helpful 
in determining if the gear ratios are correct for a given set of conditions. 

The Y-axis displays the range of values of the active channel, divided into a number of bins. 
The axis is displayed in the color of its associated channel. 

The X-axis shows the absolute time or percentage of time that each channel spends 
between two bin values. 

The Bin-axis (to the right of the plot area) shows the absolute time and percentage of time 
for every bin. 

Shortcuts 

        Shortcut               Description                       Menu 

  Changes the active channel.  > Properties 

 +  
Displays the Histogram Property 
dialog. 

None 

 +  +  Copies bin values for all 
channels and all data selections 
to the clipboard. 

 > Layout > Tile bins/ Overlaid 
bins 

 Tile/Overlay y-axis mode.  > Copy as Text 
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Features 

The Active channel 

In a display one channel is the 'Active' channel, or the channel in focus. For visual reference 
the y-axis scale is displayed in the same color as the active channel. You can scroll through 
the available channels using the   keys, making each in turn the active channel. 

Display scales as a time or a percentage 

You may need to view data as a percentage of total time or as an absolute value, i.e. the car 
spent 45 seconds at full throttle in a lap of 1 minute 20 seconds. 

Display an X and Y-axis with graduations 

An axis and its associated graduations are used as a visual reference to data values when 
analyzing data and debriefing drivers. The Y-axis is shown in the same color as the active 
channel. For clarity, the X-axis is the reverse color of the background. 

Change the number of divisions or bins 

You can vary the number of divisions - 'bins' - within the data, up to a maximum of 32.  

Zoom the data range in time or distance. 

You can limit the data region in the X-axis, over which the data is displayed, by either time or 
distance. For example, you may wish to analyze damper velocity distribution on the main 
straight only.  

Show vertical bins  

Histograms can be displayed in a vertical orientation by selecting ‘Show Vertical Bins’ in the 
Property dialog. In this mode, the bin values are shown at the top of the plot area and the 
range of values displayed at the bottom.  
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Linked zoom 

Displays within a Workbook that share the same task, can have their zoom level linked 
together. With two or more displays in a task linked, zooming in on any of the displays will 
cause all linked displays to zoom to the same level, i.e. share the same X-axis time region. 

Copy bin values as text  

Using the ‘Copy as Text’ context menu command, the bin values for all channels and all 
data selections can be passed into an Excel spreadsheet in a tab de-limited format. 

Multiple Axes 

A separate Y-axis and Bin axis can be displayed for every channel selected in the 
Histogram. The feature can be switched on and off in the Property dialog. It can be selected 
for screen only, print only or both. 

When the feature is switched off the axes displayed are for the active channel only, when 
the feature is activated, the axes for the active channel are displayed closest to the plot 
area. If you change the active channel then the channels will be displayed so that the new 
active channel is displayed closest to the plot area. Histograms having multiple data 
selections show multiple axes for each data selection. 

Note: You can change the active channel in the following ways: using the up and down arrow 
keys, by clicking on the Y-axis or Bin axis of the ‘non-active’ channel and by clicking on a bar in 
the plot area. 

Non-linear bins 

By default, the Histogram shows an equal number of bins for all channels selected for the 
display. Users can set specific channels to show non-linear bins, i.e. the bin count and 
intervals can be set separately for individual channels. In non-linear mode, a channel's bin 
count and intervals is determined by the color gradation property in the Property explorer. 



 

 

Displaying non-linear bins 

1 In the Properties Explorer select the channel that you want to display in non-
linear bins. 

2 In the lower pane click the  button adjacent to the Color Gradation property. 

3 The Gradation Properties dialog opens. 

4 In the 'Type of color gradation' field select: Discrete. 

5 Click to add the required number of bands - this will determine the number 
of bins. 

6 Select each color band in turn and in the right-hand window expand the 'Bounds' 
node (if necessary) and set lower and upper bound values. 

Note: Altering the lower bound will affect the upper bound of the preceding color band. 
Altering the upper bound will affect the lower bound of the proceeding color band. 

7 Click OK to close the dialog box and accept the changes. 

8 Go to the Histogram display and select the channel for the display. 

9 Select:  > Properties to open the Properties dialog and select the Channels 
tab. 

10 Select the 'Non-linear Bins' and 'Color Gradation' checkboxes. 

11 Click OK to return to the Histogram. 
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Properties 

Layout 

 

Region Visibility 

Show Grid: Switches the background grid On and Off. 

Show active areas: Toggles the X-axis on and off. 

Bins Orientation 

Determines the orientation of the display between Horizontal and Vertical. 
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View 

 

Bin settings 

Number of bins: Sets the number of divisions 'bins' of data. The default value is 10 bins. If, 
for example, engine speed were the active channel, the total engine rev range would be 
divided into 10 bins. With the channel maximum value set at say 14,000rpm the first bin 
would be 0 to 1400 rpm; and the last bin would be 12,600 to 14,000. 

Note: Data falling outside of the display minimum and maximum values set for the channel (the 
data range) can be displayed in End bins. 

Show End Bins: Shows the total value of the data that falls outside of the data range set 
(display maximum and minimum) for the channel. For example, the time, or percentage of 
total time, that a value spent above a set maximum limit, would be shown in the End Bin. 

Bin Layout 

Overlaid/Tiled: Bins can be overlaid or tiled. Tiles hold one channel only but can hold 
multiple outings of that channel. When in tiled mode the shown bins will be grouped by 
channel, not by bin number. Toggle modes by pressing 'T'. 
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Bin Domain Axis 

Autoscale: When checked, Autoscale adjusts the X-axis scale to the highest value of data 
found in all the channels displayed on the histogram, and then adds 5%. This ensures that 
data is displayed on the full width of the histogram whilst leaving a 5% margin. When not 
checked the X-axis scale is determined by the Max and Min field values set for Percentage 
and Time. 

Note: Autoscale affects all channels displayed on the histogram. You can set auto scaling in the 
Y-axis for individual channels in the Properties Explorer. 

Percentage: With Percentage selected the X-axis shows the percentage of total time 
occupied by data in each bin. The scale default max is 100%. The highest value of data 
found is displayed as 100% of the X-axis (with Auto scale off). If, for example, you select 
50% max, only half of the highest value of data will be displayed. 

Time: With Time selected the X-axis shows absolute values for data in each bin. With 
Autoscale off the range of the X-axis is determined by the Max and Min value fields. 



 

 

Channels 

The page lists the channels in the Histogram and enables them to be selected for displaying 
in non-linear bins mode. The bin count and intervals are determined by the color gradation 
property in the Property explorer. 

 

Non-linear bins: When selected the bin count for the channel is determined by the number 
of steps selected in the color gradation property for that channel (in the Properties explorer). 
The bin intervals are determined by the boundary settings for the property. In this mode the 
bin setting for the display (View page) is ignored. 

Note: The color gradation mode must be 'Discrete' for non-linear bins to function.  

Color gradation: When selected the bins are displayed in the colors set in the color 
gradation property. This option can be selected separately from the non-linear option above. 
Color gradation mode can be Discrete or Gradient.  

Note: Non-linear bins will only function with one data selection added to the task. 
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Zoom 

 

Data Selection: When selected, the data plotted is taken from the full extent of the outing 
data. 

Time: When selected the 'From' and 'To' fields are enabled. Adjust these times so that the 
plotted data is taken from a specific time period, effectively zooming in on that portion of 
data. 

Distance: When selected the 'From' and 'To' fields are enabled. Adjust these distances so 
that the plotted data is taken from a region in the outing that corresponds to a specific 
portion of the track.  

Note: For information about customizing the appearance of the display, see page 258 
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X-Y Charts 

X-Y Displays graphically illustrate the correlation between two channels plotted on Cartesian 
axes, and identify patterns of behavior. This chart can be used in both Historic and Real-
time modes. 

Typical uses may be to analyze the suspension stiffness of the car by plotting wheel force 
against wheel displacement, or to analyze the engine oil system performance by plotting 
engine oil pressure against engine RPM. X-Y display can support up to 16 pairs of channels 
to display. 

Shortcuts 

  Moves the X cursor to the next/previous data point. 

 +   Moves the X cursor through the data quickly. 

  Moves the X cursor to the beginning or the end of a trace. 

 +  +  Show / Hide the Polynomial curve. 

 +  +  User defined Polynomial 

 +  +  Copy Equation. 

 +  +  Copy Coefficients. 

  Or 

 +  

Changes the active channel pair. 

 +  

Displays the X-Y Properties dialog. 

 Zoom in 
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 Zoom out 

 +  Undo all zooms 

Features 

Active channel pair selection 

On an XY display one pair of channels is the “Active” pair (active trace), or the channel pair 
in focus. For visual reference the Y-axis scale is displayed in the same color as the active 
pair. You can scroll through the available channel pairs using the   keys, making each 
in turn the active pair. Active channel pairs are persisted when the workbook is saved and 
subsequently opened. They are also persisted when the display is exported. 

Data cursor 

There are two cursors. The free cursor '+' snaps to the nearest data point to the mouse 
cursor and follows the mouse movements. The task cursor 'X' cursor is drawn at the nearest 
data point to where you click. The task cursor is locked to this data point until you click again 
or click and drag. In a Worksheet two or more displays (XY and Time/Distance) can be 
connected to the same Task. You can click and drag the task cursor around the data region 
in XY Displays to move the cursor simultaneously in all other displays connected to the 
same task. This is known as the 'Task Cursor' concept. 

Data Range zooming 

The time region of the X-axis is displayed below the axis and shows the time region in which 
data is calculated. By default the PSD display's time region is the whole of the data 
selection, indicated on the display by the legend - TR: [Data Selection]. Using the Zoom tab 
on the Properties dialog, the user can determine a specific time or distance range for the X-
axis, effectively zooming in on a portion of data. The time region legend shows the specific 
time/distance region selected, e.g. TR: [0.00..60.00] or DR [0.00..4500.00]. Note that the 
time/distance range is applied relative to the beginning of each data selection. 
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Polynomial curves 

Polynomial Curves represent the polynomial relationship between two channels. For 
example, when comparing left and right suspension stiffness, there are two pairs of 
channels, FL_Load against FL_Displacement and FR_Load against FR_Displacement. 
There will be two polynomial curves. When polynomial curves are ON, the active polynomial 
equation (the active channel pair) is displayed below the X-axis as an indication of the 
curve's fit. 

User defined Polynomial curves 

Users can change the offset and/or gradient of first order polynomials that have been 
automatically generated. This may be useful for graphs that include some non-linear points 
in the plot area that cause an undesirable polynomial to be generated. Editing is achieved by 
dragging the whole line, or the end points of the line, with the mouse. 

Zoom and Scroll in the Data region 

Using the mouse or menu commands you can zoom the data to investigate an area of 
interest. Horizontal and vertical scroll bars allow you to pan the zoomed area. 

Linked Zooming 
Displays sharing the same task can have their zoom level linked together. When linked 
zooming is enabled, zooming in on one display will cause all other displays to zoom to the 
same level, i.e. share the same time region. In X-Y displays the display would show only the 
data between the start and end zoom time. 
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Data value legends 
The 'Cursor' legend shows the data values for the task cursor position and only changes 
when you click in the data region or click and drag. The 'Closest' legend shows the data 
value at the free cursor. The 'Polynomial' legend shows the value of the polynomial curve at 
the point nearest to the free cursor. 

Auxiliary Axes 

A separate X-axis and Y-axis can be displayed for every channel pair selected for the 
display. The feature can be switched on and off in the property dialog and can be selected 
for screen only, print only or both. When the feature is switched off the axes displayed are 
for the active channel pair only. When switched on, the axes for the active channel pair are 
displayed closest to the plot area. Changing the active pair re-orders the axes so that the 
new active pair’s axes are nearest to the plot area. Displays having multiple data selections 
show multiple axes for each data selection. 

Copy and Paste polynomial expressions 

Copy Equation and Copy Coefficients commands are used to copy the polynomial 
expression in the following formats: Plain text for pasting into text processing applications, 
e.g. Notepad; Rich text format for pasting into RTF aware applications, e.g. Word; and Tab 
delimited coefficients for Excel. 

Displaying data in three dimensions 

The XY charts can show data in 3 dimensions by using a third channel (C) to color the XY 
plotted data points via the color gradation scheme applied to the channel. 
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Real-time features and 
behavior 

XY charts can be used to display historic and real-time outings. See Setting up a Real-time 
Display, page 241 to find out how to add a Real-time outing. 

 

The following list describes the behavior of XY charts in Real-time mode. 

• When Real-time mode is paused, the display behaves and functions in exactly 
the same way as in Historic mode. 

• The Polynomial is disabled and the Polynomial values are not shown. 

• Zooming the data region is disabled and all current data zooms are discarded. 

• The display zoom is not affected. 

• The free cursor is disabled and its values are not displayed. 

• The time region indicator displays: TR [data selection, real-time] 

 



 

 

Working with X-Y charts 

The Task cursor concept 

Other charts connected to the same task share a common Data Cursor position. In XY 
charts the task cursor 'X' is fixed until you click (or click and drag) in the data region. The 
task cursor snaps to the point nearest to where you have clicked (or if you are dragging, the 
point where you release), The cursor moves simultaneously in other XY charts, or 
Time/Distance Charts, connected to the task. 

This allows you to copy a display and, by setting different zoom levels, view data in detail on 
one display while maintaining an overview in the other. You can also compare the same 
data in an XY chart and a Time/Distance Chart. 

You can copy a display by 'Ctrl + click and drag' on the display title bar. 
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Selecting Channel pairs 

Channels are added in pairs to XY charts up to a maximum of 16 channel pairs. After 
creating the XY Display and connecting it to a task, you can select channel pairs to be 
displayed. Initially, the details pane will display 'No Selection'. 

To select a channel pair: 

1 Double-click the first channel or press ‘Enter’ 

The channel appears in the details pane. The  
icon indicates that the first channel will provide x-
axis data. 

2 Double-click the second channel or press ‘Enter’ 

The  icon indicates that the second channel will 
 provide Y-axis data. 

Note: Repeat the above steps to create multiple XY plots, 
e.g. Speed-RPM, Speed-Oil Pressure. 
 

To swap the XY assignment of channels: 

• Highlight the pair header and select:  > Swap 

The X and Y channels swap their assignment. 

 

To remove a channel pair: 

Highlight the pair header and select:  > Remove 

You can replace either channel in the pair by highlighting one and selecting:  > Remove, 
then selecting another channel to replace it from the Available Channels list. 
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Showing or hiding the Polynomial curve 

When you add a channel pair to an XY display a polynomial curve of the third order is 
automatically generated and displayed. You can choose to change the order or of the curve 
or hide it. 

Note: Changing the Polynomial order affects all channel pairs added to the display, it cannot be 
set for individual pairs. Likewise the Show/Hide commands affect all channel pairs. 

• With the XY display in focus select:  > Polynomial > Show Polynomial. 

The checkmark is removed from 'Show Polynomial' and the curve is hidden. 

Note: You can also use the keyboard shortcut  +  +  

To change the polynomial order 

• Select:  > Polynomial > Polynomial Order > 1, 2, 3, 4, 5 or 6 

Alternatively, the Polynomial order can be set in the Properties dialog. 

Creating a user defined Polynomial curve 

First order Polynomials can be re-defined if required. This can be useful where graphs 
include some non-linear points in the plot area that cause an undesirable polynomial to be 
generated. User defined Polynomials can be created individually for each channel pair. 

To change the Polynomial curve 

1 With the XY Chart in focus select the required channel pair using the arrow keys 
to scroll through the available pairs. 

Note: The selected channel pair becomes the 'Active' pair. The Polynomial Curve of the 
Active pair is drawn in black. 

2 Select:  > Polynomial > User Defined Polynomial. 

Note: You can also use the keyboard shortcut  + + . 
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'Grab' handles are added to the ends of the Polynomial line. When the mouse cursor is 
held over the Polynomial, the line becomes bold to indicate that it is in user-defined 
mode. 

3 To change the offset of the Polynomial, hold the mouse cursor over the middle 
part of the line, left click and drag the line to a new location. 

4 To change the gradient of the line, hold the mouse cursor over either of the line's 
endpoints, left click and reposition. 

Note: You can revert to the automatically generated Polynomial at any time by selecting  
> Polynomial > User Defined Polynomial again. User defined Polynomials are not 
persisted when the Workbook is closed. 

Tip: You can replace one or both of the channels in a pair. Right click on a channel in the 
Available Channels list and choose 'Select as X in.' or 'Select as Y in.'. The submenu 
displays a list of existing channel pairs. Choose one of the pairs to insert the new channel as 
X or Y data. 

 

Adding a C channel to a display 

A third channel - C, can be added to any existing channel pair on a XY chart or added at the 
time of configuration to make it an XYC chart. The extra channel will display data using its 
color gradation scheme, adding an extra dimension to the chart. 

To add a C channel to a display: 

• The C channel can either be added to an existing channel pair - in the Channel 

explorer,  > Select as C 

• To add a C channel at the time of configuring a chart, in the Channel explorer, 
multiple select the channels you want to add to the display, select the 3rd channel 

or C channel, this will be shown with the following icon:  



 

 

Properties 

Layout 

 

Show grid: Display a grid to aid data visualization. 

Show cursor values: Displays cursor value legends for the selected channels. 

Auto size cursor values: Calculates the maximum width required to show the cursor 
legends in full, and adjusts the display area.  

Show polynomial: Displays the polynomial curve on the plot region. 

Show active Y-axis: Displays the active channel axis closest to the plot area. 
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Drawing 

 

Draw using lines: Data points are connected by a line to render a trace on the display. 

Draw using points: Each data value is drawn as a point. With Points selected, the slider is 
enabled. Use this to increase or decrease the size of data point when rendered on the 
display. 
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Polynomial 

 

Show goodness of fit: How well data matches the reference model defined by the 
polynomial curve. 

Order: Order of the Polynomial from 1st to 6th. Defined by the reference model being 
compared with the data. 

Width: The Width slider increases or decreases the width of the polynomial curve rendered 
on the display. 
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Zoom 

 

Data selection: When selected, the data plotted is taken from the full extent of the outing 
data. 

Time (sec): When selected the 'From' and 'To' fields are enabled. Adjust these times so that 
the plotted data is taken from a specific time period, effectively zooming in on that portion of 
data. 

Distance: When selected the 'From' and 'To' fields are enabled. Adjust these distances so 
that the plotted data is taken from a region in the outing that corresponds to a specific 
portion of the track. 

Note: For more information about customizing the appearance of the display, see page 258 
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The Split report display 

The Split Report displays channel data per map sector in a spreadsheet format, using laps 
as row headings and sectors as column headings. Additional columns containing Lap 
performance, differences between current and fastest lap, and two additional rows 
containing the fastest rolling lap and theoretical fastest lap data can be displayed. The Split 
report also displays outing details, outing short comments and optionally the outing report 
type. 

The display can work in both historic data and real-time modes: 

• In real-time mode the report updates continuously, with the latest lap data 
always being displayed. The scroll bar is disabled until Pause mode is entered. 

Use the keyboard shortcut  to activate/deactivate the Pause control. 

• Historic mode displays data for the complete outing. Scroll bars are displayed 
and are active. 
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Split report features 

Types of Split report 

There are 3 types of split report that you can choose from: 

• Auto 

• Hard 

• Soft 

The display checks the outing for any Soft or Hard splits, if none are detected then the 
display defaults to auto. If any splits are detected then the display will default to the type of 
split detected. 

Exporting to MS Excel 

Selecting Export to Excel from the context menu will open MS Excel (if not already opened) 
and export the Split report to a new worksheet in the current workbook. The layout in MS 
Excel will match the layout of the Split report. 

Pause mode in Real-time 

Entering Pause mode inhibits further data from reaching the display. The scroll bar becomes 
active, allowing scrolling through previous laps from the outing. When Pause mode is 
cancelled, the buffered data will be added to the report and continuous updating will resume. 

Connecting to a single outing 

The display shows data for a single channel in a single outing. Where tasks contain multiple 
outings. The information displayed can be changed by connecting to another outing. 

Copying the data as text 

The display can be pasted as text into an MS Excel spreadsheet by using CTRL + SHIFT + 
C to copy the display and CTRL + V to paste the display into the spreadsheet. 



 

 

Split report properties 

Layout 

 

Show grid: Check to show grid lines on the display. 

Show report type label: Check to show the table header information. 

Lap performance: Check to show the lap performance column. This could be either lap 
speed or lap time depending on the global setting. 

FL difference: Check to show the fastest lap column. 

Out lap: Check to show the out lap row. 

In lap: Check to show the in lap row. 

FRL and TFL: Check to show the Fastest rolling lap and Theoretical fastest rolling lap rows. 

Note: All options are enabled by default. 
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Lap/Report 

 

Ascending: Click to set the lap order to ascending. 

Descending: Click to set the lap order to descending. 

Auto split: Click to set the type of split report to Auto. 

Hard split: Click to set the type of split report to Hard. 

Soft split: Click to set the type of split report to Soft. 

Creating a Split report 
and setting the telltales 

The following steps assume that you have created a task and loaded the datasets that you 
want to report on. 

1 Select: Insert > Display > Split Report, or use the Insert Display button. 

  An empty Split report display is added to the worksheet. 

2 Select: Data > Connect and select the required task.  
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3 With the report display in focus, go to the Selection Explorer (Alt + 2) and select 
the channel required for the report. 

The display is populated by data from the selected channel. Maximum channels are 
shown by default. 

Note: All laps in the outing are reported on, regardless of the current data selection. 

4 In the Split report, select the desired telltale for each sector from the dropdown 
list. 

Changing the connected 
outing 

When a Split report is added to a worksheet and connected to a task, the report is initially 
connected to the first outing added to the Task. 

Highlight the appropriate outing and select:  > Connect. 

The outing icon will change from this:  to this:   to show that it has been selected. 

Split report display 
shortcuts 

Shortcut Description Menu 

 +  

Display the Split report 
property pages 

 + Properties 

 +  Display the Context menu for 
the Split report 

 

 +  +  Copy the data as text N/A 

 Pause the Real-time display  > Local Pause 

 



 

 

The Summary display 

The Summary display is made up of 3 features. You can display any or all of the features at 
any time. 

A Channel display: Up to 4 channels can be displayed, with the option of using channel 
alarms. 

A Map: The map displayed is for reference only. 

Lap performance: The lap number and either lap time or lap speed is displayed depending 
on the global setting in the workbook. 

Note: The Lap performance information is always displayed. 

The Summary display can also be shown on a Palm PDA running Pi Remote Toolbox. For 
more information see Pi Remote Toolbox on page 300 

Summary display 
properties 

Layout 
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Region Visibility: This section controls how the features in the Summary display are 
displayed. The channel list and map are optional, the Lap information is always displayed. 

Show map: Display the map. A miniature map is drawn in the preview pane, to 
illustrate how the Summary display will look. 

  Show channels: Show or hide the selected channel information. 

Note: If the Show channels option is disabled, all features that relate to this option are also 
disabled. When the feature is re-enabled, the associated features will also be re-enabled. 

Show header: Display a heading row in the channel table. 

Show grid: Display the channel table within a grid display. 

Displayed columns 

Channel name: Check to show the selected channel names. 

Units: Check to show the associated units with the channels. 

Channel alarms: Displays or hides channel alarms. 

Channel Order 

 

This page controls the order that the channels are displayed in the channel table. To move a 
channel up or down in the table, select it and change its position using the Up or Down 
arrow. 
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Color 

From here you can set the color for the display. To change a color, select the color to be 
changed in the Properties section, then select a new color from the color palette. You can 
choose between two color palettes. 

Font 

You can set fonts the information displayed in the Channel display here. Select the Font to 
be altered in the Properties pane, edit the settings and preview the result in the Sample text 
pane. 

 

Font Default paragraph font, showing channel values etc. 

Header Font Table heading row text (if enabled) 

Performance Labels font Label text for Performance value 

Performance Values font Performance value font 

Channel display 

This display enables channel names, values and units to be displayed in a list view on the 
worksheet. The display can work in both historic data and real-time modes and is generally 
used for viewing channel values for car parameters in real-time. 

Note: Only 4 channels can be displayed in the Channel display section of the Summary Display. 

• In real-time mode, the values of the last data sample of the channel are 
displayed. 

• In historic mode, channel values are based on the position of the task cursor. 

The default layout of the Channel Display is a column made up of three sub-columns: 
channel name, value and units. 

The default channel color is indicated by a colored square adjacent to the channel name. 

The principle of connecting tasks to a display and selecting channels for viewing, as in 
Time/Distance Charts, applies to Channel Displays. 



 

 

Using Channel alarms 

Alarms can be configured and displayed in the Channel display and Summary display. 

 To use the alarm function, you must do the following: 

• Enable the Alarm function. This can be done in either the Channel display or 
Summary display properties. 

• Set the Global alarm properties in the Channel Explorer. 

• Add the channel to the display. 

Setting local alarm properties 

Once the channel is added to the display, you can set local alarm properties for any channel 
in the display. 

This is a useful feature if you are monitoring a channel closely, as soon as the value 
changes, the alarm will be triggered. 

• Select the alarm in the display,  > Set Thresholds. Keyboard shortcut  

The channel alarm thresholds are now locally set to the current value that is displayed in the 
table. 

Note: You can revert to the global alarm properties at any time. Select the channel in the display, 

in the Channel Explorer click the Display tab,  > Revert. 
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Summary display 
shortcuts 

Shortcut Description Menu 

 +  

Display the Summary display 
property pages. 

 + Properties 

 +  Display the context menu for the 
Summary display. 

 

 +  Copy the display N/A 

 Set the low and high alarm 
thresholds to current channel value. 

 +  

 Connect the display to Pi Remote 
Toolbox. 

Data > Remote display 

 Enable data transfer to Pi Remote 
Toolbox. 

Data > Pi Remote Toolbox 
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Pi Remote Toolbox 

Pi Remote Toolbox utilizes a PDA handheld device with a built in Bluetooth adapter as a 
wireless solution for viewing compatible Pi Toolbox displays. 

 

When Pi Toolbox is installed, a folder called Remote is created in the Pi Toolbox directory. 
This folder contains a file called PiToolbox.prc and a file called Mathlib.prc. These files need 
to be installed on the handheld device by using the Hot Sync function between the PC and 
the handheld. For more information on using or installing the handheld device, refer to the 
supplied manufacturers documentation. 

Note: To successfully use Pi Remote Toolbox, you must have a suitably enabled Pi Toolbox 
dongle and be running Pi Toolbox V3.1 or higher. 
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Before you can view the displays on a PDA, you must first select the communication 
protocol that is to be used to connect to the PDA. This is done on the Preferences dialog. 
Once the protocol is selected, you must configure Pi Toolbox to be able to transmit data to 
the PDA and the Pi Toolbox Remote software. This setting can be found on the Data > 
Remote display menu. 

Compatible displays can now be selected within Pi Toolbox by clicking the enable remote 

icon or by using keyboard shortcuts and view the information on a compatible PDA. 

As handheld devices have lower screen resolutions than a PC, any activated display will 
change to match the remote version of the display. For example: The remote channel name 
property will be used and the list of displayed channels in a Channel list may be reduced so 
that the view on the PC closely replicates the image that is seen on the handheld device. 
When a display is shown on the handheld device, the following icon is displayed in the upper 

right corner of the parent display in Pi Toolbox . 

A list of available displays can be navigated and selected on the handheld device once all of 
the required displays have been enabled for remote data transmission (maximum of 32). 

Note: The displays can be named using the keyboard shortcut . This is the name that will 
appear on the display list on the handheld device. 

Overview 

To be able to successfully view Pi Toolbox displays on the handheld device you must carry 
out the following steps: 

1 Install the Bluetooth PC adapter. 

2 Configure the Bluetooth serial port. 

3 Install the Handheld PDA. 

4 Install the Pi Remote Toolbox application on the handheld device. 

5 Start Pi Remote Toolbox. 

6 Configure the displays in Pi Toolbox and check their operation with the handheld 
device. 
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Note: This overview assumes that you have already installed a version of Pi Toolbox that 
supports Pi Remote Toolbox. If you haven’t done so, you must carry this out before attempting 
any of the other tasks. 

Installing the Bluetooth 
PC adapter 

Install the supplied Bluetooth PC adapter as per the supplied manufacturers instructions. 

Setting up the 
Bluetooth serial port 

Once you have installed the Bluetooth PC adapter, the Bluetooth serial port must be configured. 
You need to do this to configure the security options and to obtain the port details so that you 
can configure Pi Toolbox. 



 

 

To set up the Bluetooth serial port 

1 Right-click on the Bluetooth icon in the System tray to bring up the shortcut 
menu, select Advanced Configuration. 

 The Bluetooth Configuration dialog is displayed, click the Accessibility tab 

 

2 In the Allow field, select Only Devices listed below from the list. 

This will mean that only devices added to a permissions list will be able to connect to the PC 
via Bluetooth. 
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3 Click Add. 

The PC will search the network for Bluetooth devices. 

The Devices with access… dialog will be displayed. 

 

4 Select the user(s) that you want to be able to connect to the PC. 

5 Click OK. 

6 Click the Local Services tab. 

 

 303 

 



 

 

304 Pi Toolbox User Guide 

 

7 Select Bluetooth Serial Port from the list, click Properties. 

The Bluetooth properties dialog is displayed. 

 

 

8 Click to select the Startup Automatically box if it isn’t already selected. This will 
mean that your virtual Bluetooth port will automatically start when the PC is 
started. Remember the COM port details that are displayed. This setting has to 
be the same for the Bluetooth adapter and the handheld device. 

Note: Configuration for the handheld device COM port is done in Pi Toolbox. 

 

Note: Pi Toolbox must use the same COM port number that is displayed in the Bluetooth 
properties dialog. 

9 Click OK. 

10 Click OK. 



 

 

Installing the handheld 
device 

Install the supplied handheld device as per the supplied manufacturers instructions. 

Installing Pi Remote 
Toolbox 

The final step in configuring the elements of Pi Remote Toolbox is the installation of the 
PiToolbox.prc file and the Mathlib.prc file. 

1 Browse to the location where you installed Pi Toolbox, for example: C:\Program 
files\Pi Toolbox. 

2 Locate and open the Remote folder. 

3 Select the two .prc files contained in the folder and double-click them. This will 
add them to the Hot-Sync process. 

4 Hot-Sync your handheld device with your PC. The files are installed. 

5 Start Pi Remote Toolbox. Tap the  icon. 
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Getting Started 

Once you have installed Pi Remote Toolbox on your handheld device, you must make sure 
that Pi Toolbox is configured correctly to transmit the information and that your Bluetooth PC 
adapter is set up properly. 

Setting up Pi Toolbox 

1 Open Pi Toolbox. 

2 On the File menu, select Preferences. 

3 Click the Remote tab. 

4 Make sure that the Remote Connection method is set to Serial. 

5 Make sure that the Serial port is set to the same port number as the Bluetooth 
PC adapter. If you need to check what your Bluetooth adapter port number is, 
see Checking your PC adapter on page 313 



 

 

The handheld function 
buttons 

 

The function buttons can be used to perform various tasks: 

 

Disconnect the Bluetooth connection. 

 

Open the Displays menu. 

 

Discover Bluetooth devices. 

 

Connect/ Re-connect to the host PC and Pi Toolbox. 

 

4 way scroll & Select/Exit. 
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The handheld toolbar 

The toolbar on the handheld device allows you to personalize its appearance and configure 
some of the settings. 

 

Toolbar features: (from left to right) 

• Home. 

• Find. 

• Display the Context menu for the current menu. 

• Clock and handheld settings. 

• Alert. 

• Bluetooth settings. 

• Enable/Disable full screen writing. 

• Rotate screen. 

• Input. 
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Summary display 
overview  

 

The Summary display has 3 components: 

• A Channel display: Up to 4 channels can be displayed, with the option of 
displaying channel alarms. 

• A Map: Displayed for reference only. 

• Lap performance: The lap number and either lap speed or lap time is displayed 
depending on the global setting specified in the Pi Toolbox workbook. 

Note: The Lap performance information is always displayed. 

The display can be customized in Pi Toolbox to only display certain information, adjust font sizes, 
etc. These settings will then be applied to the display on the handheld device. 
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Channel display 
overview 

 

The Channel display enables channel names, values and units to be shown in a tabulated 
list. Data can be shown in historic or real-time modes and it is generally used for viewing 
channel values of car parameters in real-time. 

• In real-time mode, the values of the last data sample of the channel are 
displayed. 

• In historic mode, channel values are based on the position of the task cursor. 

Channel alarms can also be viewed on the handheld device. When the channel value moves 
outside of the specified minimum or maximum value, it will be displayed with a red 
background. The alarm value can be set globally or locally. Local alarms can be useful if you 
are watching a specific channel for a change in its status. For example: a differential 
channel. 
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Trouble shooting 

In this section you can find useful tips to help you if you are having difficulty configuring your 
handheld device or displaying data. 

Data is not displayed on the handheld device 

If there is no data being displayed on the handheld device, you need to check the following: 

1 Make sure that you are within the range of your Bluetooth PC adapter. For more    
information, refer to the manufacturers handbook. 

2 Make sure that no other handheld devices are connected to the PC. Bluetooth 
cannot    multicast. Only one connection can be made at any time. 

3 Make sure that the device is fully charged. 

4 Make sure that you have configured the Bluetooth serial port correctly. For more 
information, see Setting up your Bluetooth serial port, on page 303 

5 Make sure that you have configured Pi Toolbox to use the same Bluetooth serial 
port as the Bluetooth PC adapter. For more information, see Checking your 
Bluetooth PC adapter, on page 313. 

6 Make sure that you have enabled data transfer to Pi Remote Toolbox – 
keyboard shortcut F10. 

7 If you have changed your Bluetooth PC adapter and cannot establish a 
connection. For more information, see Changing your Bluetooth PC adapter, on 
page 313 

The Pi Toolbox display changes when Pi Remote Toolbox is enabled 

As handheld devices have lower screen resolutions than a PC, any activated display will 
change to match the remote version of the display. For example: The remote channel name 
property will be used and the list of displayed channels in a Channel list may be reduced so 
that the view on the PC closely replicates the image that is seen on the handheld device. 
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Checking your Bluetooth PC adapter 

To successfully set up Pi Toolbox and Pi Remote Toolbox, you must make sure that they 
are both configured to use the same Bluetooth serial port. 

To check your Bluetooth serial port 

1 Right-click on the Bluetooth icon in the System tray to bring up the shortcut 
menu. Select Advanced Configuration. 

2 The Bluetooth configuration dialog is displayed, click the Local Services tab. 

3 Locate the Bluetooth Serial Port from the list. The COM port number displayed 
next to this is the number that you must specify in the Pi Toolbox Remote setup. 

Changing your Bluetooth PC adapter 

If you have changed your Bluetooth PC adapter, when you try to establish a connection with 
the adapter from the handheld device, it will fail. 

This is because the new adapter has a different identification to the old one and the 
handheld will try to use this detail to establish the connection. To establish a successful 
connection, you must first delete the old Bluetooth PC adapter details from the handheld and 
then discover the new one. 



 

 

Pi Remote Toolbox 
shortcuts 

Keyboard shortcuts 

Shortcut Description Menu 

 Activate a selected display to be shown on a 
handheld device. 

Data > Pi Remote display 

 Enable transmission of data from Pi Toolbox to Pi 
Remote Toolbox. 

Data > Pi Remote Toolbox 

PDA Graffiti shortcuts 

Shortcut Description Menu 

R Displays the preferences dialog. N/A 

D Displays the details for the dialog. N/A 
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Maps 

A Map display is a pictorial representation of a circuit layout that can be divided into straight 
and corner segments to enable detailed analysis of car/driver performance. Standard maps 
are constructed from on-car inertial information. GPS maps are produced by decoding data 
logged from the local coordinate system, using math channels to create GPS coordinate 
math channels: Latitude, Longitude and Altitude. 

Note: GPS Maps are an optional feature. 

The GPS option allows maps to be created when conditions differ from those where inertial 
data can create accurate maps, i.e. enclosed lap circuits. These conditions may include: 

• Individual stages from point A to B, not forming individual laps with lap 
start/finish beacons. 

• Where vehicles operate at high roll and slip angles, on low grip surfaces, where 
high levels of wheel-spin render calculation of distance traveled difficult. 

• Where stages are used in both directions during testing. The Map Position D 
channel allows runs to be plotted in either direction. 

Note: The Latitude and Longitude math channels quantity is 'Angle'. The Altitude math channel 
quantity is 'Length'. 

Maps provide a pictorial representation of where the car is on a circuit at any instant in time 
and allow segment-by-segment comparison of car/driver performance. 

Note: Workbooks can only have one map loaded at a time. Multiple Map displays can be created 
so that they can display different channel data, but they will all reference the same map. 



 

 

Graphical Lap Reporting 

An additional functionality of Map displays is to provide Graphical Lap Reports. Here 
channel values for specific map segments are displayed in labels and color bands. For 
further details see Graphical Lap Reporting page 327. 

 

Shortcuts 

  In edit mode with map element selected, selects consecutive map 
elements, i.e. boundary, segment, beacon. 

 +  In edit mode selects multiple map elements. 

 +  In edit modes with boundary selected, moves boundary. 

 +  
Displays the Map Property dialog. 
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Features 

Edit mode 

Selecting Edit mode disconnects the map from the task cursor and allows you to edit 
segments, move borders, insert split beacons and edit segment captions. Exit Edit mode to 
view the car cursor and reconnect the task cursor. 

Create and save new maps 

Using the Create Map dialog, you create maps from distance, speed and lateral acceleration 
data. A preview window on the dialog continually updates as you change map parameters; 
providing a visual aid as you adjust the map shape to accurately represent the circuit. 

Segment editing 

After creating the map you can change the number of segments manually. For instance, you 
may need closer analysis of a corner and want to break it down into three segments. In Edit 
mode you can split or merge segments, move segment borders, create segment names and 
define colors. 

Map editing 

Choose custom colors to represent straights, corners, borders etc. Increase or decrease 
circuit line width and move segment captions. 

Car cursors 

Cursors on the map display car positions. In historic mode the relevant track position is 
shown for a given data point on Time and Distance and/or XY Displays, sharing the same 
task. The task cursor looks like this: X. 

Save and load map file 

The maps that you create can be saved, along with the segmentation and split parameters 
that you have set. Map files can be loaded locally or sent to other users. 
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Real-time features and 
behavior 

Maps can be used in Historic or real-time modes.  

Pause characteristics 

• When Pause mode is entered the car cursor (disc) is frozen on the map. 

• When Pause mode is cancelled the car cursor jumps to the current track 
position. 

 

Behavior 

• Maps can be created from Real-time data. However, real-time must be in pause 
mode. 

• In order to create from real-time data the Lateral Acceleration and Speed 
channels, must be selected on a display in the workbook. The display must have 
been viewed in the current Pi Toolbox session. 



 

 

Creating Maps 

Note: Before creating a map, go to the GPS Mapping dialog (Tools > GPS Mapping > Edit). 
Check that the common GPS channel names are mapped to the correct GPS co-ordinates in the 
Pi Toolbox database. For more information, refer to Mapping Common Channels, page 48. 

To create a map: 

1 Create a task and select the required outing. 

1 Create a Map Display and connect it to the task. 

2 Go to the Task Explorer, right-click on the required outing. 

3 Select:   > Create > Standard Map / GPS Map 

Note: The map types available from this sub-menu depends upon the types currently registered.  

4 Set the parameters in the Create Map dialog box. 

5 Click 'Apply' to create the Map. 

6 From the Create Map Preview check the shape of the Map. 

7 If you are satisfied that the Map is an accurate representation of the circuit, click 
'OK'. If you are not satisfied, adjust the lateral acceleration parameters as 
described above. 

Note: The Map is profile is based on the datum data selection in the task it is connected to. 
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Configuring a Standard Map 

 

Track Name: Enter the name of the circuit. 

Refetch Details: Updates the map to include outing property changes that have been made 
in the Task Explorer, e.g. Track Name. 

Track Type: Select the type of circuit. Select standard if the circuit does not contain in field 
loops, figure-of-eights and is ‘Closed’. 

Preview: The preview window continually updates as you change map parameters, 
providing a visual aid as you adjust the map shape to accurately represent the circuit. 
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Lateral acceleration 

The Map shape is determined by the speed, distance and lateral acceleration. If the Map 
appears incorrect, set lateral acceleration parameters to adjust the Map appearance. 

Offset: Calibrates the accelerometer so that when lateral acceleration is zero, output is 
zero. 

Scale: Sets the gain of the accelerometer, i.e. increases or decreases the output. 

Threshold: Sets the threshold for determining corners. Setting a lower threshold creates 
more corner segments, setting a higher threshold creates fewer corner segments. 

Track properties 

Official length: Enter the Official track length if available.  

Start Angle: Enter the angle for the start line. 

Configuring a GPS Map 

When you are creating a GPS map, you have to configure the map dialog. 
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Track name: Use this field to enter the name of the circuit. 

Preview: The preview window continually updates as you change map parameter, providing 
a visual aid as you adjust the map shape to accurately represent the track. 

Track Properties 

Official length: Track length is calculated by adding the distances between consecutive lap 
points. The user can enter the official length if known. In this case the distance between map 
points is proportionally scaled so that the total distance between points equals the official 
track length. 

Track Type 

Standard / Open: When 'Standard' is selected, a copy of the first point of the track is added 
at the end of the list so that the first and last points share the same X, Y and Z coordinates. 
GPS Maps are generated as 'Open' tracks by default. 

Distance Between Points 

Minimum: defines the average distribution of map points around the track. When the 
distance between two consecutive points is less that the minimum, the second point is 
removed. When greater than the minimum, a linear interpolation is performed to create a 
point mid-way between the two points. The default distance is 1M. 

Segments 

Corner radius: Sets the threshold for determining corner segments. The default threshold is 
50M. Setting a lower radius creates more corner segments, setting a higher radius creates 
fewer corner segments. 



 

 

Editing Maps 

All map editing is done in Edit mode, which disconnects the map from the task cursor and 
allows you to edit segments, move borders, insert split beacons and edit segment captions. 
Context menu options are different in Edit mode, to increase edit functionality. 

To enter Edit mode select:  > Edit, to leave select:  > Edit > Done. 
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To edit a map element: 
• Hold the cursor over a map element to highlight it: 

 

• Click on the element to select it: 

 

• Press Enter to open the edit box: 

 

Note: With a border element selected, you can use the tab key to select consecutive segment 
names. Using the arrow keys will select consecutive map elements, i.e. boundary, segment, 
beacon, segment, boundary. Press Enter to edit a selected Map element. 

 

Tip: You can use the following keyboard shortcut to exit the edit mode.  +  
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Map cursors 

Time/Distance Charts connected to the same task as a Map share a common Data Cursor 
position. As you move the cursor along the Map using the arrow keys, or click on a point on 
the Map, the cursor moves simultaneously to the corresponding data point in all connected 
displays. Conversely the relevant track position is shown on the Map when you move the 
Task Cursor along the active channel trace of a chart. This is the Task Cursor concept. 

In real time the Map retrieves the last time/value sample from the Lap Distance channel and 
uses this value to position the cursor. 

Saving and Loading a 
Map 

To save a Map: 

1 Select: Data > Map > Save As. 

2 In the Save as dialog browse for a directory to save the Map (.pxt) file. 

To Load a Map: 

1 Select: Data > Map > Load 

2 In the Load dialog search for a Map (.pxt) file to load. 

3 The map will become the loaded map in the Workbook and be shown in the 
display, replacing the existing map. 
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Printing a Map 

• With the map display selected, select: File > Print from the Pi Toolbox Main 
menu. 

Note: If segment names are switched off in the map display, they will not be printed. Use the 
Print Preview command to preview the printout. 

Editing Segments 

Map segments are created using lateral acceleration data. After the Map is created you can 
split segments and move segment boundaries to precise positions in order to analyze a 
particular portion of the track. For instance you may wish to divide a corner segment into 
'entrance', 'apex' and 'exit' segments. 

All editing is done in Edit mode. 

Naming segments and positioning segment captions 

To rename a segment: 

1 Double-click the segment caption or the segment itself. 

2 Overtype the segment caption. 

To reposition a segment caption: 
• Click and drag the segment caption to the required location. 



 

 

Splitting and merging segments 

When you split a segment, the split is made at the middle map point of the segment. You 
can then move the new boundary to a precise position if required. The segments created by 
splitting take the name of the original segment, i.e. segment name 1 and segment name 2. 
Change these if required. 

To split a Segment: 

1 Click the segment once to select it 

2 Select:  > Split Segment. 

Merging segments is achieved by removing the boundary between two segments. The 
resulting segment will be a straight (if both segments are straight) or a corner (if either 
of the segments is a corner). 

To merge two segments: 

1 Click a segment boundary once to select it 

2 Press . 

Moving Segment boundaries 

Two adjacent segments share a segment boundary. A boundary can be moved by clicking 
and dragging. When dragged, the boundary snaps to the nearest map point. A tool tip 
displays the track position as you drag, in the units of the Lap Distance channel. 

To precisely position a boundary, double-click and enter a distance in the edit box. 
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Editing Beacons 

Split Beacons 

The Map is divided into straight and curved segments from lateral acceleration data. 
However, to split the track into more appropriate sections, e.g. to analyze performance 
through a complex sequence of corners, you can add split beacons. Split Beacons are 
precise points on the racetrack, measured from the end of lap beacon, which define timing 
regions. Segments and split points can be shown on Time and Distance displays on the 
Segment Bar. 

To add a split beacon: 

1 Hold the mouse cursor over the part of the track where you want to add a split 
beacon. 

2 Select:  > Insert Split Beacon. 

The beacon is inserted in the segment at the mouse cursor location. 

To reposition a split beacon: 

1 Double-click the beacon marker. 

2 Enter a precise distance in edit box (if required). 

To remove a split beacon: 

1 Click the beacon marker once to highlight it. 

2 Press . 

Start-Finish line 

The Start-Finish line beacon is drawn on the map at distance 0.0. This beacon cannot be 
edited or deleted. 
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Graphical Lap reporting 

Graphical Lap reports consist of two main elements: 

• Labels displaying channel values for a specific part of the track, e.g. a straight or 
curved segment, beacons etc. For each channel included in the label, a function, 
or several functions can be selected. Channels and functions are set up in the 
Labels property page. 

• Color bands with gradient or discrete color fills, which follow the line of the track 
and indicate channel values through variations in color. 

In order to report on channels in the map display, channels must be selected for the display 
using the Selection Explorer. The selected channels are then available for including in 
labels. 

Adding, deleting and positioning labels is done in the Edit Reports mode. Setting up the 
label contents is done in the Labels property page in either mode. 
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Overview 

 

1 Channel Value labels - Labels are 
associated with a specific track 
element, i.e. segment, split, beacon 
etc. To make channels available for 
Graphical Lap Reports, they must be 
selected for the Map display. 
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Adding and deleting labels to and from 
track elements, and positioning labels, 
is carried out in Edit Reports mode. For 
more information about labels see 
Channel Value Labels page 329. 

2 Label legends - The Label Legend 
lists the channels that have been 
included in the labels. Functions are 
listed beneath each channel title. For 
example, the Speed channel may 

appear several times in a label with different functions: Speed on entry to the region, 
maximum speed in the region and speed on exit from the region. 

The label legend indicates what the functions are and what order they appear in the label. 

 
3 Active Channel Indicator - The color bar beneath the map indicates the active channel, 
and the min, max values of the channel in the data selection. Its color is derived from the 
channel properties, as is the color gradation scheme, i.e. Discrete or Gradient. Color 
gradation properties for a channel are set up in the Properties Explorer. These properties 
also determine the look of the Color Bands displayed around the track. 

 
4 Color Bands - These are drawn around the track using gradient or discrete color fills and 
represent values for the active channel as the car progresses around the track. Color depth 
gives a visual indication of how values increase or decrease along straight or curved 
sections of the track. 



 

 

Channel Value labels 

A label is associated with a map element, e.g. straight or curved segment, beacon etc. 
Labels can be added to any map element in the display. The channels and channel values 
contained in the label are defined in the Labels property page. The label configuration is 
global to the map display, i.e. each label created for the display, has the same contents. 

A label can consist of single channel with multiple functions (e.g. max, min, average for 
segment) or multiple channels with various functions. 

Labels are positioned on the map display, in edit mode, using the click and drag technique. 

The layout of a label changes depending upon the number of outings contained in the task. 

Single outing labels 

The illustration below shows a label created for a Map display that has a single outing 
associated with it. Two channels are selected for the label, RPM and Speed. The label 
legend shows the order of the value functions for each channel in the label. The active 
channel is RPM. Each instance of the active channel is highlighted in the label. 
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Multiple outing labels 

The illustration below shows a label created for a Map display that has two outings 
associated with it. Values are given for each outing and displayed in the outing color. In this 
example pairs of values are give for each channel function, Entry and Exit (RPM or Speed). 
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Graphical lap report editing 

Any map element can have a label added to it. The contents of the label are defined in the 
Labels property page in either View or Edit modes. Adding and Deleting labels and 
positioning them is carried out in Edit Report mode. 

• To enter edit mode select:  > Edit Report. 

• To exit edit mode select:  > Edit > Done. 

Selecting Edit Report mode disconnects the map from the task cursor as in Edit Map mode. 

Before adding a label to an element the label contents must be configured in the Labels 
property page.  

Creating graphical lap reports 

Add channels to a Map display 

1 With the Map display in focus go the Selection Explorer. Keyboard shortcut: 

+  

2 From the Available Channels list double-click the channels to select. 

These will appear in the lower pane under 'Selected Channels' 

The selected channels will now be available for inclusion in the graphical lap report Label. 

Configure a label 

1 In the Map display select:  > Properties. 

2 In the Properties dialog select the Labels tab. 

3 Click   to add a blank label entry line, alternatively press . 

4 Double-click the blank entry line under the Channels column. 

5 From the drop-down list of available channels, select a channel. 

6 Double-click the blank entry line under the Functions column. 

7 Select a function, e.g. Region Entry. 

8 Add as many channels as required and click OK. 
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Add Labels to a Map element 

1 Select:  > Edit Report to enter edit mode. 

2 Place the cursor over a map element (segment, boundary etc.) 

3 Select:  > Add Label. Keyboard shortcut:  

A new label is added with a leader line centered on the selected element 

4 Click and drag the label to the required position on the display. 

5 Select:  > Edit > Done to exit edit mode. 



 

 

Setting up a Gear Change scheme 

The example below shows how, using a discrete color gradation scheme, it is possible to 
quickly set up a gear change indicator. The Color Band indicates the gear change points on 
the track and the Active Channel Indicator shows the color allocated for each gear. On the 
Indicator, note that the color band up to the value 2 denotes 1st gear, between 2 and 3 
denotes 2nd gear etc. 

 

1 With the Map in focus, go to the Selection Explorer and select the Gear channel. 

2 Go to the Properties Explorer and click on the Gear channel. 

3 Double-click Color Gradation in the Details pane. 

The Color Gradation Properties dialog opens. 

4 In the Type of color gradation field select Discrete. 

5 With the root node (Discrete) still selected in the left-hand window, set the Bound 
Settings property to Automatic. 

6 Set the Lower Bound property to 2 and the Upper Bound Property to 6. 
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7 Using the New button  add three new color bands (until the gap between 
bands in the left-hand window is 1). 

To set the color bands: 

1 Click the bottom node in the left-hand window (<2). 

2 Double-click the color property and, from the color palette, select a color to 
represent the 1st gear. 

3 Click the top node (>=6) and select a color to represent 6th gear. 

4 Click on the root node (Discrete) and select:   > Determine Colors. 

Colors graded in depth between the first and last gears are selected automatically. 

5 Click OK. 

Note: In the Gear channel details pane, you can set the Decimal place property to '0' so that the 
divisions read 2, 3, 4 etc. 



 

 

Properties 

The Map (properties) dialog is where the line width, segment and border colors are 
determined. 

Access the dialog by selecting:  > Properties. 

Note: You can access this dialog in both 'Live' and Edit modes. In Edit mode there is a separate 
'Map Properties' context menu, which allows you to reset map parameters in the Map dialog. 

Layout 

Map style 

The check boxes are used to select the 
items to be shown on the display. The 
preview window updates continuously to 
give visual indication of the items selected. 
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Color bands 

Sizes 

Track: This slider control changes line width 
of the various Map elements, e.g. segments, 
boundaries etc. 
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Bands: This slider control changes line 
width of the color bands that are drawn 
around the track to represent active channel 
values. 

Car Cursor: This slider control changes the 
size of the car cursor (disc). 

 

Labels 

 Contents 

 Adds a blank entry line to the label. 

 Deletes a Label line. 

Channel: Double-click to open a drop-down 
list of available channels (channels which 
have been selected for the Map display). 

Function: Double-click to open a drop-down 
list of reporting functions. 

Note: For more information about customizing the appearance of the display, see page 258 

 

 



 

 

Excel reports 

The Excel Reports display provides a means of summarizing and organizing data for display 
and printing in Excel spreadsheets. 

 

Like other Pi Toolbox displays, it is connected to a task. Data channels are added to the 
display so that they are available for selection by individual tables in the display. 

In the Excel Reports display you create tables that are listed by name in the order that you 
create them. A table's properties are defined in the Report tab of the Excel Report 
(properties) dialog. The properties you set are the Excel Report Type, the Excel file, the 
channels and the channel functions (min, max, mean etc.). 

Channels and events added to the display are automatically selected for all Lap and Outing 
tables. They can be deselected to create channel / event subsets for individual tables, 
however they will not be deleted from the display, and will be available for re-selection. 

From the display you can run the whole report, which outputs all tables to an Excel 
spreadsheet, or you can run individual tables. 

Up to eight Excel reports can be added to a Worksheet. 
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Shortcuts 

 Adds a new table. 

 Deletes the selected table. 

 +  

Runs the entire report. 

 

Run the selected table. 

 Cancels a report or table run. 

 +  

Opens Properties dialog for selected table. 
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Excel report features 

Reports generated in Microsoft Excel 

Excel is commonly used as a reporting tool throughout the world. Engineers can create and 
control the Report format in an environment that is familiar, without needing to retrain on 
new software. 

Master workbooks 

A master workbook can be defined for an Excel Report display. This becomes the default 
template for all tables in the Report (data is output to this destination). However, individual 
tables can have their output destinations changed to additional workbooks if required. 

Task based to enable rapid selection of outings and laps to report 

Excel Reports are task based like other Pi Toolbox displays so changing outings for a report 
is done at the task level and is quick and easy. 

Excel report templates 

Excel Reports displays can be exported as part of a Worksheet, or as an individual display, 
and subsequently imported at other locations and used as templates. 

Multiple outing 

The report order for multiple outings is the same as the order of selected outings in the task. 
You can produce 'trend' reports that show the trend of a parameter over multiple outings. 

Report on Soft Events and Math Channels 

Soft Events and Math Channels can be selected for an Excel Report display in the same 
way as real events and channels. These are then available for selection by all tables in the 
display. 
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Run Macros in Excel 

At the Run Report or Run Table commands, Pi Toolbox initiates a macro before data is 
downloaded to Excel and after data download is complete. The macros are available for 
programming in the Visual Basic Editor of Excel, to your own requirements. 

Repetitive headings 

Generation of repetitive lap, lap time and telltale headings for all but the first outing can be 
switched on and off by the user. The initial headings row cannot be switched off. 

Error messages 

A progress bar and error messages are shown beneath the list of tables in the Excel Report 
display. 



 

 

Report Types 

Lap reports 

Lap Reports use Map segments to divide laps into straights and corners and show channel 
values segment by segment. They are typically used to show maximum values achieved in 
each segment of a lap over the course of a complete outing. Before the report can be 
generated a circuit map must be created with segments defined and currently loaded. 

 

In the above example, the engineer is interested in maximum speed, oil pressure and 
engine RPM for each segment of an outing of several laps. 

For each channel, the function selected is the maximum value. 

When the Report is generated, the outing information, lap number and lap time are given. 
Then the lap is divided into segments with the maximum values of the associated channels. 

Note: When the report contains a ‘compare’ math channel, e.g. Compare Speed, the time region 
for the datum outing is typically the fastest lap. This applies to all Excel Report types except Split 
reports. 
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Outing reports 

Outing Reports are used to examine channel values lap by lap over for an entire outing and 
are typically used for analyzing trends during an outing; for example, engine temperatures or 
pressures.  
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Soft Split reports 

Split Time Reports split the track into key segments or features (e.g. slow corners, fast 
corners, straights). Before a report can be generated a circuit map must be created with 
segments defined and currently loaded. 

This type of report may typically be used to determine the effect of chassis set-up changes 
with respect to car performance within key areas of the track layout. 

The report provides two unique performance indicators - the theoretical fastest lap and the 
fastest rolling lap. The theoretical fastest lap gives the lap time that could be achieved if the 
best split section times from an outing were all in one single lap. The fastest rolling lap is the 
fastest lap time using a start and end point that may not be the end-of-lap beacon. 
Comparing achieved lap times to the theoretical fastest lap time shows driver consistency. 

 

This example shows that the Excel Report consists of the lap number, lap time, the number 
of split beacons you have added to the circuit map and the time difference of the lap to the 
flying lap time. The times between split beacons are shown in the columns headed 1, 2, 3 
etc. 

Each row corresponds to an individual lap of the outing. The cells that correspond to the 
fastest time between the split beacons are highlighted. 
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Hard Split Reports 

Hard split reports generate event data for Split Beacon events in an outing. 

Event reports 

Event Reports show when an event occurred and any associated channel values. To create 
an Event Report both channels and events must be added to the Excel Report display to be 
available for selection. 

Note: The following example shows a typical Event Report layout for post V2.x versions of Pi 
Toolbox. Data output can be configured to generate V1.x Event Report layouts. This differs 
slightly from post V2 versions, in that all event occurrences are listed for all associated channels. 

 

In this example the Event GBox SOS has assigned channels GBox IPS, GBox Drum Dmd 
and Gbox Oil Press. The Event's description is turned off. 

Each row consists of one event and one or more channels associated with that event. 

 

344 Pi Toolbox User Guide 

 



 

 

Between Events 

Between Event reports generate data between events occurring within a lap or outing. The 
user can set independently the start and end events. They can typically be useful for testing 
engines on a dyno where a transition occurs in RPM (start event), is held constant for a 
period of time and then stepped to the next target event (end event). The user can generate 
a report examining what the RPM variation was between the start and end events. 

The output is similar to an outing report except that channel TellTales are calculated 
between the start and end events. 

 

In this example the first two sections of the report define a time region where data is 
collected. The last section contains the selected telltales. See graphic below. 

 

Time regions are defined using the following rules. 

• The time region starts at the first occurrence of the start event in the outing 

• The time region ends at the first occurrence of the end event in the outing 

• Consecutive events of the same type are ignored. 
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Report layouts 

The position of individual tables in an Excel report display is determined by the starting cell 
selected (in the Excel Reports dialog - Table tab). 

For each table you select a starting cell, shown like this  in the illustration, which 
determines the top left starting point. Individual tables are shown surrounded by borders. 

In the display selecting:  > Run Report, runs all tables in the display and positions them 
according to their starting cell. 

Selecting:  > Run Table, runs only the table highlighted, positioning it according to its 
starting cell. 

To Select a Starting Cell: 

1 Double-click a table in the display. 

2 Select the Table Tab in Excel 
Reports dialog. 

3 Click 'Get Cell'. 

4 Maximize Excel. 

5 Click in starting cell. 

6 Go back to Pi Toolbox. 

7 Click 'Get Cell' again. 

The starting cell appears in the Starting 
Cell field like this: Sheet1$A$20. 
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Generating reports 

To create an Excel report and add a table: 

The following steps assume that you have created a task and loaded the datasets that you 
want to report on. 

1 Select: Insert > Display > Excel Reports or the Insert Display toolbar button. 

An empty report display is added to the Worksheet. 

2 Select: Data > Connect and select the required task. 

3 Select:  > New Table. 

An empty table is added to the report display. 

4 Repeat the above steps to add further tables as required. 

To select channels and Events for the Excel report display: 

Data channels and Events are added to the Excel Report Display so that they are available 
for selection by individual tables in the display. Channels selected are specific to a display. 
Every Excel Report display on the Worksheet must have its own channels selected. 

Select channels in the same way as you would for other display types. 
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Setting the Excel report properties 

1 Highlight the table in the Excel Report control that you want to configure, select: 

 > Properties. Alternatively you can double-click the table or use the 

keyboard shortcut:  + . 

2 In the Excel Reports dialog set the table properties: 

Report tab 

Master Excel file: This field shows the path filename of the Excel file to link to all tables in 
the display. Use the 'Browse' button to search for a file. Before running a report you should 
devise a spreadsheet that matches your expected data output and use this as linked Excel 
file. 

Lap filter: Use this field to restrict the output of the Excel Report as required. 

Table Name: Enter a name for the table is required. 

Target Excel File: To change the target to an additional Excel file, click <master>, and then 

click the browse button  to browse for a file. 

Starting Cell: Displays the sheet and cell of the target Excel file that will be the top left cell 
of the current table. To select a starting cell, click the existing cell and then click the Get Cell 

button . The target Excel file opens and with the Select Cell dialog displayed. Select the 
required sheet then click in a cell. The sheet/cell data is entered into the dialog edit box. 
Click OK to return to the Property dialog. 

Automation tab 

Auto Generation: This option enables MS Excel reports to be automatically generated 
when a task has been updated. This setting is disabled by default and is persisted in the 
system registry. 

Content tab 

Table: From the drop-down list select the table to configure 

Type: Select the type of Excel Report to generate. 

Outing headings etc: Select the heading to display in the report. 
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Channel: For every channel displayed set the Telltale and Action required. 

 Use the delete key to remove unwanted channels from the table. They will not be 
deleted from the display but they will not appear in the report. 

1. Click OK. 

To run an Excel report and save it: 

You have two options when generating Excel Reports: 

• Run Table - Runs the table currently highlighted in the display. 

• Run Report - Runs all the tables listed in the Display. 

1 Highlight a table in the Excel Report Display and select:  > Run Report or 
Run Table. 

The Excel file associated with the display opens, and data loads into the worksheet. 

2 In Excel select: File > Save As. Name the report and browse for a location of 
your choosing. 

Using an Excel report as a template 

Excel Report displays can be exported as part of a Worksheet, or as an individual display, 
and subsequently imported at other locations and used as templates. 

To export an Excel Report display: 

1 Make sure that the display is currently open in your Workbook. 

2 Select: File > Export... 

       The Export Workbook Wizard opens 

3 Follow the Export Wizard's instructions. 

You can choose to export the entire Worksheet that the display is on, or the 
display only. 

4 Click Finish. 



 

 

To Import a Worksheet 

1 Open the Workbook that you want to import the display into. 

2 Select: File > Import... 

The Import Workbook Wizard opens. 

3 Follow the Wizard's instructions. 

4 Click Finish. 

A Worksheet is opened containing the imported display. Use this to generate 
new Excel Reports. 

To run a macro in Excel: 

When a Report or Table is run, a macro is initiated before data is downloaded to Excel and 
after data download is complete. The macros are available for programming in the Visual 
Basic Editor of Excel, to your own requirements. If you do not activate the macros they are 
ignored. 

Note: The macros must be created in a book module and not a worksheet. 

1 In Excel select: Tools > Macro > Visual Basic Editor (Shortcut  + ) 

2 In the VBA Project window select: > Insert > Module. 

3 To create a macro to run before the data is downloaded, enter the following in 
the module window: 

Public Sub OnDataStart () 

4 To create a macro to run at the end of the data download - enter the following in 
the module window: 

Public Sub OnDataEnd () 

5 Press Enter 

6 Enter your macro code and save the module 

7 Quit the Visual Basic Editor 

8 The macros will run on the Run Table and Run Report commands. 
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Note: An Excel Report display is linked to an Excel file, which is the template for the Tables in the 
display. The Macros must be saved in this File. If you link the display to a different Excel file, the 
macros must be recreated in the new file. Alternatively, copy the Excel file containing the macros 
and edit it as required. 

Data format in Excel 

If the data format in your Excel Reports is not as expected, you may need to change the 
Excel file cell format. For instance, if your output data is in times, you may need to change 
the cell format to display times correctly, e.g. 00:01:51. To change cell format right click in 
any cell in the Excel file and select:  Format Cells.... Choose the appropriate format from 
the 'Category:' list. 

Example: 

To change time format to display thousandths 

1 Select the cells to format. 

2 Select:  > Format Cells… 

3 In the Category window select ‘Custom’. 

4 In the Type window scroll down and select the format: mm:ss:00 so that it 
appears in the Type field above it. 

5 In the Type field change the format to: mm:ss:000 

6 Click ‘OK’. 

 

 



 

 

Excel report properties 

To open the Excel Reports Properties dialog, highlight a table and select:  > Properties; 
or double-click the table. 

The commands on the Report tab are global, affecting all tables in report. The commands on 
the Content tab are specific to the table highlighted in the Excel Report display. 

Note: Split reports rely on circuit map data, and have no configuration options available on the 
Table tab.  

Report tab 

 

Master Excel File: This field shows the path and filename of the Excel file linked to all 
tables in the Excel Report control. Data is output to this destination. Use the 'Browse' button 
to search for a file. Before creating an Excel Report you should devise a spreadsheet that 
corresponds to your expected data output. 

Lap Filter: Use this field to restrict the output of the Excel Report as required. 
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Tables 

This window displays the tables that have been created for this display. 

Name: Double-click the default name to enter a new one. 

Target Excel file: Displays <master> if the target Excel file is the master (defined above). 
To change the target to an additional Excel file, click <master>, and then click the browse 

button to browse for a file. 

Starting cell: Displays the sheet and cell of the target Excel file that will be the top left cell 
of the current table. To select a starting cell, click the existing cell and then click the get cell 

button . The target Excel file opens and with the Select Cell dialog displayed. Select the 
required sheet then click in a cell. The sheet/cell data is entered into the dialog edit box. 
Click OK to return to the Property dialog. 

Did you know: You can copy and paste a cell reference from an open Excel file to the Excel 
Reports Property dialog. In the Excel file select a cell and press Ctrl + C. In the Property dialog, 
highlight the required table and press Ctrl + E. 

Note: For the Get Cell operation to work correctly, Excel macros should be enabled. You must 
select a cell for each table in the report; in this way you control the layout of the report. 

  Add or Delete tables to/from the report. 
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Automation tab 

 

Auto Generation: This option enables MS Excel reports to be automatically generated 
when a task has been updated. This setting is disabled by default and is persisted in the 
system registry. 

Content tab 
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Table: Drop down list of tables created in the Report tab. The Properties of the selected 
table are displayed on the property page. 

Type: Select the type of Excel Report to generate, i.e. Lap, Outing, Soft Split, Hard Split, 
Event, Between Events. 

Start / End (Between Event Reports Only): Select the Start and End Events for the report. 
The drop-down list displays the Events added to the display in the Selection Explorer. 

Outing/Channel headings: controls the visibility of headings in the report for the table 
selected. This option is not applicable to Soft/Hard split reports and Event reports. 

Repetitive headings: Uncheck this to hide lap, lap time and telltale headings for all but the 
first outing in the report. 

Channel List: This window shows the channel list for the selected table. Initially, all 
channels that are added to the Excel Report display (in the Selection Explorer) appear in 
this list. A subset of channels can be created for individual tables by deleting unwanted 
channels. Channels deleted from the table will not be deleted from the display, and will be 
available for re-selection. 

 Adds a blank line to the table, ready for a new channel. Use the combo boxes to 
select from a list of channels that have been previously added to the display. For each 
channel, set the Telltale and Action required. 

Note: Use this button to add a special 'Fuel Consumption' channel for which MPG or KPL 
TellTales can be selected. These TellTales cannot be added to any other channels in the list. 

 Deletes a channel from the table. 

 Moves the highlighted channel up or down the list, changing the order in which the 
channels appear in the table. 

Telltale 

The values that can be displayed in the report columns can be calculated from channel 
values using the following functions (or TellTales). 

Min/Max: Shows the maximum and minimum value of the channel for every lap. 
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Mean: Shows the mean value of the channel for every lap. 

Standard Deviation: Shows the standard deviation of the channel for every lap. 

Start Value / End Value: Shows the value of the channel at the start and end of every lap. 

Difference: shows the difference in the value of the channel between the start and the end 
of every lap. 

AtSame: shows the channel value at the same point in the lap as the previous channel in 
the report list. 

Kilometer per Liter / Miles per Gallon: shows the fuel consumption within a given region 
(lap, segment or between events). These TellTales can only be added to a Fuel 

Consumption channel. This channel is added in this property dialog using the button. 

[Fuel Consumption] = d (Corrected Distance) / d (Fuel Used) where d gives the 
difference in channel values taken at the boundaries of the corresponding time region. 

Action 

Determines formatting parameters for the report when a change in data is detected. These 
options provide a useful means of highlighting where changes of data occur in the report. 

Blank line on change: Insert a blank line in the report where a data change occurs. 

Show only on change: Inserts data into the column only when a change occurs. Following 
cells in the column remain blank until the next change occurs. 

Note: Telltale and Action properties only apply to outing or lap reports.  

 

Note: In the Table tab, when an 'Event' report type is selected the table property options change. 
For each event, use the combo boxes in the Channel column to select a channel value to report 
when the event occurs. 



 

 

Events 

 

Table: Drop down list of tables created in the Report tab. The Properties of the selected 
table are displayed on the property page. 

Type: Select the type of Excel Report to generate, i.e. Lap, Outing, Soft Split, Hard Split, 
Event, Between Events. 

Show events description: includes the description in the data output. 

V1.x compatibility: Event data output can be configured to generate Pi Toolbox V1.x Event 
Report layouts. This differs slightly from post V2 versions, in that all event occurrences are 
listed for all associated channels. 

Events: This window shows the event list for the selected table. Initially, all events that are 
added to the Excel Report display (in the Selection Explorer) appear in this list. A subset of 
events can be created for individual tables by clicking to clear unwanted events. Events 
deleted from the table will not be deleted from the display, and will be available for re-
selection. 

Channels: This window shows the channel list for the selected table. Check the channels 
whose values you want to record when the events occur. 

Moves the highlighted event or channel up or down the list; changing the order in which 
events appear in the table. 

Note: For more information about customizing the appearance of the display, see page 258 
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Tabular Outing reports (TOR) 

Tabular Outing Reports (TOR) are used to display channel values in a list view on the 
Worksheet, lap by lap, over an entire outing. They are typically used for analyzing trends 
during an outing; for example, engine temperatures or pressures. 

All channels in the report can have Telltale indicators (e.g. max value in the lap, mean value 
in the lap etc.) set individually. 

 

The display can work in both historic data and real-time modes: 

• In real-time mode the report updates continuously, with the values of the last full 
lap always being in view. The scroll bars are disabled until Pause mode is 
entered. 

• Historic mode displays data for the complete outing, regardless of the current 
data selection. Scroll bars are displayed if necessary and are active. 
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Features 

Vertical or Horizontal layout 

The report can be configured to show channel data in horizontal rows or vertical columns. In 
vertical mode the complete channel name may not be displayed as column width is fixed. A 
ToolTip is provided showing the full channel name. 

Exporting to Excel 

Selecting Export to Excel from the current menu will open an MS Excel session (if one is not 
already running) and export the full report to a new worksheet in the current Excel workbook. 
The layout in Excel will match that of the Tabular Outing Report (TOR). 

In-place editing 

A channel's Telltale can be edited directly in the display. Double-clicking a Telltale cell, or 
highlighting a channel and pressing Enter, will produce a drop-down list of TellTales. The 
required Telltale is located using the arrow keys and selected using the enter key. 

Lap Order 

Reports can be configured to display laps in ascending or descending order. 

Channel order 

The channel order can be changed by dragging a highlighted channel to a new location in 
the list. This can also be achieved in the Properties dialog. 

Real-time Pause mode 

Activating Pause mode in Real-time will inhibit further data from reaching the display. The 
scroll bar will become active allowing you to scroll through previous laps in the outing. When 
Pause mode is de-activated, the buffered data will be downloaded to the report and updating 
in real-time will continue. 
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Duplicate channels 

Highlighting a channel and pressing ‘D’ will duplicate the channel and Telltale pair. This 
feature allows users to look at two or more different TellTales for the same channel. 

Active channel 

The channel highlighted in the report becomes the active channel. The Properties Explorer 
displays the properties of the new active channel. 

Connected to a single outing 

The display shows data for a single outing. In tasks containing multiple outings the displayed 
outing can be changed by connecting to the required outing. 

Copy data as text 

The display can be copied and pasted as text into an Excel spreadsheet. 

To copy a display, first select the text, then press CTRL + SHIFT + C. 

To paste it into a spreadsheet, use CTRL +V. 

Real-time features and 
behavior 

Tabular Outing Reports can be used to display historic and real-time outings. 

Pause characteristics 
• Entering Pause mode inhibits further data from reaching the display. 

• The scroll bar becomes active, allowing scrolling through previous laps from the 
outing. 

• When pause mode is cancelled, the buffered data will be downloaded to the 
report and continuous updating will resume. 



 

 

Behavior 

A new lap column will only be added after an indication that a lap has been completed is 
received, e.g. an end of lap beacon. Data in the new column will be continuously updated 
until the lap is completed. 

Once sufficient laps have been received to fill the display a scroll bar is added. This will 
remain disabled until Pause mode is entered.  

The newest lap will always be displayed on left or right depending on the selected lap or 
(ascending or descending). 

If the application is configured to allow events from hidden regions to be viewed, the regions 
will form empty columns with the associated text for the region displayed in the lap number 
cell. 

Using Tabular Outing 
reports 

Create a Tabular Outing report 

1 Select: Insert > Display > Tabular Outing Report or use the Insert Display 
toolbar button. 

An empty report display is added to the Worksheet. 

2 Select: Data > Connect and select the required task 

3 With the report display in focus, go to the Selection Explorer (Alt + 2) and select 
the channels required for the report. 

The display is populated by data from the selected channels. Maximum values are 
shown by default. 

Note: All laps in the outing are reported on, regardless of the current data selection. 

4 In the report display select:  > Properties. 

5 The Tabular Outing Report Properties dialog opens. 
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6 Select the Data tab. 

7 For each channel double-click the current telltale and select one from a drop-
down list. 

8 Click OK to return to the display. 

Change the connected outing 

When a Tabular Outing report is added to a Worksheet and connected to a Task, the report 
is initially connect to the first outing added to the Task. 

• Highlight the appropriate outing and select:  > Connect. 

The outing icon will change from this:  to this:  to show that it has been selected. 

Displaying Real-time data 

For more information on displaying real-time data, see Setting up a Real-time display on 
page 241. 



 

 

Tabular Outing report 
properties 

Layout 

 

Show lap time: Check to show lap times beneath the lap number. 

Show grid: Check to show grid lines on the display 

Horizontal/vertical: Select the required orientation for the display. 

Note: In vertical orientation the complete channel name may not be displayed as column width is 
fixed. A ToolTip is provided showing the full channel name. 

Display in/out lap: Check these to include in lap and out lap data columns. These 
checkboxes will be disabled during real-time operation. 
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Data 

 

Channel: The channels list shows the channels added to the display in the Selection 
Explorer. 

Function: For each channel set a function by double-clicking 'max' (default function) to 
display a drop-down list. 

Ascending/Descending: Select the order in which incoming laps are displayed. 

 Duplicates the highlighted channel. This allows users to set two or more different 
TellTales for the same channel. 

Deletes the highlighted channel. Deleting a channel here removes it from the list of 
channels selected for the display. 

 Moves the highlighted channel up or down the list; changing the order in which              
channels appear in the table.  

Note: For information about customizing the appearance of the display, see page 258 
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TOR Telltale definitions 

Lap max/lap min (max/min): The maximum or minimum data value that occurs during the 
lap. 

Lap difference (diff): Lap max minus lap min. 

Lap start (start): The data value taken from the EOL burst data from the previous lap if 
available. Otherwise interpolated to the start of lap from other data available. 

Lap end (end): Initially displayed as an interpolated data value and subsequently updated 
from the EOL burst data if available. 

Lap mean (mean): Shows the mean value of the channel for every lap. 

Standard deviation (stddev): Shows the standard deviation of the channel for every lap. 



 

 

TOR Shortcuts 

Shortcut Description 

 +  +  Copies the selected data as text. 

 +  

Opens the Properties dialog. 

 +   Moves the focus to the first/last row of data. 

 +  In Historic and Paused mode, scrolls one lap forward. 

  In Historic and Paused mode, goes to the first/last lap. 

  
In Historic and Paused mode, scrolls the display. 

 Duplicates the selected channel. 

 +   Moves a highlighted channel up or down the list. 

 Toggles local pause mode. 
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Video displays  

This display enables videos to be viewed, synchronized with the Task Cursor time on 
displays sharing the same task. As the video is scrolled, cursor movements are made 
simultaneously in all displays connected to the same task. To display a video, an MPEG 
must first be associated with an outing. Video display commands are all accessed from 
context menus.  

Note: For correct operation of Video displays make sure that Pi Datasets are not write protected. 

The number of laps selected from the outing determines the start and end points of the 
video in the display. Although the video may cover a complete outing, the user can only 
scroll from the beginning of the first lap selected, to the end of the last. 

The data selection may go beyond the extent of the video. If the task cursor in a connected 
display is in a data region not covered, the video slider will rest at the beginning or end of 
the slider bar. The video display will be static until the task cursor is moved into a data 
region covered by the MPEG. 

Note: To successfully load the MPEG file there must be at least one beacon on the audio track, 
and at least one end of lap event. If the beacons match the outing currently loaded, the MPEG 
frame numbers will synchronize to the task cursor time. If the beacons do not match, the video is 
synchronized via a single point, i.e. the first beacon pulse to the first end of lap event. The user 
can then define a time offset to manually align the beacon times. 
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Shortcuts 

  Moves to the previous/next frame in the MPEG. 

  Move to the first/last frame in the MPEG within the limits of the data 
selection. 

  
Fast forward/Fast reverse. 

 Play/Pause. 

 Enter/leave Offset mode. 

 +  
Opens Video Properties dialog. 

Features 

Keyboard or mouse play and pause controls 

Start and stop the video by simply clicking the display or pressing the space bar. 

Beacon times and offsets 

If an outing with an associated MPEG file is highlighted in the Selections Explorer, beacon 
pulse times and matching end of lap times are shown in the Properties pane. These times 
are used as synchronization points, to synchronize the video with the Task Cursor. If the 
MPEG file did not associate with the outing, the video and Task Cursor are synchronized via 
a single pair of beacon pulse / end of lap event, whose times are displayed. 

User defined offsets 

The user can manually adjust this synchronization by defining an offset. In Offset mode, the 
link between the cursor and video is broken. The Video will remain static while the slider can 
be used to move the Task cursor through the data selection, to re-align the video with a new 
position within the data selection. Exiting Offset mode reconnects the video with the task 
cursor. 



 

 

Resizing  

Video displays can be resized like any other Pi Toolbox display. The user can force the 
video to maintain its original aspect ratio (at recording) regardless of the display aspect ratio. 

Audible beacon pulses  

When the mute option is deselected in the Properties dialog, audible beacon pulses are 
available to the PC sound card. 

Loading MPEGs 

The following procedure assumes that you have created a task and loaded an outing that 
has a corresponding MPEG video file. 

1 Add a new Video display to the Worksheet and connect it to the appropriate 
task. This is the same as adding any other type of display. 

2 With the Video display in focus, select:  +  to go to the Selection Explorer. 

A camera icon is displayed beneath the outing name for every camera used on the 
outing. 

3 Highlight the required camera and select:  > Load Video. 

4 Use the Open dialog to browse for an MPEG to load. 

The dialog box has an active preview panel with video controls to aid MPEG selection. 

5 Double-click on the required MPEG to load the video. 
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MPEG file association 

When the load operation has completed, an attempt is made to synchronize the video with 
Task Cursor time. This is achieved by trying to associate each beacon pulse found in the 
MPEG file with a corresponding end of lap event from the Outing. If no MPEG beacon 
pulses are found, the load operation will fail and the MPEG cannot be selected for the video 
display. 

Association is successful if a sequence of end of lap events is found in the outing whose 
event-event time separation matches the beacon-beacon time separation in the sequence of 
MPEG beacons i.e. both the end of lap events and the MPEG beacons define a matching 
sequence of lap durations. A +/- 0.5% tolerance is allowed in the matching algorithm, to 
allow for possible differences in clock speed between the hardware used to generate the two 
data sets.  

If the association succeeds, the MPEG file is loaded into the outing and this icon  is 
shown. The times for each associated end of lap event / MPEG beacon are shown in the 

Selections Explorer properties pane. With the MPEG file highlighted, select:  > Select to 
display the video. When the video is run, video time is synchronized with Task Cursor time 
via each of these end of lap event / MPEG beacon pairs. 

If MPEG beacon pulses are found but they do not match the outing End of Lap event times, 
the MPEG file is loaded into the outing and this icon  is shown, to indicate that a match 
has not been made. In this case the video is synchronized with Task Cursor time by 
associating the first beacon pulse found in the MPEG file with the first end of lap event in the 
Outing. The times for this end of lap event / MPEG beacon are shown in the Selections 
Explorer properties pane, and the MPEG can then be selected for the video display. 

Note: The association process time varies according to the size of the MPEG file. 
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User defined offsets 

The synchronization between video time and Task Cursor time which results from the above 
association process can be manually adjusted if required, by setting a user defined offset. 
The Task Cursor time that corresponds to the current video frame can be offset to a new 
value selected by the user. This is achieved by entering Offset Mode and, with the video 
disconnected from the task cursor, using the slider bar to re-position the Task Cursor. 

To set an offset: 

1 In the display select:  > Offset Mode to enter Offset mode. 

The video is stopped at the current frame and disconnected from the task cursor. An 
offset field showing the current offset is displayed next to the slider bar, which itself is 
re-mapped to show the Task Cursor position within the current data selection.  

2 Move the Task Cursor to a point within the data selection, which is to be 
synchronized with the current video frame.  

This is achieved either by moving the slider bar on the video display, or by 
moving the Task Cursor itself on any other display sharing the same task. 

3 Select:  > Offset Mode again to exit Offset mode. 

Note: When an offset is defined it will remain in effect until it is deleted by selecting:  > Delete 
Offset. When this is selected, the synchronization will return to that made when the video was 
initially loaded. 
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Properties 

Layout 

 

Show Slider: Display the slider bar at the bottom of the video. This is used to scroll through 
the video within the limits of the current data selection or, if it is shorter that the data 
selection, the length of the MPEG. 

Original Aspect Ratio: The video is shown at the aspect ratio that it was recorded. Areas of 
black may show at the edges of the video when the aspect ratio of the display window differs 
from that of the video. Resizing the display window can minimize this.  

When deselected, the video stretches to fill the display window. 
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Playback 

 

Mute: When selected the beacon pulses, stored in the MPEG sound track, are inaudible. 

Note: For more information about customizing the appearance of the display, see page 258 
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Bit Indicator displays 

The Bit Indicator display enables the engineer to examine system status channels looking 
for error conditions to occur. A typical example would be where the health status channel, 
comprised of a 32-bit word, has Bits 0, 1, 2, 5 and 7 assigned to the errors identified in the 
hydraulic differential system. 
 

Error condition Bit 

Pressure transducer - peak value exceeded 0 

Pressure transducer - open circuit 1 

Pressure transducer - high noise presence 2 

Moog valve - coil failure 5 

System Hydraulic Pressure - low 7 

Typically when an error condition occurs i.e. Bit value changes from 0 to 1, the indicator for 
that bit will change color. 

The display is in the form of a grid. Bits are mapped to the cells of the grid and the cell's 
color is dependant upon the status of the bit. 

Bit-fields 

Status channels can have one or more bit-fields pre-defined, allowing different values to be 
displayed for each field. For example, a 'Pressure Transducer Status' field could have the 
values 'Enabled', 'Disabled', 'Failed'. 

Bit-field definitions are contained in outing datasets (real-time or historic) making it 
convenient for engineers to use status channels in displays and math channels with little 
setting up. When a status channel is added to a Bit Indicator display or included in a math 
channel, it automatically conforms to its bit field definition as long as a definition exists in the 
outing. 
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About Bit-fields 

Bit-field definitions, contained in historic and real-time outing datasets, define the number of 
fields that a status channel can have and how many possible values each field has, along 
with each field value's associated color and text. 

 

In the above example the Traction Control Mode channel has several fields, three of which 
are visible: Status, Save Settings and Driver Settings. The corresponding Bits tab of the 
Properties dialog shows the possible values of each field. For example the Status field has 
three possible values: default (no title), 'Disabled' and 'Enabled'. 

When a channel (with an associated bit-field definition) is added to a Bit Indicator, the 
display for that channel is automatically configured to the bit-field definition; the 'Use bit-
fields' option is checked by default. 

Checkboxes adjacent to the Bit-field names are used to enable or disable individual fields. 
Disable fields will not appear on the display. 

Note: Users can uncheck 'Use Bit-fields' in the Properties dialog so that the channel ignores the 
definition and reverts to individual bit behavior. 

 

Note: If no bit-field definitions are present within the dataset, then the 'Use Bit-field' check box will 
be disabled, and behavior will revert to normal channel bits display. 
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Editing 

Field background color and text can be edited if required. 

Definitions have a global context across the outing. Each instance of a channel, with a bit-
field definition, used in a Bit Indicator display will be configured according to the definition. 
Changes made to background color and field text are applied on a per display basis. 

Note: If an outing is updated with a new bit-field definition, local field properties set up in Bit 
Indicators will be lost. 

Bit field definition file format 

The file format used is XML, with Pi specific XML elements employed to cater for the bit-field 
definitions. Bit-Field definitions can come from several application sources. They all need to 
be combined before they are converted into a blob (to be added to the target PDS file), since 
each application will produce channels that are logged and stored in a single PDS file. 

The definitions will be specified on a per application basis, as seen below. Usually there will 
be one XML file per application, but it is also permissible to have several applications 
defined within one XML file. 

Note: The tag name attribute of the <channel> element must be unique across all applications. 



 

 

 377 

 

For example: 

 
<status_def version=”1.00”> 
 <application name=”Gearbox Control” id=”48dbefa1” > 

 <channel tagname=”GB_Status” colour=”0xff0000”> 
  <field name=”Heartbeat” abbr=”Htbt” bitmask=”0x0100”> 
   <entry value=”0x0000” text=”Off” colour=”0xff0000” /> 
   <entry value=”0x0100” text=”On” colour=”0x00ff00” /> 
  </field> 
  <field name=”Mode” abbr=”Md” bitmask=”0x0003”> 
   <entry value=”0x0000” text=”Disabled” colour=”0xff0000” /> 
   <entry value=”0x0001” text=”Enabled” colour=”0x00ff00” /> 
   <entry value=”0x0002” text=”Failed” colour=”0xff0000” /> 
   <default text=”Undefined” colour=”0xa1a1a1” /> 
  </field> 
 </channel> 
 <channel tagname=”GB_Selection” color=”0x005566”> 
  <field bitmask=”0xffff”> 
  <entry value=”0x0000” text=”R” /> 
  <entry value=”0x0001” text=”1” /> 
  <entry value=”0x0002” text=”2” /> 
  <entry value=”0x0003” text=”3” /> 
  <entry value=”0x0004” text=”4” /> 
  <entry value=”0x0005” text=”5” /> 
  <entry value=”0x0006” text=”6” /> 
  <default text=”-“ /> 
  </field> 
 </channel> 
</application> 
</status_def> 
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The above example defines two fields in the first status channel. The first is a heartbeat that 
changes between the two states to indicate that the application is still running. The second 
indicates the state of the application: 

1 Disabled by the user. 

2 Enabled by the user and functioning. 

3 Enabled by the user but there is an error and the application has been disabled 
automatically (e.g. an input sensor is out of range). 

Note: The second field contains a default text string that should be displayed if the value does 
not matching any of the above. 

The second status channel is a special case where the channel contains only one, unnamed 
sub-field.  The gearbox position channel should therefore be treated as a normal channel 
but with the ability for Toolbox displays to show the text associated with the specified values. 

XML elements 

In addition to the XML elements required to describe the bit-field definitions, extra elements 
are needed to provide such data as version information, build information and timestamp 
etc. 

Example strings 

For examples of XML strings, see Appendix E, XML Example strings on page 479. 



 

 

Bit field Maintenance 
tool 

Use the maintenance tool to import Bit-field definitions from XML files, for writing to Pi 
Datasets. Bit-field definitions define the number of fields that a status channel can have and 
how many possible values each field contains. See the example below to see how channels 
with Bit-fields defined can be used in Bit Indicators. 

 

The Maintenance Tool can be operated in two modes: Using the Bit-field Maintenance Tool 
dialog box, or using command line parameters through the standard console. 

The command line interface is intended to be used when automation of the tool is required. 
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Command line operation 

The Bit field maintenance tool can be accessed from the command prompt; this is so that 
the operation can be included in batch files as an automated process. 

To access the Bit-field Maintenance Tool from the command prompt: 

1 Open a Command line session. 

2 Change the displayed directory to the following: C:\Program Files\Common 
Files\Pi Research\Pi Bitfields. 

3 At the prompt, type maintenancetoolcui.exe. 

The Maintenance tool will open and a list of options will be displayed. 

 

4 Enter a location for the XML source file, an output directory and any of the 
options that you want to include. For example: 

Maintenancetoolcui.exe <source file> <output directory> <options>  

Maintenancetoolcui.exe c:test.xml c:testdirectory /e /o 

In the above example, c:test.xml is the source file. C:testdirectory is the output directory 
and options /e, Suppress confirmation of errors and /o, Overwrite bit field definitions 
without prompting are applied. 

5 The application will display status messages as it carries out the process. 
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Options 

Name Definition 

/E Suppress prompting to confirm errors. 

/M Merge definitions. If this parameter is not supplied then the definitions 
in the destination files will be over written. 

/O Suppress prompting to confirm overwriting existing definitions. 

/S Recursive. This option is only valid if the destination contains a folder. If 
the destination is not a folder and this parameter is supplied then an 
error will occur and the application will quit. 



 

 

Dialog box operation 

The Bit-field Maintenance Tool dialog is intended for single import operations. You access 
the Bit field Maintenance tool from the Start menu. 

Click Start > All Programs > Pi Research > Pi Tools > Pi Bit Field Definitions Maintenance. 

 

 

Source: The source files are XML files. Enter the path/name of the source file or use the 
browse button. 

Target: Target files are Pi Datasets (.pds files). Enter the path/name of the target file or use 
the browse button. 

Browse and update file(s): With this option selected you can import definitions into a single 
pds file, or a selection of files. Clicking the browse button (with this option) displays a multi-
selection File Open dialog where single or multiple files can be selected.  

Browse and update folders: with this option selected you can import definitions to into 
every pds file contained in a folder.  
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Include sub-folders: Checking this will include in the import, any sub-folders that may 
contain .pds files. 

Options 

Merge: with the Merge option selected, the Bit-field definitions from the source files will be 
added to the definitions contained in the target files. 

Overwrite: with the Overwrite option selected, all Bit-field definitions in the target files will be 
removed before the definitions from the source files are added. 

Prompt on overwrite: Check this to display a prompt dialog if destination files contain 
definitions that will be removed. 

Pause on Error: If an error occurs either reading definitions from a source file or writing 
them to a target file, then a continue/stop prompt will be displayed. 

Shortcuts 

 +  
Opens the Bit Indicator Properties dialog. 

Features 

Bit selection 

Select bits to display from any channel, choose true/false colors and edit the caption text. 

Outing selection 

The display can be assigned to a single outing only. In a task containing multiple outings, 
you can select which one to display by highlighting the outing and selecting:  > Connect.  



 

 

Display resizing 

The display can be resized vertically and horizontally. The display of the status channel can 
be either by row or by column. When resizing, the bits from each channel will always remain 
within their assigned column. 

Layout options 

These examples illustrate two options for bit caption placement. The display on the left has 
bit captions inside the indicator. You can also place the captions outside (right, left, above, 
below) as shown on the display on the right. Placement is defined in the Properties dialog. 

    

Note: both of these displays are in a vertical format. Channels can also be laid out horizontally. 

To create a bit indicator: 

1 Using the Insert Display toolbar buttons, place a Bit Indicator display on the 
Worksheet and connect it to a task. 

2 With the Bit Indicator in focus, go to the Selections Explorer and select the 
channels to display. 

Note: The 'Show Bit Captions' default is 'Yes'. However, they may not show initially if the 
space allocated to the display on the Worksheet is too small. Also, the display will have 32 
bits enabled for every channel selected. Deselect unwanted bits in the Properties dialog. 

3 Open the Properties dialog. 
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4 Select the 'Bits' tab and highlight a channel in the channel list on the left of the 
dialog. 

5 Uncheck any unwanted bits. Repeat this for all channels selected. 

Tip: To disable a group of bits, click on the first bit then shift click the last bit. With the group 
highlighted, click on the checkbox of any of the bits - all bits selected will become disabled. 
You can also use this method with multiple channels selected. 

6 Define other properties as required. 

7 Click 'OK'. 

Properties 

Layout 

 

 

 

 

 

 

 

 

 

 

Show Channel Headers: Selects various elements to show on the display. The preview  
window aids visualization of the layout. 



 

 

View 

 

 

 

 

 

 

 

 

 

Channels Orientation: Determines the format of the display grid - horizontal or vertical. 

Bit Caption Placement: Determines where the bit caption is placed in relation to the 
channel indicator. 
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Bits (Normal view) 

 

Channel list: Displays all the channels selected for the display. 

Use the up/down arrows to move the highlighted channel up or down the list. This will 
change the column order in the display. 

Bit control panel: Shows the bit status for the channel highlighted in the channel list. 

Uncheck the bits that you do not want to appear on the display. 

All bit titles are editable. Double-click the bit text and enter the caption that you want to 
appear on the display. Double-click a color panel and select a color from the color palette. 

Use Bit fields: When checked, forces channels in the channel list to conform to their 
associated Bit Field Definitions in the outing data (if they are present). If the highlighted 
channel has an associated definition, the configuration of the Bit Control Panel changes 

Channel Name/Fixed: Defines the column header text for the highlighted channel. To 
define a header other than the channel name, select 'Fixed' and enter the new header in the 
adjacent field. 
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Bits (using Bit-field definitions) 

 

Channel list: Displays all the channels selected for the display. 

Use the up/down arrows to move the highlighted channel up or down the list. This will 
change the column order in the display when the Apply button is clicked. 

Bit Control Panel: The number of fields is defined in the Bit Field Definition. This example 
shows the Traction Control Mode channel (Pi Datasets in Sample Data folder). The channel 
has several fields, three of which are visible here: Status, Save Settings and Driver Change. 
The Field name and abbreviation can be edited. The abbreviation is displayed if the column 
width of the display is too small for the complete name. Each field has a pre-defined number 
of values (Status has three in this example: default (no title), Disabled and Enabled). The 
value names and background colors can be edited if required. 

The example shows how the Traction Control Mode channel appears. 
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Enable: Use this checkbox to enable/disable individual fields of the selected channel. 

Use bit-fields: When checked, forces channels in the channel list to conform to their 
associated Bit Field Definitions in the outing data (if they are present). 

Note: If no bit-field definitions are present within the dataset, then the 'Use Bit-field' check box will 
be disabled, and behavior will revert to normal channel bits display. 

Channel Name/Fixed: Defines the column header text for the highlighted channel. To 
define a header other than the channel name, select 'Fixed' and enter the new header in the 
adjacent field. 

Note: For information on customizing the appearance of the display, see page 258 



 

 

Channel displays 

 

The Channel display enables channel names, values and units to be displayed in a list view 
on the Worksheet. The display can work in both historic data and real-time modes and is 
generally used for viewing channel values for car parameters in real-time. 

• In real-time mode, the values of the last data sample of the channel are 
displayed. 

• In historic mode, channel values are based on the position of the task cursor. 

The default layout of the Channel display is made up of three columns: channel name, value 
and units. The display can be configured to display a combination of any of the 3 columns. 
The default channel color is indicated by a colored square adjacent to the channel name. 

Channel alarms can also be shown in the channel display. When the channel value moves 
outside of the specified minimum or maximum value, it will be displayed with a red 
background. The Alarm value can be set globally or locally. Local alarms can be useful if 
you are watching a specific channel for a change in its status, a differential channel for 
example. 

The principle of connecting tasks to a display and selecting channels for viewing, as in Time 
and Distance charts, applies to Channel displays. 

Note: Because Channel displays are primarily real-time displays; only Channels from a single 
connected data selection are displayed. 
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Shortcuts 

 +  

 +  

Hide/Show the column headers 

Toggle table header visibility on/off 

 +  

 

 

Opens Channel Display Properties dialog. 

 

Enable the display in Pi Remote Toolbox 

Enable Pi Remote Toolbox 

Features 

Column width 

Change column widths by dragging the column header border. Double click the column 
header for a ‘Best Fit’. 

Number of columns 

Define the columns to display: value only; value and name or units; or value, name and 
units. The display can be configured to display a combination of any of the 3 columns. 

Channel order 

Move channels up or down the order in the channel display.  

Show header/grid 

Show or hide the channel headers and grid lines. 

Channel color indicator 

If the channel name sub-column is displayed, the channel’s color (set in Properties Explorer) 
is indicated by a colored square. 
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Data point indicator 

In historic mode when the cursor is on a data point, the value field will display the data point 
indicator: . 

Channel alarms 

Channel alarms can be shown in the channel display. When the channel value moves 
outside of the specified minimum or maximum value, it will be displayed with a red 
background. 

The Alarm value can be set globally or locally. Local alarms can be useful if you are 
watching a specific channel for a change in its status, a differential channel for example. 

Pi Remote toolbox 

Information that is currently being displayed in the Channel display can be shown on a Palm 
PDA running Pi Remote Toolbox. For more information on Pi Remote Toolbox, see page 
300 

Working with Channel 
displays 

Channel Displays are created in the same way as other types of display. The display must 
be connected to a task that contains an outing, and have channels selected channels. The 
channels selected will appear in the Channel Display. 

To add channels to the display: 

1 With the Channel display in focus go to the Selection Explorer. 

2 In the upper pane double-click the channel you want to add. 

The channel appears in the Selected Channels list of the explorer and is added to the 
bottom of Channel Display list. 



 

 

To change the channel position in the channel display 

1 Select:  > Properties. 

The Channel Properties dialog opens. 

2 Click the Channels Order tab. 

3 In the Channels list select the channel to move. 

4 Use the up/down arrows to move the channel up or down the list. 

5 Click OK. 

Using Channel Alarms 

Alarms can be configured and displayed in the Channel display and Summary display. 

To use the alarm function, you must do the following: 

• Enable the Alarm function. You can do this in either the Channel display or 
Summary display properties. 

• Set the Global alarm properties in the Channel Explorer. 

• Add the channel to the display. 

Setting the local alarm properties 

Once the channel is added to the display, you can set local alarm properties for any channel 
in the display. This is a useful feature if you are monitoring a channel closely, as soon as the 
value changes, the alarm will be triggered. 

To set a local alarm 

• Select the alarm in the display,  > Set Thresholds. Keyboard shortcut  

The channel alarm thresholds are now locally set to the current value that is displayed in 
the table. 

Note: You can revert to the global alarm properties at any time. Select the channel in the display, 
in the Channel Explorer click the Display tab,  > Revert. 
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Properties 

Layout 

 

Show Header: Click to clear the Show header check box to disable this feature. 

Show Grid: Click to clear the Show grid check box to disable this feature. 

Channel name: Click to clear the Channel name check box to disable this feature. 

Units: Check to show the units sub-column for the channel selected in the layout window. 

Note: These options are all enabled by default. 

Display Channel alarms: Check this option to enable channel alarms to be displayed within 
the Channel display. 

Note: This option is disabled by default. 
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Channel order 

 

To change the position of a channel in the Channel display, select the channel in the 
Channel Order list and use the up/down arrows to change the order. 

Note: For information about customising the appearance of the display, see page 258 
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Event display 

The Event display, displays events in a list 
view from both real-time and historic data, 
depending on the type of data stream it is 
associated with. 

Selecting an event in the display causes the 
task cursor to be set to the event’s 
timestamp, so that all displays connected to 
the same task can navigate to the event’s 
moment in time. For example a Display can 
be set up to show gearbox parameters such 
as temperatures and pressure, together with 
more general car parameters such as lateral 

acceleration, speed. Then if an event occurs, say, ‘Low Gearbox Oil Pressure’ and is 
selected in the Event display, the cursor positions in the associated displays update, 
allowing engineers to see what other parameter values were at the event time.  

 

Source: This column indicates the logger application which generated the event e.g. DRV. 

Category: This column contains a classification specifying how and where the event has 
been generated. The categories can be: 

Box: Added by Sigma. 

Added: Added by Pi Toolbox. 

Algorithm: Added by an algorithm in Pi Toolbox (a soft event). 

The principle of connecting tasks to a display and selecting channels for viewing, as in Time 
and Distance displays, applies to Event Displays. 
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Shortcuts 

  Changes the event selection in the Display. 

 +   Scroll up and down the events without changing the selection. 

 +   
Scroll the event list one page up or down without changing the 
selection. 

  Go to the start or end of the event list. 

  Toggle the ‘marked’ status of the selected event. 

 +   Move to the next/previous marked event. 

 Toggles the Event group mode. 

  Expands or collapses all groups in the display. 

 +   Expands or collapses all groups in the display. 

 Toggle Paused/Running Modes. 

  
Opens the Event Details dialog for the selected event. Alternatively, 
double-click the event. 

 +  
Opens the Event display Properties dialog. 



 

 

Features 

Soft and hard events 

The Event display shows both Hard events, generated in the data acquisition and control 
system, and Soft events, user-generated (created locally on the PC) from a single real-time 
data stream or an historic outing. 

Current event 

The selected event in the display is the Current Event. The task cursor is set to the current 
event’s timestamp. When the current event is changed the task cursor is set to the new 
timestamp. If the task cursor in an associated display is set to a time where no events 
occurred, there will be no current event in the display. 

Display modes in real-time 

There are two real-time modes: paused and running. When paused the display behaves as 
if it were connected to historic data. When the display is running and a new event occurs, 
the display auto-scrolls to display the new event. Modes are selected at task level in real-
time.  

Shortcuts:  and . 

Multiple events occurring simultaneously 

If two or more events occur at the same time they are listed alphabetically. By their event set 
name and then by their source. If an event is marked, other events occurring at the same 
time are marked as well. 

Event order 

New events can be added to the top or bottom of the events already listed.  The selection is 
made in the Properties dialog. 

Marked events 

Pressing the space bar can mark events listed in the display. Users can navigate quickly 
from one marked event to the next/previous one using the shortcut:  +  . 
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Event details 

Complete event data from any event listed, can be displayed in the Event Details dialog. 
Double-clicking an event opens the dialog. 

Copy events to Excel 

The Event details displayed can be copies as text into Excel spreadsheets using the Copy 
as Text context menu. 

Priorities 

Priorities allow events to be categorized based on their severity, importance or source. The 
Event display can then be configured to plot events by priority. Priorities are set up in the 
Options dialog. Background and foreground colors can be set to aid recognition in the Event 
display. There a four default priorities, Debug, System, Status, Error. Priority properties can 
be changed if required and further priorities can be added, up to a total of eight. Choosing to 
show/hide selected priorities can therefore filter events. 

Grouping 

Events with the same name can be grouped in the display. Grouping is optional and can be 
switched off if required. The group header displays the name of the Events held in the group 
and how many Events it contains. Groups can be expanded and collapsed using keyboard 
shortcuts. 



 

 

Layout options 

The information shown for listed events is control in the Layout tab of the Properties dialog. 
The event name is always displayed. Time, Source, Category and Message columns can be 
shown or hidden as required. 

Sizing 

Event grouping 

Column widths can be customized by dragging the vertical border between columns. 

Events with the same name can be grouped in the display. Grouping is optional and can be 
switched off if required. The group header displays the name of the Events held in the group 
and how many Events it contains. Groups can be expanded and collapsed using keyboard 
shortcuts. 

 

The order of events in the group can be set to 'Ascending' or 'Descending' in the Properties 
dialog. 

Note: In Group mode group headers are displayed even if there are no instances of the 
corresponding event in the current data selection. 
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Expanding and Collapsing Groups 

Clicking on the expand/collapse icons to the left of the group header expands or collapses 
the group. Or: 

  Expands or collapses the highlighted group header 

 +  And  +  will expand or collapse all groups in the display. 

Event priorities 

Event priorities allow events to be categorized based on their severity, importance or source. 
The Event display can then be configured to plot events by priority. 

Priorities are set up in the Priorities tab of the Options dialog. Background and foreground 
colors can be set to aid recognition in the Event display. There a four default priorities, 
Debug, System, Status, Error. Priority properties (name, colors etc.) can be changed if 
required and further priorities can be added up to a total of eight. 

Priority ID’s 

Priorities are created using IDs which correspond to Event IDs. Events are placed in priority 
categories accordingly. If an event is assigned an ID that does not exist in the priorities 
defined for the workbook, it is placed into the 'other' category. This is unique in that it cannot 
be deleted and it does not have an ID. 
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Working with Event 
displays 

To select events for an Event display: 

1 From the Insert Display list select an Event Display 

An empty Event display is added to the Worksheet. 

2 Connect the display to a task 

3 With the event display in focus go to the Selection explorer. Keyboard Shortcut: 
 +  

When the event display has focus, the Selection explorer only shows the Events tab. 

4 In the Available Events list of the explorer, double-click the events that you want 
to appear in the display. 

The selected events appear in the lower pane of the explorer in the Individual Events 
list, and are listed in the display.  

Note: Alternative methods of selecting events include Shift click and Ctrl click techniques. 

Copy events to Excel 

1 In the Event display select:  > Copy as Text 

2 Open the required Excel spreadsheet 

3 Click on a starting cell and select:  > Paste 

All the events listed in the display are pasted into the spreadsheet as editable text. 
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Marking an Event 

You can mark an event of interest and then scroll through any marked events, saving you 
time in searching for them. 

• Click the area to the left of the event name. 

        A black triangle indicates that the event is marked. 

To navigate marked events use the shortcut:  +   

Create an Event priority 

1 Select: Tools > Options 

2 The Options Dialog opens. 

 

3 Select the Priorities tab. 
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4 Click   

5 A new priority is added to the bottom of the default priorities list. 

6 Edit the various properties of the Priority, i.e. Name, ID, Foreground Color, 
Background Color. 

Note: A maximum of eight priorities (default and custom) is allowed. 
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Assigning Events to a priority 

You can assign either Single or Multiple events to a priority. 

Note: It is assumed that Event priorities have been previously created in the Options dialog. 

1 Go to the Event Properties Explorer. Shortcut: Alt + 4. 

2 Select an Event or multiple events in the upper pane of the explorer. 

        Event properties are displayed in the lower pane. 

3 In the lower pane double-click the 'Priority' property to display a drop-down list of 
available priorities. 

4 Select a priority from the list. 

The selected Event/s will be placed in the new priority and will be displayed in                     
accordance with its properties in an Event display. 

Note: When an Event is assigned a priority, its icon in the upper pane of the Explorer, 
changes to the Foreground and Background colors set for the priority. 



 

 

Filtering Events by Priority 

Displays can be filtered to hide selected Event priorities. This can be done from either the 
Properties dialog or the Context menu. 

Via the Properties dialog: 

1 In the Event display select:  > Properties. 

2 In the Properties dialog select the View tab. 

       The Priorities panel lists the available priorities. 

3 Uncheck the priorities that you wish to filter out of the display. 

Via the Context menu: 

1 In the Event display select:  > View by Priority > Priority 1, Priority 2. Etc. 

2 From the drop-down list of available priorities select or deselect as required. 

There are two further commands in the menu: 

All Priorities: Selects all available priorities for display. 

Toggle: Reverses the current priorities selection. 

Note: When all priorities are selected, the 'Toggle' command can be used to reverse the 
selection, i.e. no priorities selected, and then reselect a single priority. This can save time 
deselecting priorities individually. 

406 Pi Toolbox User Guide 

 



 

 

Properties 

Layout 

 

Show Header: Check to show headers 

Show Grid: Check to show grid lines  

Time: Check to show the Time column. This is the time value at which the event occurred. 

Source: Check to show the Source column. This is where the event was generated, e.g. 
‘BOX’. 

Category: Check to show the Category column. This is the category of the event, e.g. Box, 
Algorithm, etc. 

Message: Check to show the Message column. This is the text string associated with the 
event. 
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View 

 

Sort Order 

Descending/Ascending time: Determines the sort order of events, either within groups or 
as a flat list. 

Grouping 

Group events: When checked the display groups events of the same name under a group 
header. Groups can be expanded and collapsed using keyboard shortcuts. 

Priorities 

Event priorities allow the user to categorize events based on their severity, importance or 
source. The checkboxes related to priorities in this list can be used to show/hide priority 
groups. 

Note: For information about customizing the appearance of the display, see page 258 
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Chart Recorders 

The Chart Recorder provides a 
means of viewing real-time data 
from the car as it proceeds around 
the track. The chart constantly 
updates with the latest data, 
resulting in a scrolling behavior. At 
any time the user can pause the 
display and scroll back to 
investigate a data feature. 

 

The Chart Recorder possesses many of the features associated with Time and Distance 
displays, but is for use only with real-time data. The advantage of using a Chart Recorder is 
the ability to view data over a pre-determined time span, regardless of lap boundaries. 

Tasks, channels and properties functionality is the same as Time and Distance displays. 

Shortcuts 

 Toggles 'Paused' and 'Running' modes. Also click in display to pause. 

 Tile/Overlay Y axis mode. 

 +  
Opens the Chart Recorder Properties dialog. 

In Pause mode many of the shortcuts used in Time and Distance displays apply to Chart 
Recorders. These include:  

 Zoom 

  Hide / flash trace 

  Scroll through channels in display 
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Features 

Modes of operation 

The chart has two modes; 'normal' (continuous update) and 'paused'; pressing 'P' toggles 
these modes. In normal mode the chart is continually updated with the latest data from the 
car. Note that in Normal operation the Data Cursor is not displayed. If the user sees a data 
feature such as a sudden decrease in oil pressure, the chart can be paused. The data can 
then be scrolled back, zoomed and investigated. When normal mode is restarted the cursor 
tracks the latest data point again. 

Data display 

The Chart Recorder displays a single real-time outing. Up to 32 data channels can be 
displayed simultaneously. Channel traces are displayed in the Channel property color. 

Data time span 

The X-axis time span is user defined. When the traces reach the X-axis limit the screen 
clears and the traces grow again from zero. The default time span is 20 seconds. A time 
between 1 and 999 seconds can be set. 

Elapsed time  

This is displayed beneath the X-axis. The time display format can be configured in the 
Options dialog, Displays tab. The options are: seconds, minutes: seconds, hours: minutes: 
seconds. 

Zooming 

Zooming functionality is the same as Time and Distance displays but is only active when the 
chart is in paused mode. 

Channel selection 

As with other displays, channels are selected in the Selection Explorer. The added channel 
will display all the data previously logged for it in the real-time outing. 
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Active Channel selection 

In a display one channel is the 'Active' channel, or the channel in focus. For visual reference 
the Y-axis scale is displayed in the same color as the active channel, and the cursor values 
legend is highlighted. You can scroll through the available channels using the  keys, 
making each in turn the active channel. As with Time and Distance displays the Data Cursor 
follows the active channel trace. See Using Time and Distance Charts for information about 
the Data Cursor. 

Multiple axes 

A separate Y-Axis can be displayed for every channel selected for the Display. The feature 
can be switched on and off individually in the Property Explorer for each channel. When the 
feature is switched off the axes displayed are for the active channel only. When switched on, 
the axes for the active channel are displayed closest to the plot area. Changing the active 
channel re-orders the axes so that the new active channel's axes are nearest to the plot 
area. Displays having multiple data selections show multiple axes for each data selection. 
The shortcut key 'Y' toggles the auxiliary axis for the active channel between left, right and 
off. 

Real-time features and 
behavior 

See Setting up a Real-time display, page 2  to find out how to add a real-time outing. 41

Pause characteristics 
• When Pause mode is entered, data is frozen on the display but it continues to be 

received and buffered. 

• When Pause mode is cancelled, the buffered data is added to the display and 
you are then moved to the latest block of received data. 

Behavior 

The default drawing style “Drawing Using Lines” is recommended in real-time mode as this 
reduces CPU usage. 
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Working with Chart 
recorders 

1 Create and name a Task. 

2 Select:  > Add Outing. 

The Add dialog opens. 

3 Select Telemetry in the navigation bar of the Add dialog. 

4 Open the Telemetry list. 

5 Double-click 'No Real-time Server' or click . 

The Browse for Computer dialog opens. 

6 Browse for a telemetry server and click OK. 

7 The server is added to the Telemetry list. 

8 Click OK. 

9 Go to the Selections Explorer, shortcut:  +  and select the required real-
time channels. 

10 If required open the Chart Recorder Properties dialog, select the data tab, and 
enter a new data time span. 



 

 

Properties 

Layout 

Show cursor values: Displays 
cursor value legends for the selected 
channels. 

Auto size cursor values: 
Calculates the maximum width 
required to show the cursor values / 
channel names in full, and adjusts 
the display area automatically. 

If the cursor value region (top right) 
is resized manually with the splitter 
bar, auto sizing is disabled. 

Show grid: Display a grid to aid data 
visualization. 

 

Data 

Data Time Span: The X-axis time 
span is defined in this field. When 
the traces reach the X-axis limit the 
screen scrolls. The default time span 
is 20 seconds. A time between 1 and 
999 seconds can be set. 
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View 

Cursor Value Base: Sets the display 
mode of cursor values. 

When Hexadecimal or Binary mode is 
selected, the Cursor Value Width 
buttons are enabled. 

Cursor Value Width: The values will 
be limited to 8, 16, or 32 bits when in 
hexadecimal and binary mode. If 
'Auto size cursor values' is checked 
(Layout tab) the cursor value region 
will adjust automatically. 

Y-Axis: Traces can be tiled or 
overlaid. With the display in focus, 
press 'T' to toggle these modes. 

Drawing 

Draw using lines: Data points are 
connected by a line to render a trace 
on the display. 
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Draw using points: Each data value 
is drawn as a separate point. With 
Points selected, the slider is enabled. 
Use this to increase or decrease the 
size of data point rendered on the 
display. 

 

 

Note: For information about customizing the appearance of the display, see page 258 



 

 

Navigator displays 

These provide a quick and easy means of selecting data regions in a display. Like all other 
Pi Toolbox displays, Navigators are connected to a specific task. Navigators create a linear 
representation or navigator bar, for each outing loaded in the task. Each division of the 
navigator bar represents a region of data. A region is defined as a lap. 

Holding the mouse cursor over a region displays a tool tip defining the lap number/region 
and time. Simply click on a region to make all displays sharing the same task display that 
region. 

The illustration below describes each region of the navigator bar. In this example regions 
represent laps. 

 

To select multiple regions: 

To make connected displays span more than one region, click the first region then drag the 
cursor along the navigator bar. Release at the last region to display. 

To select the entire region: 

Double-click the outing indicator:  

Note: When there are multiple navigation bars in the display, shift click to span the same regions 
in all outings. 

To show outing text: 

To display the outing title adjacent to the navigator bar select: 

 > Layout > Show Outing Text. 
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To show hidden regions: 

You can choose whether the navigator bar shows or hides hidden regions at each end of the 
bar, e.g. Warm up and Cool Down laps. 

1 Go to the Task Explorer and select the required outing. 

2 In the Details pane double-click 'Show Hidden Regions' (in the Data category). 

3 Select Yes or No to Show/Hide hidden regions. 

Track the cursor location: 

As you select data points on connected displays, a vertical line on the navigator bar 
indicates the cursor location within the selected region. 

Note: You can select all regions by double-clicking the disc at the left of the navigator bar. 



 

 

PSD Displays (Optional) 

A Power Spectral Density (PSD) display allows the analysis of the power spectral density of 
channel data in both historic and Real-time modes. 

A power spectrum describes the distribution of power contained in a signal over frequency, 
based on a finite set of data. It is useful in a variety of applications, including the detection of 
signals buried in wide-band noise. 

Channel data is displayed graphically as a trace, which represents the magnitude of the 
channels data at a specific frequency range. Frequency values are placed on the X-axis and 
the power magnitude values measured in dB/Hz are on the Y-axis. 

Typically this display type may be used when analyzing car ride performance, which in turn 
is indicative of the mechanical grip characteristics of the car. The input channel will be 
vertical acceleration and the objective would be to minimize the peak value by adjusting 
spring and damper settings. 

The principle of connecting tasks to a display and selecting channels for viewing, as in Time 
and Distance displays, applies to Event Displays. 

Note: Traces can only be displayed in overlaid mode. 

Shortcuts 

  Move to the previous/next frequency value in the active trace. 

 +  Or  Move the cursor backwards/forwards by 5% of the visible frequency 
region. 

 +  Or  Scrolls the zoomed region left or right. 

  Moves to the first/last frequency sample in the active trace. 

 Zoom in. 

 417 

 



 

 

 Zoom out. 

 +  Undo all zooms 

 

Features 

Data display 

Up to 32 data channels can be displayed in overlay mode. Channel properties such as color, 
scale etc can be customized fully as in Time and Distance displays. 

Data cursor 

The Data cursor is displayed on the chart together with data values at the intersection. 
However, because the chart is based in the frequency domain, the cursor is not linked to 
other displays sharing the same task, as with Time and Distance displays, Histograms, etc. 

Data range zooming 

The time region of the X-axis is displayed below the axis and shows the time region in which 
data is calculated. Y default the PSD display’s time region is the whole of the data selection, 
indicated on the display by the legend – TR: [Data Selection]. Using the Zoom tab on the 
Properties dialog, the user can determine a specific time or distance range for the X-axis, 
effectively zooming in on a portion of data. The time region legend shows the specific 
time/distance region selected, for example: TR: [0.00.60.00] or [0.00.4500.00] 

Note: The time/distance range is applied relative to the beginning of each data selection. 

 

Note: In a display one channel is the ‘Active’ channel, or the channel in focus. For visual 
reference the Y-axis scale is displayed in the same color as the active channel and the cursor 
values legend is highlighted. You cab scroll through the available channels using the keys, 
making each in turn the active channel. 

418 Pi Toolbox User Guide 

 



 

 

 419 

 

Active channel 

In a display one channel is the 'Active' channel, or the channel in focus. For visual reference 
the y-axis scale is displayed in the same color as the active channel, and the cursor values 
legend is highlighted. You can scroll through the available channels using the keys, making 
each in turn the active channel. Active channels are persisted when the Workbook is saved 
and subsequently opened, and also persisted when the display is exported. 

Multiple axes 

A separate Y-Axis can be displayed for every channel selected for the Display. The feature 
can be switched on and off individually in the Property Explorer for each channel. When the 
feature is switched off the axes displayed are for the active channel only. When switched on, 
the axes for the active channel are displayed closest to the plot area. Changing the active 
channel re-orders the axes so that the new active channel's axes are nearest to the plot 
area. Displays having multiple data selections show multiple axes for each data selection. 

The shortcut key 'Y' toggles the auxiliary axis for the active channel between left, right and 
off. 

 



 

 

Properties 

Layout 

 

Region Visibility 

Show cursor values: Displays cursor value legends for the selected channels. 

Auto size cursor values: Calculates the maximum width required to show the cursor 
values / channel names in full and adjusts the display area automatically. 

Show grid: Display a grid of equally spaced horizontal and vertical lines to aid data 
visualization. 

Show active Y-axis: Displays the active channel Y-axis closest to the plot region. 
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View 

 

X-Axis graduation: 

• X-Axis graduation can be plotted with a linear scale or with a log 10 scale. 

Y-Axis graduation: 

• Y-Axis graduation can be plotted with a linear scale or with a log 10 scale. 

X and Y-Axis Range 

X-Axis Autoscale: When checked, Autoscale adjusts the X-axis scale to the highest 
frequency data found in all the channels displayed on the PSD Chart, and then adds 5%. 
This ensures that data is displayed on the full width of the PSD chart whilst leaving a 5% 
margin. When not checked, the X-axis scale is determined by the Max and Min field values 
set in Hz. 

Y-Axis Autoscale: When checked, Autoscale adjusts the Y-axis to the highest amplitude of 
data found in all the channels displayed on the PSD Chart. When not checked, the Y-axis 
scale is determined by the Max and Min field values that set the square of the amplitude of 
the wave component at that frequency. 
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Granularity and Precision 

The frequency range of the calculation will depend on the X-axis min-max range, specified 
by the user, or on the frequency spectrum of the channel data, if X-axis is auto scaled. The 
granularity of the frequency range is controlled by the Granularity and the Precision 
properties. 

Granularity: defines the minimum difference (or the step) in the frequency range. 

Frequencies that differ after the Precision decimal symbol are considered equal and their 
powers are accumulated together. 

The power range of the Y-axis will depend on its min-max range, or on the actual channel 
data, if the axis is auto scaled. 

Precision: The granularity of the Power Range is controlled by the Precision property, 
which defines the number of significant decimal symbols in the resulting frequencies and 
powers. 



 

 

Drawing 

 

Lines: Data points are connected by a line to render a trace on the display. 

Points: Each data value is drawn as a separate point. With points selected, the slider is 
enabled. Use this to increase or decrease the size of data point when rendered on the 
display. 
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Zoom 

 

Data selection: When selected, the data plotted is taken from the full extent of the outing 
data. 

Time (sec): When selected the ‘From’ and ‘To’ fields are enabled. Adjust these times so that 
the plotted data is taken from a specific time period, effectively zooming in on that portion of 
data. 

Distance (m): When selected the ‘From’ and ‘To’ fields are enabled. Adjust these distances 
so that the plotted data is taken from a region in the outing that corresponds to a specific 
portion of the track. 

Note: For information about customizing the appearance of the display, see page 258 
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Exporting Data 

Overview 

There are several options available when exporting data: 

Exporting all data – from the Task Explorer 

The Export command is available from the context menu when an outing is highlighted. The 
Data Export Wizard allows the user to export the entire outing dataset for selected channels 
and events. 

Exporting displayed data – from the Time and Distance Display 

Selecting Export > Displayed Data from a Time and Distance display opens the Data 
Export Wizard. This allows the user to export the data that can be seen at the current zoom 
level.  Displayed Data can be exported in MATLAB, ASCII or Pi Dataset. 

• MATLAB format data files support channel data only. Events and lap marker 
data will not be exported. 

• ASCII format data files support channel and event data, but not lap markers. 

• Pi Dataset format data files support channel, event and lap marker data. 

Note: The Data Export Wizard allows the user to edit outing details prior to export. 

Note: Pi Toolbox Lite only supports pds files for the import and export feature. 

Exporting qualifying mode data – From the time and Distance Display 

Qualifying Mode files are binary files used to store Distance - Time pairs, i.e. at distance x 
the time was y. 

Distance values are generated either by using beacons (soft or hard) or by setting a 
distance interval for which a time is required.  
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Data Export wizard 

Channel selection page 

This page lists the channels currently selected for the display. Here the channels to be 
exported are selected. The same applies to the Events Selection page. 

File location page 

Use the browse button to open the Choose File dialog where the export file location is 
selected, as well as the export format. 

Outing page 

Use this page to change outing property details such as Short Comment, Long Comment 
etc. Outing property changes will appear in the Task Explorer when the exported outing is 
imported by other users. 

To make changes, double-click the property and overtype the existing text in the edit box. 

Properties that cannot be changed are 'grayed out'. 

Summary page 

Summarizes the export file information including the channels and events you have selected 
for export. 

Clicking 'Next' in the summary page starts the export process. 

Results page 

The results page indicates whether or not the export has succeeded. When the process is 
complete click the Finish button. You can close the wizard during a long export process if 
required. The export will continue to completion however, you will not be informed of 
successful completion. 
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Time Range selection 

Select the time range of data to export. Choose either the displayed time range or an A to B 
range within the displayed time range. 

Data Rate Selection page 

Select the rate at which data is exported. Choose either the data acquisition rate of the 
source dataset or a fixed rate. If fixed rate is selected, existing data will be interpolated. 

Event Selection page 

This page lists the events currently selected for the display. From the list of available events, 
select which ones are to be exported. This page will not be shown unless events are 
selected for the display. 

Note: If you see the message “No data found for channel X” on the results page, for a channel 
known to have data, repeat the export process. 
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Displayed Data export 
formats 

MATLAB 

MATLAB format data files (.mat) support channel data only. Events and lap marker data will 
not be exported. The following is intended to supplement the user's knowledge of the 
MATLAB environment. 

Note: If the 'System details' category heading of the outing properties has the extension: 
'Externally Written Data', this indicates that the dataset was last modified externally, e.g. in 
MATLAB. 

Channel names 

MATLAB format data, re-imported into Pi Toolbox, will remove spaces from channel names 
and replace them with underscores. 

Adding outing properties in MATLAB 

The following outing properties can be added in MATLAB. These will be subsequently 
editable in the Pi Toolbox Properties Explorer. The format and capitalization must be as 
shown below. Items not preceded by 'Tbx..' will be ignored by Pi Toolbox. 

TbxDriverName = 'name' 

TbxTrackName = 'track name' 

TbxCarName = 'car name' 

TbxShortComment = 'comment' 

TbxOuting = '<000:000:000>' 

Note: Outing information is in the form: session: outing: first lap, e.g. <002:005:010> 



 

 

Display plots in MATLAB 

To display plots in MATLAB use the following form: 

plot((channel name)(:,1),(channel name)((:,2)) where the value (:,2) is plotted 
against time (:,1) 

MATLAB time and distance data 

Pi Toolbox will recognize as channels double array data of n x 2 columns, where the 1st 
column is sequential time and the 2nd column is data values.  

Working with MATLAB files in Pi Toolbox 

You cannot add channels, events, lap markers, etc. to re-imported MATLAB data. Only the 
channels exported initially (or added in MATLAB) will be available for analysis.  
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MS Excel format 

Excel export utilizes the multiple worksheet feature of the application to export different 
types of data to different named sheets. These are Outing Information, Channel Data, and 
Event Data. Outing data is exported to the first sheet, channel data to the second and event 
data to the third. 

Channel Data 

The first column contains times, with subsequent columns containing the channel data. Both 
time and channel values will be exported as doubles so that no precision is lost from the 
source data. 

Event Data 

Event times will be exported as doubles. Other values will be exported as strings. 
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Export constraints 

Spreadsheets are limited to 255 columns and 655535 rows, resulting in the following 
limitations for Excel data export: 

Channels = 254 

Samples per channel = 65535. 

If these constraints are exceeded the user will be informed on the Results page of the 
Wizard, e.g. 

The following channels cannot be exported:  Damper RR, Damper RL. 

ASCII 

ASCII format data files (.txt) support channel and event data, but not lap markers. The 
following information is intended to supplement the user's knowledge of ASCII text file 
environment. 



 

 

Editing ASCII text files in a text editor or Excel 

Pi Toolbox ASCII text file headers are in the form: PiToolboxASCIIDataset. 

Blocks of data are headed in the form: {OutingInformation}, {ChannelBlock}, etc. 

Example: 

Note: To re-import ASCII text files, they 
must be saved in Excel as: Text (Tab 
Delimited) *.txt files. 

Adding outing properties in a text 
editor or Excel 

When adding outing properties in a text 
editor, make sure the data block is 
headed {OutingInformation} and that 
the property name and value are tab 
delimited. To re-import into Pi Toolbox, 
save Excel file as Text (Tab Delimited). 

Adding channels in a text editor or 
Excel 

Channels can be added in Excel or a text 
editor. Add columns under the 
{ChannelBlock} header, making sure 
that new columns are tab delimited from 
the preceding ones. To re-import into Pi Toolbox, save Excel file as Text (Tab Delimited). 

Importing ASCII text files into Excel 

When Importing ASCII text files into Excel, use the Text Import Wizard defaults of 'Delimited' 
and 'Tab'. 

To view the plot, highlight the data columns and select the Chart Wizard toolbar button. 
Follow the wizard instructions.  
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Pi Datasets 

Pi Dataset format data files support channel, event and lap marker data. Pi Dataset is the Pi 
Toolbox native format.  

Export Qualifying mode 

The Export QM file dialog creates a file for export, which contain split times for regions in a 
single lap. 

The Export QM file dialog is accessed by selecting  > Export > Qualifying Mode... in a 
Time and Distance display. 

 

The Define Distances window lists the distances between Soft splits, Split beacons or 
Distance intervals, depending upon which option is selected. When Split beacons are 
selected the distances are not editable. When Distance interval is selected, enter a distance 
and select a unit, 'm' or 'ft'. The distance intervals will be transferred to the Define Distance 
window. Use the Browse button to browse for a location for the exported file. 
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How do I? 

This section of the manual is designed as a quick reference guide for common tasks that 
may incorporate the setting up of one or more dialogs in Pi Toolbox. 

Real-time Broadcast set 
up 

1 Check that a Real-time browser is enabled. 

• On the File menu, click Preferences. 

The Preferences dialog is displayed. 

 

• Click the Browsers tab. 
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• Make sure that one of the browsers in the list is configured as a Real-time 
browser. If you need to configure a Real-time browser, see Setting up a Real-time 
display on page 241 for more information. 

• Click OK. 

2 Add a task to the worksheet. If there are no spare tasks in the worksheet, add a 
new task. 

• Press CTRL + T to add a new task. 

• If you want to rename the task, you can do this by editing the Name field in the 
Appearance section of the task column. 

3 Add an outing to the to the task. 

• Press CTRL + L, the Add dialog is displayed. 
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• Click the Real-time button. 

The Real-time options will be displayed. 

 

• Select Telemetry Servers. 

, the Browse dialog is displayed. • Click 
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• On the Insert menu, point to Display then select Real-time chart recorder. 

• Browse to or type the name of the telemetry server in the name field. 

• Click OK. 

4 Add a Real-time chart recorder display to a worksheet. 

Note: You cannot have more than 8 displays in a worksheet. 

5 Make sure that all controls are linked to the appropriate telemetry task. 

6 Add your required channels to the display. 

• The channels list will only become populated after telemetry data has been 
received. 

Common Issues  

The Real-time server will not connect to the Telemetry server 

1 Using Windows Explorer, browse to the Telemetry server. 

• If you can see the Telemetry server, make sure that your configured details are 
the same as the properties for the server. 

• If you cannot see the Telemetry server, make sure that you have access rights 
on the network. 

2 If you still cannot see the Telemetry server: 

• On the Tools menu, click Options. 

• Click the Real-time tab. 
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• Make sure that settings in the Information stream field are the same as the 
settings for the Real-time server. 

The Real-time control freezes 

Clicking in the real-time control will pause the update, this can be confirmed by the text 
Local Pause in the bottom left of the display. To release the display, click in the display area 
and press P. The text displayed will change to Running. 

To pause all displays, click the Global pause button. The text will display Global Pause. 
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Appendix A – Standard Math operators 

Mathematical operators 

Operators Description 
+ Addition 

- Subtraction 

* Multiplication 

/ Division 

 

Logical operators 

Operator Usage Description 
! !a Logical Negation. If ‘a’ is not zero returns 0 else 1. 

&& a&&b Returns 1 if both ‘a’ and ‘b’ are non-zero, else 0. 

^^ a^^b Returns 0 if both ‘a’ and ‘b’ are 0 or 1, else 1. 

|| a||b Returns 1 if either ‘a’ or ‘b’ are non-zero, else 0. 
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Bitwise operators 

Operator Usage Description 
~ ~a Casts a to a 32 bit integer and inverts each bit. 

& a&b Casts both ‘a’ and ‘b’ to a 32 bit integer and AND’s the two 
results. 

| 

Casts ‘a’ as a 32 bit integer and shifts it to the left by n bits. 

^ 

ror(a,b) 

 

a|b Casts both ‘a’ and ‘b’ to a 32 bit integer and OR’s the two 
results. 

<< a<<n 

>> a>>n Casts ‘a’ as a 32 bit integer and shifts it to the right by n bits. 

y^y Returns u32(’x’)XORed with u32(‘y’) 

rol() rol(a,b) Returns u32('a') rotated left by u32('b') bits. 

ror() Returns u32('a') rotated right by u32('b') bits. 
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Comparison operators 

Operator Usage 

a>=b 

< 

Returns 1 if ‘a’ is less than or equal to ‘b’, else 0. 

a= =b 

a!=b 

Returns 1 if the magnitude of the difference 
between 'c' and its value 't' seconds before is 
greater than 'd', else returns 0. 

Description 
> a>b Returns 1 if ‘a’ is greater than ‘b’, else 0. 

>= Returns 1 if ‘a’ is greater than or equal to ‘b’, else 
0. 

a<b Returns 1 if ‘a’ is less than ‘b’, else 0. 

<= a<=b 

= = Returns 1 if ‘a’ is equal to ‘b’, else 0. 

!= Returns 1 if ‘a’ is not equal to ‘b’, else 0. 

choose(,,) choose(c,a,b) Returns ‘a’ if ‘c’ is non-zero else ‘b’. 

compare() Compare(a) Returns a channel with values equal to difference 
between the current outing and the Datum, for 
channel. The differences are calculated, based on 
time. 

compareDist CompareDist([x]) Returns a channel with values equal to difference 
between the current outing and the Datum, for 
channel. The differences are calculated, based on 
Distance. 

edge() 

 

edge(c,t,d) 
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Trigonometric functions 

Operator Usage Description 
acos() acos(a) Returns the arc cosine of ‘a’. 

asin() asin(a) Returns the arc sine of ‘a’. 

atan() atan(a) Returns the arc tangent of ‘a’. 

atan2(,) atan2(a,b) Returns the arc tangent of ‘a/b’. 

cos() cos(a) Returns the cosine of ‘a’. 

sin() sin(a) Returns the sine of ‘a’. 

tan() tan(a) Returns the tangent of ‘a’. 

hypot(,) hypot(a,b) Returns the length of the hypotenuse of the right-angled 
triangle specified by ‘a’ and ‘b’. 

 

Hyperbolic functions 

Operator Usage 
sinh() 

Returns the hyperbolic sine of ‘a’. 

tanh(a) 

exp() 

Description 
sinh(a) Returns the hyperbolic cosine of ‘a’. 

cosh() cosh(a) 

tanh() Returns the hyperbolic tangent of ‘a’. 

exp(a) Returns the exponential value of ‘a’. 
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Conversion operators 

Operator Usage 

Returns the largest integer that is less than or equal to ‘a’. 

fmod(a,b) 

fabs() 

Returns 'a', reinterpreted as floating-point 

iu32() 

Description 
ceil() ceil(a) Returns the smallest integer that is greater than or equal to ‘a’. 

floor() floor(a) 

fmod(,) Returns the floating-point remainder of ‘a/b’. 

fabs(a) Returns the absolute value of ‘a’. 

iflt() iflt(a) 

is32() is32(a) Returns 'a', reinterpreted as 32-bit signed integer. 

iu32(a) Returns 'a', reinterpreted as 32-bit unsigned integer. 

min(,) min(a,b) Returns the lesser of ‘a’ and ‘b’. 

max(,) max(a,b) Returns the greater of  ‘a’ and ‘b’. 

minimum() minimum(a) Returns 1 if 'a' reaches its minimum at current timestamp, 
else returns 0. 

maximum() maximum() Returns 1 if 'a' reaches its maximum at current timestamp, 
else returns 0. 

shl(,) shl(a,n) Casts a to a 32 bits integer, right shifts ‘a’ by ‘n’ filling the 
higher order bits with zeroes. 

s8() s8(a) Casts ‘a’ to 8 bit signed integer. 

s16() s16(a) Casts ‘a’ to 16 bit signed integer. 

s32() s32(a) Casts ‘a’ to 32 bit signed integer. 

u8() u8(a) Casts ‘a’ to 8 bit unsigned integer. 

u16() u16(a) Casts ‘a’ to 16 bit unsigned integer. 

u32() u32(a) Casts ‘a’ to 32 bit unsigned integer. 
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Miscellaneous 
operators 

Operator Usage Description 

log() log(a) Returns natural logarithm of ‘a’. 

log10() log10(a) Returns the logarithm base 10 of ‘a’. 

pow(,) pow(a,b) Returns ‘a’ raised to the power ‘b’. 

sqrt() sqrt(a) Returns the square root of ‘a’. 

slope() 

 

slope(a,Left|Right,  
Reset|Ignore|NoData])  

Returns the left/right partial first-derivative of 'a'. 

Rand Rand Returns a random value in the range 0 to 1. 

register register'x'[='y'] Declares a new register 'x' and initializes it with 'y' or zero if 
'y' is missing. The name of the register must start with '@'. 

derivative() derivative(x, 
Reset|Ignore|NoData) 

Returns the first derivative of ‘x’ 

integral() integral(x, 
Ignore|Reset|Hold) 

Returns the integral of ‘x’ 

timeDiff() timeDiff(x, 
Previous|Next, 
Reset|Ignore) 

Returns the distance from the previous to current sample 
or from the current to the next sample of channel ‘x’ 

BandPass() Bandpass(x,l,h,Ignor
e| AsumeZero) 

Applies band pass filter to expression ‘x’ with low 
frequency ‘l’ and high frequency ‘h’. When ‘l’(‘h’) 
is zero, this function works like low(high) pass 
filter. 

Gate() Gate(x,y) Returns ‘y’ if ‘x’ is non-zero, otherwise returns 
discontinuity. 

MovAverage() MovAvergae(x,y,Ign
ore|AssumeZero) 

Applies running average filter to expression ‘x’ in 
time interval of ‘y’ seconds. 
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Table ‘x’ = ‘y’; 

 

 

Operator Usage Description 

.warning {ID off | level N } This warning control pragma disables a particular 
warning or establishes an upper warning level 
threshold (inclusive). 

Table 

 

 

IfExist() 

 

 

IfExist([channel 
name],x) 

Declares a new lookup table ‘x’ and initializes it 
with ‘y’. The name of the lookup table must start 
with ‘#’. 

Defines values for specific channels, even if the 
channel is currently undefined. The channel does 
not need to be present in the current list of 
defined channels. 'x' will be any valid math 
channel expression. 

Note: if the data rate of the math channel is set 
to [channel_name] then the math channel will still 
be undefined if [channel_name] does not exist. 
To ensure that the math channel is not undefined 
either set the data rate to an unconditional 
channel, or set a fixed rate for the calculation. 
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Constant operators 

 
Operator Usage Description 

OUTCONST () OUTCONST () Returns the value of the constant from the 
outing 

GLOBALCONST () GLOBALCONST () Returns the value of the global constant 

CONST () CONST () Returns the outing constant, if this fails, 
selects the global constant. 



 

 

Appendix B - Shortcuts 

In this section you will find the keyboard and menu shortcuts for Pi Toolbox. 

File Menu 

Shortcut Description Menu 

 +  Creates a new Workbook File > New 

 +  Opens an existing Workbook File > Open 

 +  Saves the active Workbook File > Save 

 +  Prints the Active panel File > Print 

 

Edit Menu 

Shortcut Description Menu 

 +  Cuts the selection and 
places it on the clipboard 

Edit > Cut 

 +  Copies the selection and 
places it on the clipboard 

Edit > Copy 

 +  Pastes the clipboard 
contents 

Edit > Paste 

 +  Delete a Worksheet Edit > Delete Worksheet 

 Rename a Display Edit > Rename Display 
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 +  Rename a Worksheet Edit > Rename Worksheet 

View Menu 

Shortcut Description Menu 

 +  Explores the available tasks View > Tasks 

 +  Explores the active display’s 
selection 

View > Selections 

 +  Explores the channel 
properties of the active 
display 

View > Channel Properties 

 +  Explores the event properties 
of the active display 

View > Event Properties 

Hides/Shows the Explorer 
bar 

View > Hide/Show Explorer 
Bar  

Cycles tabs in Explorer, e.g. 
Channels, Events 

N/A 

 +  

 +  

 

Data Menu 

Shortcut Description Menu 

 +  Add a task Data > Add Task 

 Refresh Data > Refresh 

 Link Zoom Data > Link Zoom 
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 Unlink Zoom Data > Unlink Zoom 

 Enable Pi Toolbox display in 
Pi Remote Toolbox 

Data > Remote Display 

 Enable transmission of data 
from Pi Toolbox to Pi 
Remote Toolbox 

Data > Pi Remote Toolbox 

 +  +  Opens the Select (Laps) 
dialog with Laps selected 

Data > Select Laps 

 +  Selects all laps in the outing Data > Entire Outing 

 +  Selects the fastest lap in the 
outing 

Data > Fastest Lap 

 +  +  Selects all laps for all the 
outings in the task 

Data > Entire Outings 

 +  +  Selects the fastest lap for all 
outings in the task 

Data > All Fastest laps 

 +  Opens the Add Outing dialog Data > Add Outing 

 +  Opens the Replace Outing 
dialog (outing highlighted) 

Data > Replace Outing 

 +  Deletes the outing 
highlighted 

Data > Delete Outing 

+  +  

Go to the next or previous 
lap in the outing 

Data > Move Next/Previous 

 +  +  

Go to the first or last lap in 
the outing 

Data > Move First/Last 
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Windows Menu 

Shortcut Description Menu 

 +  Closes the selected display Window > Close 

 +  Moves to the next pane Window > Next 

 +  +  Moves to the previous pane Window > Previous 

 +  
Maximizes / Restores the 
selected display 

Windows > Maximize / 
Restore 

Help Menu 

Shortcut Description Menu 

 Displays help for the current 
dialog, command etc. 

N/A 

 +  What’s this? Help for 
selected Buttons, Menus and 
Windows 

N/A 
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Task explorer 

Shortcut Description 

 +  Creates a new task in Pi Toolbox. 

 

Opens the Load Outing dialog (when a task is highlighted). 

 

Opens the Select dialog (when an outing is highlighted). 

 Deletes the selected task or outing from the current 
workbook. 

 +  Selects the fastest lap in the current outing. 

 +  Selects all laps in the current outing. 

Details pane 

Shortcut Description 

 

Edits the selected property. 

 Cancels the edit procedure. 

  Expands or collapses the property category. 

  Expands or collapses the category and navigates up and 
down. 
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Selection explorer 

1 D channel selection 

Shortcut Description 

 

Adds the currently selected channels or groups to a display. 
If the root node is selected, all items under the node are 
added. 

 Clears the filter. 

 Deletes a character from the filter. 

 Deletes an item from the display in focus. A channel, group 
or event must be selected in the upper pane. 

 

2D Channel selection 

Shortcut Description 

 

One channel highlighted 

The channel is added to the first empty X or Y assignment in 
the display’s selection. 

Two channels highlighted 

The channels are added as a pair to a display, with the 
channel selected first assigned to the X axis and the channel 
selected second assigned to the Y-axis. 

 Clears the filter. 

 Deletes a character from the filter. 
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 In an X – Y display, with a channel highlighted in the upper 
pane. The channel in the last channel pair is deleted, if there 
isn’t a channel there, then the channel in the previous 
channel pair is deleted. 

Event Selection  

Available with the Events tab selected. 

Shortcut Description 

 

Adds the currently highlighted events to the control. If the 
root node is selected, all events under the node are added 
to the control. 

 Clears the filter. 

 Deletes a character from the filter. 

 Attempts to remove the highlighted items from the selection. 
If a parent node is selected then an attempt to remove all 
items under the node is made. 

 When the filtered list has input focus and if a filter has been 
entered, this adds the filter as an inclusion for the controls 
event selection filter. 

 +  When the filtered list has input focus and if a filter has been 
entered, this adds the filter as an exclusion for the controls 
event selection filter. 

 +  When the filtered list has input focus, this removes the 
currently entered filter from both the exclusions and 
inclusions of the controls event selection filter. 
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Properties explorer 

Properties list 

Shortcut Description 

 

Edits the selected property. 

 Cancels the edit procedure. 

 (keypad) Expands or collapses the property category. 

  Expands or collapses the category and navigates up/down. 

Channel list 

Shortcut Description 

 Clears the filter. 

 Deletes a character from the filter. 
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Time and Distance 
displays 

Cursor movement 

Shortcut Description 

  Moves the X cursor left or right or: 

Changes the Offset when in offset mode. 

 +   Moves the X cursor left or right (Quickly). 

 Moves the X cursor to the beginning of the trace and: 

Moves the zoom region to the beginning of the trace when in 
Keyboard zoom mode. 

 Moves the X cursor to the end of the trace or: 

Moves the zoom region to the end of the trace when in 
keyboard zoom mode. 

 
 

 Moves the cursor to the previous or next event. 

  Finds the Maximum or Minimum cursor values. 
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Zoom control 

Shortcut Description 

 Zoom on current cursor position (50%). 

 +  
Zooms using the mouse. Left click and drag the boundary to 
size. Release to set the size. 

 +  
Zoom in or out on current cursor position. 

 Undo last zoom. 

 +  Undo all previous zooms  

Scrolling 

Shortcut Description 

  Scrolls along the trace in a zoomed region. Multiple presses 
increase scroll speed. 

 +  
Open hand cursor, click and drag to scroll. 

 +   Moves the view port by 10% of its width in the arrow 
direction. 
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Display mode 

Shortcut Description 

 Time/Distance mode. 

 Flash/Display the active channel trace. 

 Hide/Show the active channel trace. 

Enter/Exit the Time Offset mode. 

 +  Enter/Exit the Value Offset mode. 

 Tile/Overlay Y - axis mode. 

 Cancels the current mode. 

  +  

 

 Changes the active channel.  

Other shortcuts 

Shortcut Description 

 +  

Displays the Time and Distance display properties dialog. 

 Enter/Exit the Reference cursor mode. 

 Mark a split or mark a Segment when the segment bar is 
enabled. 

 +  Selects all the laps in the outing (outing highlighted or 
display selected). 

 +  Selects the fastest lap in the outing (outing highlighted or 
display selected). 

 Toggles the auxiliary axis for the active channel between 
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left, right and off. 

 Toggles the locked cursor on or off. 

Removes the active channel from the display.  

Histograms 

Shortcut Description 

 +  

Displays the Histogram property dialog. 

  Changes the active channel. 

 Tile/Overlay Y-axis mode. 

 Toggles the auxiliary axis for the active channel between 
left, right and off.  

 +  +  Copies the bin values for all channels and all data selections 
to the clipboard. 

Maps 

Shortcut Description 

 +  

Displays the Map property dialog. 

  (In Edit mode), with a map element selected, selects 
consecutive map elements, i.e. boundary, segment, beacon. 

 +   (In Edit mode), selects multiple map elements. 

  (In Edit mode), with a boundary selected, moves the 
boundary in the arrow direction. 
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X-Y Displays 

Cursor movement 

Shortcut Description 

  Moves the X cursor to the next/previous data point. 

 +   Moves the X cursor through the data quickly. 

Moves the X cursor to the beginning or end of the trace. 

 +  +  
Show/hide the Polynomial curve. 

 +  +  Enter/Exit User defined Polynomial mode. 

 +  +  Copy the Polynomial equation (for pasting as plain text or 
rich text). 

 +  +  Copy the Polynomial coefficients (for pasting as tab 
delimited text). 

  

Zoom control 

Shortcut Description 

 Zoom on current cursor position (50%). 

 +  
Zooms using the mouse. Left click and drag the boundary to 
size. Release to set the size. 

 +  
Zoom in or out on current cursor position. 

 Undo last zoom. 

 +  Undo all zooms. 
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Scrolling 

Shortcut Description 

  Auto scrolls along the trace in a zoomed region. 

 
Scroll in a zoomed region. 

 
Open hand cursor. 

Click and drag to scroll in a zoomed region. 

 +   Moves the view port by 10% of its width in the arrow 
direction. 

Display mode 

Shortcut Description 

  

 +  

Changes the Active channel pair. 

 Toggles the Auxiliary axis for the active channel between 
left, right and off. 

Other shortcuts 

Shortcut Description 

 +  

Displays the X-Y display properties dialog. 

462 Pi Toolbox User Guide 

 



 

 

Reports 

In the Report display 

Shortcut Description 

 Adds a new table. 

 Deletes the selected table. 

 +  

Opens the properties dialog for the selected table. 

 +  

Runs the entire report. 

 

Runs the selected table. 

 Cancels a report or a table run. 

In the Properties dialog 

Shortcut Description 

 Adds a new data item. 

 Deletes a selected data item. 

 +   Moves a data item up or down. 

  Moves the selection left or right. 
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Video display 

Shortcut Description 

  Moves to the previous or next frame in the video. 

  Moves to the first/last frame in the video, within the limits of 
the data selection. 

 Toggle Offset mode on/off. 

  
Fast forward/ Fast Rewind. 

 Play/Pause. 

 +  

Opens the properties dialog for the selected display. 
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Appendix C 

Sample code for Excel 

Note: Place code in a new worksheet with a Pi Toolbox task configuration page, a Pi Toolbox 1D 
channel selection page and a Pi Toolbox Time and Distance display are embedded into sheet 1. 

 
See following pages for sample code. 
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This workbook 
 
Option Explicit 
 
Private Sub Workbook_BeforeClose(Cancel As Boolean) 
 
Module1.OnClose 
 
End Sub 
 
Private Sub Workbook_Open() 
 
Module1.OnOpen 
 
End Sub 
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Module (called Module 1) 
 
Option Explicit 
 
Dim g_oConfigPage As ITbxConfigurationPage 
Dim g_oADM As ITbxADM 
Dim g_oCtl As ITbxControl 
 
Dim g_ADMSink As CADMNotificationsSink 
Dim g_ControlSink As CControlNotificationsSink 
 
Sub OnOpen() 
 
'Connect TaskView and ADM 
Set g_oConfigPage = Sheet1.TaskView1 
Set g_oADM = Sheet1.ADM1 
g_oConfigPage.ADM = g_oADM 
 
'Connect Chart and ADM 
Set g_oCtl = Sheet1.TimeDistCtl1 
g_oCtl.ADM = g_oADM 
 
'Connect ChannelSelect to the ADM and the Chart 
Set g_oConfigPage = Sheet1.ChannelSelect1 
g_oConfigPage.ADM = g_oADM 
g_oConfigPage.Control = g_oCtl 
 
'Subscribe for ADM Notifications, so we can be notified when 
'a new task has been selected. 
Set g_ADMSink = New CADMNotificationsSink 
Call g_ADMSink.Subscribe(g_oADM) 
 
'Subscribe for Control Notifications, so we can be notified when 
'the a new channel has been selected. 
Set g_ControlSink = New CControlNotificationsSink 
Call g_ControlSink.Subscribe(g_oCtl) 
 
'Call Task Changed which will rehook up any persisted tasks 
TaskChanged 
 
'Tidy up 
Set g_oConfigPage = Nothing 
  
End Sub 
 
Sub OnClose() 



 

 

468 Pi Toolbox User Guide 

 

On Error Resume Next 
 
'Finished with notifications 
Call g_ControlSink.UnSubscribe 
Set g_ControlSink = Nothing 
 
Call g_ADMSink.UnSubscribe 
Set g_ADMSink = Nothing 
 
'Must terminate the ADM before quitting 
g_oADM.Terminate 
 
'Tidy up 
Set g_oCtl = Nothing 
Set g_oADM = Nothing 
 
On Error GoTo 0 
 
End Sub 
 
'Called by the TaskChanged method of ITbxADMNotifications, implemented 
'in CADMNotificationsSink 
Sub TaskChanged() 
 
If g_oADM.Tasks.Count > 0 Then 
    'Set the Chart Task to the new task / last added task 
    g_oCtl.TaskIndex = g_oADM.Tasks.Count 
End If 
 
End Sub 
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Class Module (called CADMNotificationsSink) 
 
Option Explicit 
 
Implements ITbxADMNotifications 
 
Dim lCookie As Long 
Dim oADM As ITbxADM 
 
Private Sub Class_Initialize() 
 
lCookie = 0 
Set oADM = Nothing 
 
End Sub 
 
Private Sub ITbxADMNotifications_ChannelPropertyFactoryChanged(ByVal 
punkCaller As PiToolboxLib.ITbxADM, ByVal pChannelPropertyFactory As 
PiToolboxLib.ITbxChannelPropertyFactory) 
'Comment to implement method 
End Sub 
 
Private Sub ITbxADMNotifications_CircuitMapDataChanged(ByVal punkCaller As 
PiToolboxLib.ITbxADM, ByVal pMapData As PiToolboxLib.ITbxCircuitMapData) 
'Comment to implement method 
End Sub 
 
Private Sub ITbxADMNotifications_CommonChannelsChanged(ByVal punkCaller As 
PiToolboxLib.ITbxADM) 
'Comment to implement method 
End Sub 
 
Private Sub ITbxADMNotifications_GroupFactoryChanged(ByVal punkCaller As 
PiToolboxLib.ITbxADM, ByVal pGroupFactory As PiToolboxLib.ITbxGroupFactory) 
'Comment to implement method 
End Sub 
 
Private Sub ITbxADMNotifications_RealTimeSettingsChanged(ByVal punkCaller As 
PiToolboxLib.ITbxADM) 
'Comment to implement method 
End Sub 
 
Private Sub ITbxADMNotifications_TasksChanged(ByVal punkCaller As 
PiToolboxLib.ITbxADM) 
 
'Calls sub to change task index of control and clear table 



 

 

470 Pi Toolbox User Guide 

 

Module1.TaskChanged 
 
End Sub 
 
Private Sub ITbxADMNotifications_Terminating(ByVal punkCaller As 
PiToolboxLib.ITbxADM) 
'Comment to implement method 
End Sub 
 
Public Sub Subscribe(ByVal pADM As PiToolboxLib.ITbxADM) 
 
'Pi Toolbox VB Helper must be selected in the references 
Dim oHelper As VBNotificationsHelper 
 
'Create a new Helper object 
Set oHelper = New VBNotificationsHelper 
 
'Check oADM and pADM and store the object if everything is OK 
If pADM Is Nothing Then 
    'Bad Parameter passed in 
    MsgBox "Error - Attempted to subscribe with unset source", , "ADM 
Notifications Sink" 
ElseIf Not oADM Is Nothing Then 
    'We've already subscribed 
    MsgBox "Error - Sink already used for subscription", , "ADM 
Notifications Sink" 
    GoTo Exit_Sub 
Else 
    'No error, so store the object being subscribed 
    Set oADM = pADM 
End If 
 
'Subscribe, storing the returned cookie so we can unsubscribe later 
lCookie = oHelper.Subscribe(tbxADMNotifications, oADM, Me) 
 
Exit_Sub: 
    'Tidy up 
    Set oHelper = Nothing 
    Exit Sub 
 
End Sub 
 
Public Sub UnSubscribe() 
 
'Pi Toolbox VB Helper must be selected in the references 
Dim oHelper As VBNotificationsHelper 
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'Create a new Helper object 
Set oHelper = New VBNotificationsHelper 
 
'Check we can unsubscribe 
If oADM Is Nothing Or lCookie = 0 Then 
    'Haven't sucessfully subscribed yet 
    MsgBox "Error - Attempted to unsubscribe without having subscribed 
sucessfully", , "ADM Notifications Sink" 
Else 
    'Unsubscribe to the stored object 
    Call oHelper.UnSubscribe(oADM, lCookie) 
End If 
 
'Tidy up and reset 
Set oADM = Nothing 
Set oHelper = Nothing 
lCookie = 0 
 
 
End Sub 
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Class Module (called CcontrolNotificationsSink) 
 
Option Explicit 
 
Implements ITbxControlNotifications 
 
Dim lCookie As Long 
Dim oControl As ITbxControl 
 
Private Sub Class_Initialize() 
 
lCookie = 0 
Set oControl = Nothing 
     
End Sub 
 
Private Sub ITbxControlNotifications_ActiveChannelsChanged(ByVal pControl As 
PiToolboxLib.ITbxControl) 
'Comment to implement method 
End Sub 
 
Private Sub ITbxControlNotifications_ADMChanged(ByVal pControl As 
PiToolboxLib.ITbxControl, ByVal pNewADM As PiToolboxLib.ITbxADM) 
'Comment to implement method 
End Sub 
 
Private Sub ITbxControlNotifications_DisplayedChannelsChanged(ByVal pControl 
As PiToolboxLib.ITbxControl) 
'Comment to implement method 
End Sub 
 
Private Sub ITbxControlNotifications_TaskChanged(ByVal pControl As 
PiToolboxLib.ITbxControl, ByVal pNewTask As PiToolboxLib.ITbxTask) 
'Comment to implement method 
End Sub 

Public Sub Subscribe(ByVal pControl As PiToolboxLib.ITbxControl) 
 
'Pi Toolbox VB Helper must be selected in the references 
Dim oHelper As VBNotificationsHelper 
 
'Create a new Helper object 
Set oHelper = New VBNotificationsHelper 
 
'Check oControl and pControl and store the object if everything is OK 
If pControl Is Nothing Then 
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    'Bad Parameter passed in 
    MsgBox "Error - Attempted to subscribe with unset source", , "Control 
Notifications Sink" 
ElseIf Not oControl Is Nothing Then 
    'We've already subscribed 
    MsgBox "Error - Sink already used for subscription", , "Control 
Notifications Sink" 
    GoTo Exit_Sub 
Else 
    'No error, so store the object being subscribed 
    Set oControl = pControl 
End If 
 
'Subscribe, storing the returned cookie so we can unsubscribe later 
lCookie = oHelper.Subscribe(tbxControlNotifications, oControl, Me) 
 
Exit_Sub: 
    'Tidy up 
    Set oHelper = Nothing 
    Exit Sub 
 
End Sub 
 
Public Sub UnSubscribe() 
 
'Pi Toolbox VB Helper must be selected in the references 
Dim oHelper As VBNotificationsHelper 
 
'Create a new Helper object 
Set oHelper = New VBNotificationsHelper 
 
'Check we can unsubscribe 
If oControl Is Nothing Or lCookie = 0 Then 
    'Haven't sucessfully subscribed yet 
    MsgBox "Error - Attempted to unsubscribe without having subscribed 
sucessfully", , "Control Notifications Sink" 
Else 
    'Unsubscribe to the stored object 
    Call oHelper.UnSubscribe(oControl, lCookie) 
End If 
 
'Tidy up and reset 
Set oControl = Nothing 
Set oHelper = Nothing 
lCookie = 0 
 
End Sub 
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Appendix D 

Band Pass filter 
algorithm 

Direct FIR implementation of digital filtering for Toolbox. 

Toolbox requires filtering of the sampled signal as follows: 

• high pass (freq < F1); 

• low pass (freq > F2); 

• band pass (F2>freq>F1). 

All of these can be computed from one or two low-pass filtered signals.  Note that: 

• high pass is [(original signal )– (low pass)] 

• band pass is [(low pass at higher freq) – (low pass at lower freq)] 

hence all implementable quickly as array addition/subtractions.  

Here we use a finite impulse response (FIR) filter to implement a low-pass filter.  It is 
recognized that in many circumstances a spectral domain (FFT) method is quicker, but this 
is more complicated in the case of data sampled at different frequencies and non-
periodically.  We will implement it non-causally (i.e. using time before and after the point in 
question) so far as possible, and truncate when necessary (at edges of time periods).   

However this is still apparently slower than the FFT implementation. 

By using a simple FIR filter, with redundancy, we can reduce the number of computations to 
comparable to the number required for a FFT implementation – or less. 
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A perfect low-pass filter has as impulse response a sinc (sine(x)/x) function, as: 

 

 

 

 

 

 

 

 

 

 

We will approximate this by using a sinc function for the central peak, but sin values for the 
subsidiary peaks, scaled appropriately. Like this each peak is self-similar, reducing 
computations.  We will take the central peak and 8 neighboring peaks, so that we take a 
total of 9 wavelengths of time at the cutoff frequency for the FIR filter.  Note that the ‘tails’ 
are a series of sin values over 1 period (so every other peak is the same height).  The 
resulting impulse response is as below. 

 

 



 

 

We further approximate by quantizing this: 

 

 

 

 

 

 

 

 

 

this gives a very good approximation to the ideal frequency response: 

 

 

 

 

 

 

 

 

 

We have quantized in time to 10 times in each ‘period’ of the tail (= filter cut-off frequency 
period). 

We note that the central ‘hump’ has only 5 discrete values, 1 of which (in the center) is 1.  
The sine waves in the side ‘tails’ are all similar, and hence only have two discrete values 
(plus a weighting for each peak). 
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The two functions are a sinc wave from x=0 to x=pi, which I call function ‘A’, and which for 
us has 5 values, A(1 … 5) and the sine wave approximation, which in this approximation has 
two values, B(1, 2).  (Note we ignore the part of the impulse response, which is zero. 

For a waveform the output of a filter of finite impulse response is the sum of the coefficients 
times the input. 

If the input channel is x, then we say the values are: 

x(1….j….N) 

and for each there is a time t(1….j…N) and equivalently a sampling interval dt(1….j….N) 
(noting that one  end has to be fiddled) where dt(i)=t(i+1)-t(i) (say dt(N) = dt(N-1)). 

For each input channel point we compute 6 interim arrays: 

x*dt*A(1...5) and x*dt*B(1,2).  

Call the results (2-D matrices) fA(1...4,1..i...N) and fB(1..2, 1....i...N) 

Say the cut-off frequency of the filter is fc.  Then the points in the impulse response are 
separated by 1/(20*fc) (since we chose 10 points in the quantization above).  Then let it 
have a variable tx which is half this for simplicity, 

tx = 1/(20*fc) 

and then we see that at any given output time our output is given by 

out(t) =  sum(XA(0,ts)[while(ts-t<tx<ts-t)])    ! central ‘plateau’ 

+ sum(XA(1,ts)[while(tx<ts-i<3*tx]) + sum(XA(1,ts)[while(tx<i-ts<3tx]) ! first step 2 sides 

etc for all the A terms 

+w1*[ sum(XB(1,ts)[while(11*tx<ts-i<13*tx]) + sum(XB(1,ts)[while(11*tx<i-ts<13*tx])  !first quarter sine 

+ sum(XB(2,ts)[while(13*tx<ts-i<15*tx]) + sum(XB(2,ts)[while(13*tx<i-ts<15*tx])  !first quarter sine 

+ sum(XB(2,ts)[while(15*tx<ts-i<17*tx]) + sum(XB(2,ts)[while(15*tx<i-ts<17*tx])  !first quarter sine 

+ sum(XB(1,ts)[while(17*tx<ts-i<19*tx]) + sum(XB(1,ts)[while(17*tx<i-ts<19*tx])  ] !first quarter sine 

for first hump 

and etc for each hump. 
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As an edge is approached, not just whole periods should be used as they become affected.  
As the periods are sine waves the d.c. response, hence scaling, is not affected: 

 

 

 

 

 

 

 

 

 

 

but when the central peak reaches the edge, then cut the central peak into two and double 
the scaling. 

Flag the area where the kernel is truncated as “edge affected” and re-compute if adjoining 
data becomes available. 
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Appendix E 

XML Example strings 

All the required elements and their associated attributes are listed and described below: 

<status_def>  

The root element of the Bit-Field Definitions. 

version 

The version of the bit-field definition XML file format 

Format: text 

For example: <status_def version="1"> 

<application name> 

The name of the application. 

Format: text 

id 

The id used to uniquely identify a build of code. In this example: the build of code for this 
application. 

Format: text 

For example: <application name="Gearbox Controller" id="aabbccdd"> 
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<channel> 

The source of data used in the creation of a bit-field. 

Tagname 

The “master” name of the channel 

Format: text 

Color 

The display color used by clients when displaying the channel’s data. 

Format: COLOUR 

For example: <channel tagname="TC_Status" color="0xff0000"> 

<field> 

A definition of a bit-field 

Name 

The name of the bit-field 

Format: text 

abbr 

An abbreviated version of the “name” attribute 

Format: TEXT 

bitmask 

The bit-mask applied to the parent status channel. 

Format: VALUE 

For example: <field name="Heartbeat" abbr="Htbt" bitmask="0x0100"> 
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<entry> 

Describes a specific bit or value of the parent status channel. 

value 

A specific bit or value of the parent status channel. 

Format: VALUE 

text 

The display text for the associated “value” 

Format: text 

Color 

The color to be used when displaying this entry 

Format: COLOUR 

For example:  <entry value="0x0000" text="Off" color="0xff0000"/> 

<default> 

Describes a default entry that is to be used when no <entry> matches are found. 

Text 

The display text 

Format: TEXT 

Color 

The color to be used when displaying this entry. 

Format: COLOR 

For example : <default text="Undefined" coloured="0xa1a1a1"/> 
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Data formats 

Color 

Format: 24bit hex number 

most significant byte = Red value 

middle byte  = Green value 

least significant byte = Blue value 

Example: 0xff00ff 

text 

Format: Ascii string 

Length dependant on use 

Example: Ratio 

value 

Format: 32bit hex number (maximum) 

Example: 0x00400 
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1 

1D table example, 203 

2 

2D table example, 204 

A 

About Intellitype, 198 
About Pi Toolbox, 17 
About the tutorial, 67 
About this guide, 17 
Active channel & Data selection 

persistence, 120 
Advanced features, 134 
Auto Update, 175 

B 

Band Pass filter algorithm, 474 
Bit field Maintenance tool 

Command line operation, 380 
Features, 383 
Shortcuts, 383 

Bit field Maintenance tool, 379 
Bit field Maintenance tool 

Dialog box operation, 382 
Bit fields definition file format, 

376 
Bit Indicators 

Properties, 385 
Bit Indicators 

general, 131 
layout options, 384 
overview, 374 

Bit-fields, 374 
Editing, 376 
XML elements, 378 

Browsers 
Adding Custom Browsers, 62 
Historic Data, 59 
Real-time Data, 60 

Building Equations, 199 

C 

Calculation Rate, 193 
Changing the Channel 

properties, 176 
Channel displays 

Working with, 392 
Channel Displays, 390 

Features, 391 
general, 132 
Properties, 394 
Shortcuts, 391 

Channel Properties 
changing, 147 

Channels 
overview, 184 

Chart recorders, 132 
working with, 412 

Chart Recorders 
Features, 410 
Properties, 413 
Shortcuts, 409 

Chart Recorders, 409 
Color Gradation, 160 
Common channels definitions, 

49 
Common Issues, 438 

Connecting Outings, 112 
Constant 

management, 231 
Constants, 200 

Excel, 232 
general, 133 
global, 230 
Introduction, 230 
outing, 230 
simple and excel, 231 

Conventions, 18 
CPU Usage, 242 
Cursoring, 178, 179 
Cut, Copy and Paste, 121 

D 

Data Export wizard, 426 
Data Filters, 153 
Deleting a math channel, 209 
Discrete scheme properties, 

162 
Context Menu Options, 163 

Display Types 
summary, 128 

Displayed Data export formats, 
428 

Displays 
repositioning, 117 
resizing, 117 

Distribution 
of layouts, 108 

E 

Equations, 199 
Event 
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Offset, 229 
Event based Technology, 104 
Event display, 396 
Event Display 

Event grouping, 400 
Event priorities, 401 
Features, 398 
Layout options, 400 
Properties, 407 
Shortcuts, 397 
working with, 402 

Event Displays 
general, 132 

Event priorities, 217 

Event Reports 
general, 131 

Events 
filtering, 214 
overview, 213 

Events Displays, 396 
Excel, 106 

using displays in, 106 
Excel Constants, 232 

Cut, Copy and Paste 
commands, 233 

Working with Constants, 234 
Excel Repoerts 

Hard Split Reports, 344 
Excel report features, 339 
Excel Report Layouts, 346 
Excel report properties, 352 
Excel reports 

data format, 351 
Excel Reports 

Between Events, 345 
events, 344 

generating, 347 
lap, 341 
outing, 342 
overview, 337 
split, 343 

Explorer 
Properties, 146 
Selection, 143 
Task, 136 
the, 135 

Export Displayed Data, 427 
Export in ASCII Format, 431 
Export in MATLAB Format, 428 
Export Qualifying Mode, 433 
Exporting 

data, 108 
Exporting Data, 425 
Exporting Real-time data from a 

Time and Distance display, 
259 

F 

Filter 
simple, 172 

Filtering 
channels and events, 172 

Filters 
advanced, 173 
Band-pass, 156 
Band-Pass 

Discontinuity handling, 157 
Gate, 154 
inclusion and exclusion, 214 
Moving Average, 158 

Functions and Operators, built 
in, 192 

G 

Global Properties, 149 
To change channel 

properties globally, 149 
To change channel 

properties locally, 149 
GPS channels, 185 
Gradient Scheme properties, 

161 
Graphical Lap Report Editing, 

331 
Graphical Lap Reporting, 315, 

327 
Setting Up a Gear Change 

Scheme, 333 
Group Properties 

changing, 171 
Groups 

about, 168 

H 

Hard Events, 104 
Hardware keys, 30 
Histograms, 267 

Change the number of 
divisions or bins, 268 

Copy bin values as text, 269 
Display an X and Y axis with 

graduations, 268 
Displaying non-linear bins, 

270 
general, 130 
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Link zoom, 269 
Multiple Axes, 269 
Non-linear bins, 269 
Properties, 271 
Show vertical bins, 268 
the active channel, 268 
time or percentage, 268 
Zoom the data range in time 

or distance, 268 
How do I? 

Common Issues, 438 
Real-time broadcast setup, 

435 

I 

Icon Summary, 166 
Importing Data, 108 
Installing Pi Toolbox, 28 

L 

Labels 
Graphical Lap Reports, 329 

Lap Reports 
general, 131 

Laps 
selecting, 114 

Layout Customization, 117 
Linked Zooming, 182 
Local Properties, 149 
Lookup table errors, 207 
Lookup table Syntax, 205 
Lookup tables, 203 

M 

Mapping common channels, 
185 

Maps, 314 
Configuring a GPS Map, 320 
Configuring a Standard Map, 

319 
creating, 318 
editing, 322 
Editing Beacons, 326 
Editing Segments, 324 
Features, 316 
Map cursors, 323 
Printing a Map, 324 
Properties, 335 
Saving and Loading a Map, 

323 
Math Channel Definitions, 194 
Math Channel Equation 

components, 190 
Math Channel Management, 

195 
Math channel, properties, 191 
Math Channels, 184 

defining, 188 
general, 133 
Importing and exporting, 202 

Math Channels, examples, 201 
Minimum System Specification, 

26 
MPEG file association, 370 

N 

Navigating 
time and distance displays, 

178 

Navigators 
overview, 415 

O 

Operands, 200 
Operating Systems, 26 
Options 

channels, 48 
displays, 47 
real time data, 54 
themes, 52 

Outing properties 
changing, 176 

Outing Reports 
general, 131 

P 

Pi Remote Toolbox, 299 
Channel display, 310 
Getting Started, 306 
Overview, 300 
Summary display, 309 
Trouble shooting, 311 

Pi Toolbox Lite, 28 
Pi Toolbox Professional, 28 
Pin Event markers, 254 
Post-Guard Times, 229 
Pre-Guard times, 229 
Print dialog, 122 
Print preview, 123 
Printing 

Example images, 123 
Printing displays, 122 
Properties 

changing, 174 
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PSD Displays 
Features, 418 
Properties, 420 
Shortcuts, 417 

PSD Displays, 417 

Q 

Quantities and Units, 125 
Quick start, 64 

R 

Real Channels, 184 
Real-time Broadcast set up, 

435 
Real-time Data, 120 

Pause characteristics, 238 
Pause mode, 238 
working with, 236 

Real-time Features and 
Behavior 
Chart Recorders, 411 
Maps, 317 
Time and Distance Displays, 

248 
X-Y Displays, 280 

Recommended System 
specification, 27 

Register Syntax, 211 
Registers, 209 
Reports 

general, 130 

S 

Sample code for Excel, 465 
Scrolling, 178, 180 

Selecting Laps, 114 
Selection Explorer 

Deleting or removing a 
channel from a display, 
145 

Deleting or removing a 
channel from a group, 145 

To add a channel to a 
display, 144 

Setting color gradation 
properties, 160 

Setting up a gear change 
scheme for a graphical lap 
report, 165 

Setting up a Real-time display, 
241 

Soft Events, 104, 217 
building equations, 222 
creating, 218 
Extended options, 220 
general, 133 
importing and exporting, 217 

Split report display, 289 
features, 290 
properties, 291 

Split Reports 
general, 130 

Start up preferences, 38 
Starting Pi Toolbox, 36 
Summary display, 294 

Channel alarms, 297 
Properties, 294 
Shortcuts, 298 

T 

Tabular Outing report 
properties, 363 

Tabular Outing reports, 358 
Task Cursor, 112 
Task properties 

changing, 175 
Tasks 

auto updating, 115 
Tasks and Outings 

the principle of, 111 
Templates, 57 
The Add dialog, 58 
The Event properties explorer, 

151 
The main window, 37 
Time and distance displays 

general, 129 
Time and Distance displays 

navigating, 178 
scale individual traces, 250 
Setting the Reference 

Cursor, 256 
Tile or Overlay mode, 250 
Using Lap Markers, 258 
Using Offset Mode, 252 

Time and Distance Displays, 
243 
Properties, 260 
Setting the size of the Plot 

region, 254 
TIme and Distance Displays 

Features, 244 
Time and Distance displays 

and Real-time chart 
recorders, 242 

To add a Band-pass filter, 159 
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To add a Real-time data 
outing:, 61 

To create a group (working in 
the Properties Explorer, 168 

To create a group (working in 
the Selection Explorer), 169 

Toolsets 
expandability, 125 

TOR 
Real-time features and 

behavior, 360 
Using Tabular Outing reports, 

361 
TOR Features, 359 
TOR Shortcuts, 366 
TOR Telltale definitions, 365 

U 

Units, 125 
Units and Arguments, 227 
Using Math channels, 208 

V 

Video 
Features, 368 
overview, 367 

Properties, 372 
Shortcuts, 368 
user defined offsets, 371 

Video displays, 131 
Videos 

loading MPEGs, 369 
Viewing the Hardware key 

status, 30 

W 

What is a Math Channel?, 188 
What is a Soft Event?, 188 
What is Pi Toolbox, 103 
Workbooks and Worksheets, 

107 
Working with Channels, 187 
Working with color gradation, 

164 
Working with Data Filters, 159 
Working with Events, 216 
Working with Real-time Data, 

236 
Add Dialog, 58 
features, 237 

Working with Soft Events, 221 
Working with Time and 

Distance displays, 249 

Working with X-Y displays, 281 
Workspace 

maximize, 119 

X 

XML Example strings, 479 
X-Y Displays, 276 

Active channel pair selection, 
277 

Creating a user defined 
Polynomial curve, 283 

Features, 277 
Polynomial curves, 278 
Properties, 285 
Selecting Channel pairs, 282 
Showing or hiding the 

Polynomial curve, 283 
The Task cursor concept, 

281 
X-Y Plots 

general, 129 

Z 

Zooming, 178, 181 
linked, 182 
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Contact Information 

For more information about Pi products and details of worldwide-authorized agents, please 
contact: 

 
 
 
Pi Research 
Brookfield Motorsports Center 
Twentypence Road 
Cottenham 
CAMBRIDGE 
UK                                  Tel  +44 (0) 1954 253600 
CB4 8PS                    Fax +44 (0) 1954 253601 

 
Pi Research 
8250 Haverstick 
Suite #275 
Indianapolis 
IN 46240         Tel +1 (317) 259-8900 

USA                                                           Fax +1 (317) 259-0137 

 

 

 

 

www.piresearch.com 

http://www.piresearch.com/
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